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Introduction

Using this guide
Using your printer (on CD) and the Quick Reference Guide (on paper) are organized into the
following chapters.

Introduction
This chapter provides a brief introduction to the printer and its documentation for new users.

How do I ...
These chapters help you to carry out various procedures such as loading paper or changing an ink
cartridge. Many of these procedures are illustrated with drawings, and some are also illustrated with
animations (in Using your printer only, on CD).

The problem is ...
These chapters help you to solve problems that may occur while printing. The most complete source
for this type of information is in in Using your printer, on CD.

Tell me about ...
Available in Using your printer only, on CD, these chapters contain reference information, including
the specifications of the printer, and the part numbers of paper types, ink supplies, and other
accessories.

Legal information
This chapter contains HP's limited warranty statement, software license agreement, open source
acknowledgments, regulatory notices, and declaration of conformity.

Index
In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

The printer's main features
Your printer is a color inkjet printer designed for printing high-quality images on paper up to 42 in
(1.06 m) wide. Some major features of the printer are shown below:
●

Production speeds of up to 1.5 m²/min (16 ft²/min), using HP Universal Inkjet Bond Paper with
the Fast print quality option and the Optimize for Lines and Text option

●

Print resolution of up to 2400×1200 optimized dpi, from a 1200×1200 dpi input, using the Best
print quality option, the Maximum Detail and Optimize for Images options, and glossy paper
(for more information on print resolution, see Functional specifications)

●

Unattended printing using 400 cm³ color ink cartridges and 775 cm³ black cartridges (see Ink
cartridges), and rolls of paper up to 300 ft (90 m) in length
NOTE The HP Designjet 4500 series supports rolls of paper up to 575 ft (175 m) in
length.

●

2

High productivity features such as multi-file job submitting, job previewing, queueing, and
nesting using the printer's Embedded Web Server (see Tell me about... (Embedded Web Server
topics))

Chapter 1
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Ink and paper usage information is available from the front panel, and on the Web from the
Embedded Web Server

●

Accurate and consistent color reproduction features:
●

Press emulations for U.S., European, and Japanese standards; and color monitor RGB
emulations (see Color emulation modes)

●

Automatic color calibration

Introduction

●

The printer's main components [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
The following front and rear views of the printer illustrate the main components.

Front view

ENWW

1.

Ink cartridge

2.

Platen

3.

Printhead carriage

4.

Printhead

5.

Printhead cleaner

6.

Front panel

7.

Spindle

8.

Blue removable paper stop

The printer's main components [4000]
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9.

Bin

Introduction

10. Ink cartridge drawer
11. Spindle lever
12. Paper load lever

Rear view

1.

Quick Reference Guide holder

2.

Power socket and on/off switch

3.

Sockets for communication cables and optional accessories

The printer's main components [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
The following front and rear views of the printer illustrate the main components.

4
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1.

Ink cartridges

2.

Platen

3.

Printhead carriage

4.

Printhead

5.

Printhead cleaner

6.

Front panel

7.

Paper load lever (roll 1)

8.

Spindle

9.

Paper load lever (roll 2)
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Front view

10. Bin
11. Spindle drawer (roll 1)
12. Spindle drawer (roll 2)
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The printer's main components [4500]

5

Introduction

Front view with optional stacker

Rear view
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1.

Quick Reference Guide holder

2.

Power socket and on/off switch

3.

Sockets for communication cables and optional accessories
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The front panel
Your printer's front panel is located on the front of the printer, on the right-hand side. It has the
following important functions:
●

It must be used to perform certain operations, such as loading and unloading paper.

●

It can display up-to-date information about the status of the printer, the ink cartridges, the
printheads, the paper, the print jobs, etc.

●

It can provide guidance in using the printer.

●

It displays warning and error messages when appropriate.

●

It can be used to change the values of printer settings and thus change the operation of the
printer. However, settings in the printer are overridden by settings in the Embedded Web Server
or in the driver.

The front panel has the following components:

ENWW

1.

The display area, where information, icons, and menus are displayed.

2.

The Power key turns the printer on and off. If the printer is in sleep mode, this key will wake it up.

3.

The Power light is off when the printer is off; amber when the printer is in sleep mode; green
when the printer is on; green and flashing when the printer is in transition between off and on.

4.

The Form Feed and Cut key normally ejects the sheet (if a sheet is loaded) or advances and
cuts the roll (if a roll is loaded). However, if the printer is waiting for more pages to be nested,
this key cancels the waiting time and prints the available pages immediately.

5.

The Reset key restarts the printer (as if it were switched off and switched on again). You will
need an implement with a narrow tip to operate the Reset key.

6.

The Cancel key cancels the current operation. It is often used to stop printing the current print
job.

7.

The Status light is off when the printer is not ready to print: it may be off, or in sleep mode. It is
green when the printer is ready and idle; green and flashing when the printer is busy; amber
when a serious internal error has occurred; amber and flashing when awaiting human attention.

8.

The Up key moves to the previous item in a list, or increases a numerical value.

9.

The Select key selects the item that is currently highlighted.

The front panel
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10. The Back key goes back to the previous menu. If you press it repeatedly, or hold it down, you
will soon return to the main menu.
11. The Down key moves to the next item in a list, or decreases a numerical value.
To highlight an item in the front panel, press the Up or Down key until the item is highlighted.
To select an item in the front panel, first highlight it and then press the Select key.
The four front-panel icons are all found in the main menu. If you need to select or highlight an icon,
and you don't see the icons in the front panel, press the Back key until you can see them.
When this guide shows a series of front panel items like this: Item1 > Item2 > Item3, it means that
you should select Item1, then select Item2, then select Item3.
Information about specific uses of the front panel can be found throughout this guide.

Printer software
The following software is provided with your printer:
●

The Embedded Web Server, which runs in the printer and enables you to use a Web browser
on any computer to submit and manage print jobs, and check ink levels and printer status

●

The HP-GL/2 and RTL driver for Windows

●

The PostScript driver for Windows (HP Designjet 4000ps and 4500ps only)

●

The PostScript driver for Mac OS 9 (HP Designjet 4000ps only)

●

The PostScript driver for Mac OS X (HP Designjet 4000ps and 4500ps only)

●

The ADI driver for AutoCAD 14

Scanner software [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
The scanner software is installed in the scanner's touch screen, and will run automatically when you
switch on the touch screen. The first page that you see can be divided into two main sections:

8

●

The viewing section on the left, for viewing scanned images

●

The control section on the right

Chapter 1
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Introduction
The preview window fills most of the viewing section. Above it is the image toolbar, with nine buttons
that can be used to change the preview in some way (see Preview copies).
The control section contains four tabs: Copy, Scan, Print, and Setup. Each tab provides options that
you can set when performing copy, scan, print, or setup tasks.
At the bottom of the page are seven larger buttons. From left to right:
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1.

Quit : shuts down or restarts the touch screen

2.

Online help : provides more information on some topics than this document

3.

Print queue : manages the print queue

4.

Preview : scans the document to preview the image and select the area of interest

5.

Reset : resets settings to default values

6.

Stop : cancels the current activity

7.

Copy, Scan, or Print depending on the selected tab

Scanner software [4500]
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Introduction
10
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How do I... (printer assembly topics)
[4000]

How do I... (printer
assembly topics) [4000]

2

NOTE This chapter applies to the HP Designjet 4000 Printer series only.
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●

Get started

●

Unpack the printer

●

Assemble the stand

●

Attach the stand

●

Remove packaging materials

●

Assemble the bin

●

Switch on for the first time

●

Install ink cartridges

●

Remove the setup printheads

●

Install the printheads

●

Install the printhead cleaners

●

Load a roll of paper onto the spindle

●

Load the paper into the printer

●

Connect the printer

●

Install accessories
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Get started
The following topics describe how to assemble your new printer (also described in the Setup
instructions).
Because some of the components of the printer are bulky, you may need up to four people to lift
them. You will also need at least 3 × 5 m (10 × 16 ft) of empty floor space, and about two hours.
The symbols on the boxes identify the contents. Refer to the table below:

How do I... (printer
assembly topics) [4000]

Symbol on box

Contents of box
Printer body
Stand and bin assembly
Consumables box, including ...
Maintenance Kit (please keep this safe)
Spare box (used while attaching the stand to the printer)

Unpack the printer
Before you start unpacking, consider where you are going to put the assembled printer. You should
allow some clear space at the back and at the front of the printer. The recommended clearances are
shown in the illustration below.
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1.

Remove the two side lids. Then remove all the upper four plastic handles from both sides of the
box (two each side).

2.

Cut the strap around the boxes carefully, as the boxes may fall as soon as the strap is cut.

3.

Remove the boxes from the top of the main printer box.

4.

Remove all eight plastic handles from both sides of the box.

5.

Remove the main printer box.

Unpack the printer

How do I... (printer
assembly topics) [4000]

When you have identified a suitable location, you can begin unpacking.
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6.

Remove the two packing pieces.

How do I... (printer
assembly topics) [4000]

Assemble the stand
WARNING! When you are unpacking the leg assembly, you will see that there is anti-slip
material around two of the wheels on the feet. Do not remove this material yet.
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1.

Remove the first tray from the stand and bin assembly box.

2.

From the first tray, remove the two boxes marked with L and R. Place them on the floor as
shown.

3.

Lower the cross-brace on to the L and R boxes.
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You now need to identify which is the left and the right side of the cross-brace.

How do I... (printer
assembly topics) [4000]

4.

(1) left (2) right (3) one hole (4) two holes

ENWW

5.

Now you will need the bag of screws and the screwdriver provided. You may notice that the
screwdriver is slightly magnetic.

6.

Remove the two leg covers from the left leg.

7.

Lower the left leg onto the left side of the cross-brace. The left leg will fit only on the left side of
the cross-brace.

8.

Fix the left leg to the cross-brace using four screws on the inner side of the leg.

Assemble the stand
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9.

Fix the left leg to the cross-brace using two screws on the outer side of the leg.

How do I... (printer
assembly topics) [4000]

10. Lower the right leg onto the right side of the cross-brace. The right leg will fit only on the right
side of the cross-brace.

11. Fix the right leg to the cross-brace using four screws on the inner side of the leg.

12. Fix the right leg to the cross-brace using two screws on the outer side of the leg.

13. Position a foot on the left leg. There are pins to help you to position the foot correctly.
NOTE Do not remove the anti-slip material from the wheel.
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14. Fix the left foot using four screws.

15. Position a foot on the right leg. There are pins to help you to position the foot correctly.
NOTE Do not remove the anti-slip material from the wheel.

16. Fix the right foot using four screws.

Attach the stand
1.

ENWW

You now need to identify the left and right of the printer. This information is shown on the foam
end packs. Also identify the rear of the printer.

Attach the stand
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2.

Pull open the protective plastic from the base of the printer. Please ensure that there is a threemeter space clear of obstructions to the rear of the printer.
Remove the two desiccant bags from the printer.

How do I... (printer
assembly topics) [4000]

3.

In this step, make sure you position the stand pins in the holes in the center of the printer body
brackets.

Lift the stand assembly onto the printer body. The anti-slip material should face to the rear of
the printer.

4.
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Fix the right side of the stand to the printer using one screw. Make sure that the screw is fully
tightened.

Chapter 2

How do I... (printer assembly topics) [4000]

ENWW

Fix the left side of the stand to the printer using two screws. Make sure that the screws are fully
tightened.

6.

Place the spare and consumables boxes against the rear of the printer box. The arrows on the
boxes must point towards the printer box.

How do I... (printer
assembly topics) [4000]

5.

Check that the anti-slip material is still fixed to the two rear wheels.

7.

Using four people, rotate the printer on to the spare and consumables boxes.

Rotate the printer until its rear rests on the spare and consumables boxes and the wheels with
the anti-slip material touch the floor.

ENWW

Attach the stand
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8.

Remove the pallet before trying to lift the printer into an upright position.

9.

Using four people and the hand holds on the rear of the printer body, carefully lift the printer into
an upright position. The anti-slip material should stop the printer from sliding forwards.

Remove packaging materials
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1.

Remove the two foam end packs and the plastic covering the printer.

2.

Position the left leg cover on the front of the left leg (1), then clip the rear edge (2) into place.
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Position the right leg cover on the front of the right leg (1), then clip the rear edge (2) into place.

4.

Remove the anti-slip material from the two rear wheels on the stand assembly.

5.

Remove the packing tapes 1 to 8. Open the printer window and remove the two window inserts
9 and 10.

6.

Remove the protective covering from the printer window and the front panel screen.

7.

Remove the spindle lock.

Remove packaging materials

How do I... (printer
assembly topics) [4000]

3.
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8.

Open the printhead cleaner door and remove the carriage packing material. Then close the
cleaner door.

9.

Press the spindle lever down, which will unseat the right–hand end of the spindle. Remove that
end of the spindle first, and then the left. Do not insert your fingers into the spindle supports
during the removal process.

10. Remove the spindle lock foam piece. Then replace the spindle.

11. Install the Quick Reference Guide holder. Angle the holder at the top (1), then position the two
hooks and clip the lower part (2) to the rear of the printer.
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1.

Locate the bin components.

2.

Fix one screw to the inside of the stand’s left leg.

3.

Do not fully fit the screw.

4.

Fix one screw to the inside of the stand’s right leg.

5.

Do not fully fit the screw.

How do I... (printer
assembly topics) [4000]

Assemble the bin

Assemble the bin
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6.

Lift the supporting framework of the bin into position in front of the printer.

7.

Fix the top arms of the bin to the two screws that you have just fitted.

8.

Fix the lower arms of the bin to the stand using one screw for each leg.

9.

Now tighten the two top screws.

10. Clip all six loops to the frame of the bin. Locate the loops with rear extensions in positions 2, 4,
and 6.
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11. Secure all six loops to the frame, using two clips on each loop.

12. Fit all three mobile stoppers to the three loops as indicated.

13. Carefully squeeze the mobile stopper and then fit it onto the loop.

14. When the mobile stopper is engaged with the loop, release your grip.

15. Move the three mobile stoppers into their parked position. These stoppers are used only when
printing on sheets of paper less than 900 mm in length (up to A1 size).

ENWW

Assemble the bin
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Switch on for the first time

How do I... (printer
assembly topics) [4000]
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1.

Plug the power cable into the rear of the printer, then plug the other end into the AC power outlet.

2.

Turn the power switch at the rear of the printer to the on position.

3.

If the power light on the front panel remains off, press the Power key to switch on the printer.

4.

Wait until you see this front panel message. Highlight your language on the front panel using
the Up and Down keys. Press the Select key.

5.

The front panel will now display how to install the ink supplies.
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Install ink cartridges
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Remove the printheads, printhead cleaners, and ink cartridges from the consumables box.

2.

Find the ink cartridge door, which is on the left side of the printer.

3.

Press the ink cartridge door until it clicks.

4.

Open the ink cartridge door.

5.

To release the ink cartridge drawer, pull the blue handle down.

How do I... (printer
assembly topics) [4000]

1.

Install ink cartridges
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6.

Slide the ink cartridge drawer out.

7.

Place the ink cartridge onto the ink cartridge drawer.
NOTE There are marks on the drawer showing the correct location.

8.

Position the ink cartridge at the rear of the drawer as indicated.

9.

Push the ink cartridge drawer back into the printer until it locks into position.

If you have difficulty, see I cannot insert an ink cartridge.
10. Install the other three ink cartridges in the same way.
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11. Close the ink cartridge door (push it until it clicks shut).

12. Wait (about a minute) until you see this front panel message.

Remove the setup printheads

ENWW

1.

Open the printer window.

2.

Remove the packing tape that is holding down the printhead carriage latch.

3.

Pull up and release the latch on top of the carriage.

Remove the setup printheads
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4.

Lift up the cover. This will give you access to the setup printheads.

5.

Before removing the setup printheads, look at the window on top of each one and check that the
printhead contains ink. If it does not, contact your customer service representative.

6.

To remove a setup printhead, lift up the blue handle.

7.

Using the blue handle, gently disengage the setup printhead from the carriage.

8.

Lift the setup printhead until it is released from the carriage. Then remove the other setup
printheads.

Chapter 2

How do I... (printer assembly topics) [4000]

ENWW

Install the printheads
Remove the blue protective cap and the clear protective tape from the printhead.

2.

Lower all the printheads vertically into their correct positions.

3.

Seat the printheads slowly and carefully.

How do I... (printer
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1.

If you have difficulty, see I cannot insert a printhead.

ENWW

4.

Make sure the printheads are correctly seated. When all the printheads are installed, the front
panel prompts, “Close printhead cover and window”.

5.

If Reseat is displayed on the front panel, see The front panel keeps telling me to reseat or
replace a printhead.

Install the printheads
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6.

Close the carriage cover.

7.

Make sure the latch engages correctly.

8.

Close the printer window.

9.

Please wait (about a minute) while the printer checks the printheads.

Install the printhead cleaners
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1.

Wait until you see this front panel message.

2.

Press the printhead cleaner door, which is on the right side of the printer.
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Open the printhead cleaner door.

4.

Insert the printhead cleaner into the slot of the correct color.

5.

Push the printhead cleaner in and down until it clicks into place.

How do I... (printer
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3.

If you have difficulty, see I cannot insert a printhead cleaner.
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6.

Insert the other seven printhead cleaners into the correct slots.

7.

Close the printhead cleaner door.

Install the printhead cleaners
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8.

Wait until you see this front panel message, then press the Select key.

How do I... (printer
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Load a roll of paper onto the spindle
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1.

Lower the spindle lever.

2.

Remove the right-hand end of the spindle (1) from the printer, then move it to the right in order
to extract the other end (2). Do not insert your fingers into the spindle supports during the
removal process.

3.

Remove the blue paper stop (1) from the left-hand end of the spindle. Keep the spindle
horizontal.
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4.

Slide the roll of paper that came with your printer onto the spindle. Make sure the paper is
oriented exactly as shown.

ENWW

5.

Put the blue paper stop onto the spindle and push it on as far as it will go without using
excessive force.

6.

Make sure the stop is seated correctly.

7.

With the blue paper stop on the left, slide the spindle into the printer. The spindle lever will drop
down automatically as you insert the spindle.

Load a roll of paper onto the spindle

How do I... (printer
assembly topics) [4000]

NOTE There is also a label on the spindle showing the correct orientation.
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8.

When you meet resistance, lift the spindle lever to seat the spindle properly.

9.

The spindle lever will be in the horizontal position when the spindle has been correctly inserted.

Load the paper into the printer
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1.

At the front panel, highlight the

2.

Highlight Paper load and press the Select key.

3.

Highlight Load roll and press the Select key.
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icon and press the Select key.
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Highlight the paper type you have loaded and press the Select key.

5.

Wait until you see the 'Open window' message.

6.

Open the printer window.

7.

Lift the paper load lever.

8.

Pull out approximately 1 m (3 ft) of the roll.

How do I... (printer
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4.

Load the paper into the printer

37

9.

Insert the edge of the roll above the black roller.
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WARNING! Take care not to touch the rubber wheels on the platen while loading
paper: they may rotate and trap skin, hair, or clothing.
10. Wait until the paper emerges from the printer as shown below.

NOTE If you have an unexpected problem at any stage of the paper loading process,
see The paper cannot be loaded successfully [4000].
11. Make sure the paper is aligned with the blue line and half-circle on the platen.

12. Lower the paper load lever.
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13. You should see the front panel message below.
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14. Using the stops, carefully wind the excess paper back onto the spindle.

15. Close the printer window.

16. The printer will adjust the paper by winding it back and forth, after which you can expect the
front panel message below.

17. Using the stops, carefully wind the excess paper back onto the spindle.

18. The printer will automatically perform printhead alignment and a color calibration for the paper
type that you have loaded. During this process the printer will advance the paper by up to 3 m
(≈10 ft) before printing. Please do not try to stop the paper advance; it is necessary to ensure a
successful printhead alignment. The whole alignment and calibration process will take about
twenty minutes; while it is going on, you can start connecting the printer. See Connect the printer.
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Load the paper into the printer
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Connect the printer
1.

Your printer can be connected to a computer directly or to one or more computers via a network.

How do I... (printer
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(1) PC, Macintosh, or workstation
(2) Printer
(3) Server
(4) PC, Macintosh, or workstation
2.

Locate the area at the back of the printer where you can connect the printer to your computer or
network, or install an optional accessory.

3.

A Fast Ethernet socket is provided for connection to a network.

4.

Two FireWire sockets are provided for direct connection to computers. One of these sockets
can also be used to connect the HP Designjet 4500 Scanner.

NOTE A FireWire cable is not provided with the printer. Any cable recommended by the
1394 Trade Association may be used.
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5.

A larger socket is provided to connect an optional accessory.

6.

How do I... (printer
assembly topics) [4000]

CAUTION Do not attempt to use this socket for any other purpose.

Pass the network cable through the hook at the rear of the printer.

Install accessories
There are various optional accessories that you can buy and install at any time during the life of your
printer. The physical installation of each accessory is graphically illustrated on the poster provided
with the accessory (except in the case of the Jetdirect print server; see below). Here are some
further steps to follow after completing the physical installation process.

Gigabit Ethernet socket
To check that the Gigabit Ethernet socket has been correctly installed, go to the front panel and
select the

icon, then I/O setup > Gigabit Ethernet > View information.

The front panel will reveal whether the socket is Installed or Not installed.
Please follow the appropriate instructions to connect the printer to your network:
●

Connect to a network (Windows)

●

Connect to a network (Mac OS X)

●

Connect to a network (Mac OS 9) [4000]

You can plug in your network cable as illustrated below.
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Install accessories
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USB 2.0 socket
To check that the USB 2.0 socket has been correctly installed, go to the front panel and select the
icon, then I/O setup > USB > View information.

The front panel will reveal whether the socket is Installed or Not installed.
Please follow the appropriate instructions to connect the printer to your computer:
●

Connect directly to a computer (Windows)

●

Connect directly to a computer (Mac OS X)

●

Connect directly to a computer (Mac OS 9) [4000]

You can plug in your USB cable as illustrated below.
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Jetdirect print server
To install the Jetdirect card:
Go to the rear of the printer and remove a small cover plate secured by two screws near the lefthand side.

2.

Insert the Jetdirect card and secure it with the screws that accompany the card.

3.

Save the cover plate and screws in case you decide to remove the Jetdirect card later.

How do I... (printer
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1.

To check that the card has been correctly installed, go to the front panel and select the
I/O setup > Jetdirect EIO > View information.
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icon, then

Install accessories
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The front panel will reveal whether the print server is Installed or Not installed.
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Please follow the appropriate instructions to connect the printer to your network:
●

Connect to a network (Windows)

●

Connect to a network (Mac OS X)

●

Connect to a network (Mac OS 9) [4000]

You can plug in your network cable as illustrated below.

Memory expansion card
To check that the 256 MB memory expansion card has been correctly installed, go to the front panel
icon, then View printer information. The front panel will display various items of
and select the
information about the printer, including Memory.

If the memory size is now shown as 512 MB, your memory expansion card has been correctly
installed.

44

Chapter 2

How do I... (printer assembly topics) [4000]

ENWW

3

How do I... (printer assembly topics)
[4500]

ENWW

●

Get started

●

Unpack the printer

●

Assemble the stand

●

Attach the stand

●

Attach the roll module

●

Set up the printer

●

Connect and switch on the printer

●

Install the ink cartridges

●

Install the printheads

●

Install the printhead cleaners

●

Load roll 1

●

Load roll 2

●

Assemble the bin
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NOTE This chapter applies to the HP Designjet 4500 Printer series only.
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Get started
The following topics describe how to assemble your new printer (also described in the Printer
assembly document).
Because some of the components of the printer are bulky, you may need up to four people to lift
them. You will also need at least 3 × 5 m (10 × 16 ft) of empty floor space, and about four hours.
NOTE If you have bought the HP Designjet 4500 Scanner, you can reduce the overall setup
time by assembling the scanner first and then switching it on. The scanner will take one hour
to warm up.
Before you start unpacking, consider where you are going to put the assembled printer. You should
allow some clear space at the back and at the front of the printer. The recommended clearances are
shown in the illustration below.
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Unpack the printer
1.

Cut the strap around the boxes carefully, as the boxes may fall as soon as the strap is cut.

2.

Remove all the upper four plastic handles from both sides of the box (two each side). Carefully
fold the two side lids up onto the top of the box as shown, then remove the two boxes.

3.

The symbols on the boxes identify the contents. Refer to the table below:
Symbol on box

Contents of box
Printer body
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Symbol on box

Contents of box
Stand and bin assembly
Consumables box, including ...
Maintenance Kit (please keep this safe)
Spare box (used while attaching the stand to the printer)
Roll module
Scanner body (mfp only)
Scanner stand (mfp only)

How do I... (printer
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Packing outside Europe:

Packing within Europe:
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Unpack the printer
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4.

Remove the two lids. Place the consumables and spare boxes in front of the printer body.
Lower the stand and bin box onto the consumables and spare boxes. Then lower it onto the floor.

5.

Lower the roll module box onto the consumables and spare boxes. Lower the roll module box
onto the floor. Then remove the consumables and spare boxes.

6.

Remove all eight plastic handles from both sides of the box.

7.

Remove the main printer box.
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8.

Remove the two packing pieces.
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1.

Remove the first tray containing the parts for the bin.

2.

Remove the second tray from the stand and bin assembly box. This tray contains the stand legs.

3.

From the tray, remove the two boxes marked with L and R. Place them on the floor as shown.

Assemble the stand
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Assemble the stand
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4.

Lower the cross-brace onto the L and R boxes.

5.

You now need to identify which is the left and right side of the cross-brace. On the left side (1)
you will see two holes, as shown; on the right side (2) you will see one hole.

6.

You will need the bag of screws and the screwdriver provided. You may notice that the
screwdriver is slightly magnetic.

7.

Identify the left leg (A) as shown below. Remove the two leg covers from the left leg.
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Lower the left leg onto the left side of the cross-brace. The left leg will fit only on the left side of
the cross-brace.

9.

Fix the left leg to the cross-brace using four screws on the inner side of the leg.

How do I... (printer
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8.

10. Fix the left leg to the cross-brace using two screws on the outer side of the leg.

11. Lower the right leg onto the right side of the cross-brace. The right leg will fit only on the right
side of the cross-brace.

12. Fix the right leg to the cross-brace using four screws on the inner side of the leg.
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Assemble the stand
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13. Fix the right leg to the cross-brace using two screws on the outer side of the leg.

14. Fix the stand cross-bar using four screws.
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15. Position a foot on the left leg. There are pins to help you to position the foot correctly.

WARNING! Do not remove the anti-slip material from the wheel.
16. Fix the left foot using four screws.
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17. Position a foot on the right leg. There are pins to help you to position the foot correctly.

WARNING! Do not remove the anti-slip material from the wheel.

How do I... (printer
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18. Fix the right foot using four screws.

19. Turn the stand assembly into an upright position as shown.

20. Open the box containing the roll module. Remove the plastic box containing the screws.
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Assemble the stand
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21. Please take note of the colored plugs located on the legs.

22. Remove the blue plug on the left leg.
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23. Locate the pin into the left leg.

24. Remove the blue plug on the right leg.
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25. Locate the pin into the right leg.
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26. Remove the top yellow plug on the left leg.

27. Locate the pin into the interior of the left leg.

28. Remove the top yellow plug on the right leg.
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Assemble the stand
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29. Locate the pin into the interior of the right leg.

Attach the stand

How do I... (printer
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1.

Identify the left and right of the printer. This information is shown on the foam end packs. Also
identify the rear of the printer.

2.

Pull open the protective plastic from the base of the printer. Please ensure there is a threemeter space clear of obstructions to the rear of the printer and one meter at the front of the
printer. Remove the two desiccant bags from the printer.

3.

Using the screwdriver supplied, remove the two screws that hold drawer 1 in place.
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Slide drawer 1 out until it touches the foam packaging.

5.

Place the stand upside down on top of the printer body. Make sure you position the stand pins
in the holes in the center of the printer body brackets. The anti-slip material should face to the
rear of the printer.

6.

Fix the right side of the stand to the printer using one screw. Make sure that the screw is fully
tightened.
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4.
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Attach the stand
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7.

Slide drawer 1 forwards to gain better access for the front screw. Fix the left side of the stand to
the printer using two screws. Make sure that the screws are fully tightened.

Attach the roll module
Before unpacking the roll module, note that you should handle this piece of equipment using only the
points indicated by the green arrows.

How do I... (printer
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1.

Open the box containing the roll module, then remove the two foam supports.

2.

Remove the roll module from the packaging box.
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Remove the roll module from the plastic bag.

4.

Remove the remaining two yellow plugs from the left and right legs. It is important to remember
the positions of these holes.

5.

Turn the roll module over into an inverted position as shown. Then carry it over to the front of
the inverted printer.

6.

Rest the roll module next to the first printer crossbar.

How do I... (printer
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3.

1. The rear of the printer.
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Attach the roll module
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7.

Before the roll module is moved into its final position, please note that it should sit on the pins
that were located on the stand legs earlier.

8.

With two people lifting the roll module and a third at the rear of the printer, guide the roll module
onto the pins located earlier on the stand.

9.

When viewed from the front, make sure that the roll module sits against the legs of the stand.
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10. Fix the roll module to the right leg of the stand.
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11. Fix the roll module to the left leg of the stand.

12. Fix the roll module to the right leg of the stand using two additional screws.
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Attach the roll module
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13. Fix the roll module to the left leg of the stand using two collar-headed screws.

Set up the printer
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1.

Place the spare and consumables boxes against the rear of the printer box. The arrows on the
boxes must point towards the printer box. Check that the anti-slip material is still fixed to the two
rear wheels.

2.

Using four people, rotate the printer onto the spare and consumables boxes.
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Rotate the printer until its rear rests on the spare and consumables boxes and the wheels with
the anti-slip material touch the floor.

4.

Remove the pallet before trying to lift the printer into an upright position.

5.

Using four people and the handholds on the rear of the printer body, carefully lift the printer into
an upright position.

6.

Rotate the printer into an upright position. The anti-slip material should stop the printer from
sliding forwards.

Set up the printer
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3.
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7.

Remove the two foam end packs and the plastic covering the printer.

8.

Position the left leg cover on the front of the left leg (1), then clip the rear edge (2) into place.

9.

Position the right leg cover on the front of the right leg (1), then clip the rear edge (2) into place.

10. Remove the anti-slip material from the two rear wheels on the stand assembly.
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11. Remove the packing tapes 1 to 12.
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12. Open the printer window. Then remove the two window inserts and the ink tube packing material.

13. Remove the protective covering from the printer window and the front panel screen.

14. Open the printhead cleaner door and remove the carriage packing material. Then close the
cleaner door.
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Set up the printer
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15. Install the Quick Reference Guide holder. Angle the holder at the top (1), then position the two
hooks and clip the lower part (2) to the rear of the printer.

16. Remove the two yellow plastic screws from the right and left side of the paper feed.
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17. Remove the two yellow plastic screws from the left and right side of drawer 2.
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Connect and switch on the printer
1.

Using the cable supplied, connect the roll module to the printer.

A second socket is provided on the roll module to connect an optional accessory.

ENWW

2.

Your printer can be connected to a computer directly or to one or more computers via a network.

3.

A Fast Ethernet socket is provided for connection to a network. Two FireWire sockets are
provided for direct connection to computers.

4.

Pass the network cable through the hook at the rear of the printer..

Connect and switch on the printer
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CAUTION Do not attempt to use this socket for any other purpose.
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5.

Plug the power cable into the rear of the printer, then plug the other end into the AC power outlet.

6.

Turn the power switch at the rear of the printer to the on position.

7.

If the power light on the front panel remains off, press the Power key to switch on the printer.

NOTE This printer is Energy Star compliant and can be left switched on without wasting
energy. Leaving it on improves response time and overall system reliability.
8.
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Wait until you see this message (~10 minutes). Highlight your language using the Up and Down
keys. Press the Select key.
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Install the ink cartridges

ENWW

The front panel displays how to install the ink cartridges.

2.

Remove the printheads, printhead cleaners, and ink cartridges from the consumables box.

3.

Find the ink cartridge door, which is on the left side of the printer.

4.

Open the ink cartridge door.

5.

To release the ink cartridge drawer, gently pull the blue handle down.
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1.

Install the ink cartridges
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6.

Slide out the ink cartridge drawer.

7.

Place the ink cartridge onto the ink cartridge drawer. Note that there are marks on the drawer
showing the correct location.

8.

Position the ink cartridge at the rear of the drawer as indicated.

9.

Push the ink cartridge drawer back into the printer until it locks into position.
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10. Following the same instructions, install the other three ink cartridges.
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11. Close the ink cartridge door.

Install the printheads
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1.

Wait (about a minute) until you see this front panel message.

2.

Open the printer window.

3.

Remove the packing tape that is holding down the printhead carriage latch.

Install the printheads
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4.

Pull up and release the latch on top of the carriage assembly.

5.

Lift up the cover. This will give you access to the setup printheads.

6.

Before removing the setup printheads, look at the window on top of each one and check that the
printhead contains ink.

7.

To remove a setup printhead, lift up the blue handle.

8.

Using the blue handle, gently disengage the setup printhead from the carriage.
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9.

Lift up the setup printhead until it is released from the carriage assembly. Then remove the
other setup printheads.
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10. Remove the blue protective cap and the clear protective tape from the printhead.

11. Lower all the printheads vertically into their correct positions.

12. Seat the printheads slowly and carefully.

13. Make sure the printheads are correctly seated. When all the printheads are installed, the front
panel prompts, “Close printhead cover and window”.
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Install the printheads
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14. If Reseat is displayed on the front panel, check that the protective tape has been removed.
Then try reseating the printhead more firmly. If the problem persists, see I cannot insert a
printhead.
15. Close the carriage assembly cover.

16. Make sure the latch engages correctly.
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17. Close the printer window.

18. Please wait while the printer checks the printheads (~1 minute).

Install the printhead cleaners
1.
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Wait until you see this front panel message.

Chapter 3

How do I... (printer assembly topics) [4500]

ENWW

ENWW

Press the printhead cleaner door, which is on the right side of the printer.

3.

Open the printhead cleaner door.

4.

Insert the printhead cleaner into the slot of the correct color.

5.

Push the printhead cleaner in and down until it clicks into place.
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2.

Install the printhead cleaners
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6.

Insert the other seven printhead cleaners into the correct slots.

7.

Close the printhead cleaner door.
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Load roll 1
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1.

Wait until you see this front panel message, then press the Select key.

2.

To load roll paper from drawer 1 into the printer: from the front panel, highlight the
press the Select key.

3.

Highlight Paper load and press the Select key.
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Highlight Load roll 1 and press the Select key.

5.

Highlight the paper type you intend to load and press the Select key.

6.

Using two hands, pull out drawer 1.

7.

Remove the spindle from drawer 1.
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4.
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Load roll 1
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8.

Use the supplied core adaptors when the roll core is of a larger diameter.

9.

Remove the blue-colored stop from the left end of the spindle. Keep the spindle horizontal.
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10. Slide the roll of paper that came with your printer onto the spindle. Make sure the paper is
oriented exactly as shown.

11. Push the black right-hand stop onto the roll. Make sure it is correctly seated.
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12. Put the blue-colored stop onto the spindle.
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13. Push the blue left-hand stop onto the roll. Make sure it is correctly seated.

14. Hold the spindle assembly using the blue and black stops.

15. With the blue stop on the left, lower the spindle into drawer 1.
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Load roll 1
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16. Lift the drawer 1 paper load lever. This is located on the right-hand side of the printer, above
drawer 1.

17. Feed the paper from roll 1 onto the drawer 1 platen. Align the paper with the central blue line on
the right side of the platen.
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assembly topics) [4500]

18. Stop feeding the paper when the printer beeps.

19. Lower the drawer 1 paper load lever.
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20. Push in drawer 1.
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21. Using the stops at each end of the spindle, carefully wind the excess paper back onto the
spindle.

22. Select the roll length if known.

Load roll 2
1.

ENWW

To load roll paper from drawer 2: from the front panel, highlight the
key.

icon and press the Select

Load roll 2
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2.

Highlight Paper load and press the Select key.

3.

Highlight Load roll 2 and press the Select key.

4.

Highlight the paper type you intend to load and press the Select key.

5.

Using two hands, pull out drawer 2.

6.

Remove the spindle from drawer 2.

7.

Load the spindle using the same procedure as already described for roll 1.
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With the blue stop on the left, lower the spindle into drawer 2.

9.

Lift the drawer 2 paper load lever. This is located on the right-hand side of the printer and under
drawer 1.
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8.

10. Feed the paper from roll 2 onto the drawer 2 platen.. Align the paper with the central blue line
on the right side of the platen.

11. Stop feeding the paper when the printer beeps.
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Load roll 2
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12. Lower the drawer 2 paper load lever.

13. Using two hands, push in drawer 2.

How do I... (printer
assembly topics) [4500]

14. Using the stops at each end of the spindle, carefully wind the excess paper back onto the
spindle.
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Assemble the bin
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Locate all the parts for the bin assembly. The screwdriver is the same one used to fix the roll
module to the printer stand.

2.

Lay one end frame on the floor. Hold one cross frame vertically with the angled part located at
the top of the end frame. The cross frame must be fixed onto the inside of the shortest leg of the
end frame.

3.

Fix the cross frame to the end frame using two screws.
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1.

Assemble the bin
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4.

Turn the bin assembly into a horizontal position. Attach the short leg of the second end frame to
the cross frame using two screws.

5.

Attach the second cross frame to the bin assembly using four screws.
NOTE This cross frame is mounted on the outside of the end frames.
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6.
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Attach one end of the loop to the cross frame.

Chapter 3

How do I... (printer assembly topics) [4500]

ENWW

Attach the other end of the loop to the cross frame.

8.

Using the same method, attach the other five loops.

9.

Locate the bin against the printer.
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7.
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Assemble the bin
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How do I... (software setup topics)

●

Choose which connection method to use

●

Connect to a network (Windows)

●

Connect directly to a computer (Windows)

●

Uninstall the printer driver (Windows)

●

Connect to a network (Mac OS X)

●

Connect to a network (Mac OS 9) [4000]

●

Connect directly to a computer (Mac OS X)

●

Connect directly to a computer (Mac OS 9) [4000]

●

Uninstall the printer driver (Mac OS 9) [4000]
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Choose which connection method to use
The following methods can be used to connect your printer.
Connection type

Speed

Cable length

Other factors

Fast Ethernet

Fast; varies according to
network traffic

Long (100 m=328 ft.)

Requires extra equipment
(switches).

Gigabit Ethernet (optional
accessory)

Very fast; varies according
to network traffic

Long (100 m=328 ft.)

Requires extra equipment
(switches).

Jetdirect print server
(optional accessory)

Moderate; varies according
to network traffic

Long (100 m=328 ft.)

Requires extra equipment
(switches).
Useful for wireless or
AppleTalk connection, and
for Novell printing.

FireWire (IEEE 1394)

Very fast

Short (4.5 m=15 ft.)

USB 2.0 (optional accessory)

Very fast

Short (5 m=16 ft.)

NOTE The speed of any network connection depends on all components used in the
network, which may include network interface cards, hubs, routers, switches, and cables. If
any one of these components is not capable of high-speed operation, you will find that you
have a low-speed connection. The speed of your network connection can also be affected by
the total amount of traffic from other devices on the network.
NOTE The Gigabit Ethernet and USB 2.0 accessories are installed in the same slot in the
printer, so they cannot both be installed at the same time. This does not affect the Jetdirect
print server accessory, which is installed elsewhere.
NOTE There are various possible ways of connecting the printer to a network, but only one
of them can be active at a time; with the exception of the Jetdirect print server, which can be
active at the same time as one other network connection.
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Connect to a network (Windows)
In order to set up a network connection, you must configure the IP address of your printer. There are
two cases, depending on the kind of IP address configuration on your network. You need only to
follow the steps of the case that applies to your network architecture:
●

Automatic IP address configuration: the printer obtains an IP address automatically

●

Manual IP address configuration: you need to enter an IP address manually

Automatic IP address configuration
In this case, once the network cable is connected and the printer is powered up, it automatically
takes an IP address. You need to get this value and perform the following steps to configure the
printer in the network:
1.
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Go to the front panel and select the
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2.

The front panel will display some information, including the printer's IP address. Make a note of
the IP address (16.23.61.128 in this example).

3.

Insert the Drivers and Documentation CD into your computer. If the CD does not autorun, run
the START.EXE program in the root folder of the CD.

4.

Click the Install button.

5.

Follow the instructions on your screen to set up the printer. The following notes will help you to
understand the screens and make appropriate choices.
●

When asked how the printer is connected, choose Connected via the network.

●

The configuration program will look for printers connected to your network. When the
search has finished, a list of printers will be displayed. Identify your printer by its IP address
and select it from the list.

●

The configuration program will analyze the network and the printer. The program will detect
the network settings and will suggest the settings to be used when configuring the printer.
It is not normally necessary to change any of these settings.

Manual IP address configuration
In this case, there is no IP address at the moment of starting the installation. The installation process
will consist of detecting the printer, configuring its IP address, and installing the driver with these
settings. Perform the following steps:

ENWW

1.

Go to the front panel and select the
Ethernet) > View configuration.

2.

The front panel will display some information, including the printer's MAC address. Make a note
of the MAC address.

3.

Insert the Drivers and Documentation CD into your computer. If the CD does not autorun, run
the START.EXE program in the root folder of the CD.

4.

Click the Install button.

Connect to a network (Windows)
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icon, then I/O setup > Fast Ethernet (or Gigabit
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5.

6.

Follow the instructions on your screen to set up the printer. The following notes will help you to
understand the screens and make appropriate choices.
●

When asked how the printer is connected, choose Connected via the network.

●

The configuration program will look for printers connected to your network. When the
search has finished, a list of printers will be displayed. Identify your printer by its MAC
address and select it from the list.

●

The configuration program will analyze the network and the printer. As there are no TCP/IP
parameters configured, the program will ask you to enter the IP address, the subnet mask,
and the gateway. Enter these values according to your network configuration and take
care, when choosing the IP address and the subnet mask, that you select values that will
not create conflicts with the current network devices. It is recommended that you get these
values from your network administrator.

At the end of the installation, you will have drivers configured to work with your printer and your
printer will have a valid IP address. You can see this IP address on the front panel when you
select the

icon.

Connect directly to a computer (Windows)
You can connect your printer directly to a computer without going through a network, by using the
printer's built-in FireWire (IEEE 1394) socket (supported under Windows 2000, XP, and 2003 Server)
or the optional USB 2.0 socket (supported under Windows 98 SE, Me, 2000, XP, and 2003 Server).
1.

Do not connect the computer to the printer yet. You must first install the printer driver
software on the computer, as follows.

2.

Insert the Drivers and Documentation CD into your CD drive. If the CD does not autorun, run the
START.EXE program in the root folder of the CD.

3.

Click the Install button.

4.

Follow the instructions on your screen to set up the printer. The following notes will help you to
understand the screens and make appropriate choices.
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●

When asked how the printer is connected, choose Connected directly to this computer.

●

When prompted to do so, connect your computer to the printer, using a FireWire or USB
cable. Ensure that the printer is switched on.

Uninstall the printer driver (Windows)
1.

Insert the Drivers and Documentation CD into your CD drive. If the CD does not autorun, run the
START.EXE program in the root folder of the CD.

2.

Choose Install, and follow the instructions on your screen to uninstall the printer driver.

Connect to a network (Mac OS X)
You can connect your printer to a network under Mac OS X using the following methods:
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●

Bonjour/Rendezvous

●

AppleTalk

●

TCP/IP
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Before you begin, make sure the following are true:
●

The printer is set up and on.

●

The Ethernet hub or router is on and functioning properly.

●

All computers on the network are on and connected to the network.

●

The printer is connected to the network.

Now you can proceed to install the printer driver and connect your printer:
1.

Insert the Drivers and Documentation CD into your CD drive.

2.

Open the CD icon on your desktop.

3.

Open the OS X HP DJ 4000ps Install or the OS X HP DJ 4500ps Install icon, depending on
your printer model.

4.

Follow the instructions on your screen.

5.

When the printer driver has been installed, the HP Printer Setup Assistant will start
automatically, to set up a connection to your printer. Follow the instructions on your screen..

6.

When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

The HP Printer Setup Assistant can be run separately from the CD, if the printer driver is already
installed.
If for some reason you prefer not to use the HP Printer Setup Assistant, you can follow the
instructions below for the specific type of connection that you have chosen.
NOTE The Printer Setup Utility was known as the Print Center in versions of Mac OS X
earlier than 10.3.

Manual connection using Bonjour/Rendezvous
1.

Go to the front panel, select the
icon, and then I/O setup > Fast Ethernet (or Gigabit
Ethernet, if you are using that option) > View configuration. Note the mDNS service name of
your printer, as shown on the front panel. You may need it later on.

2.

Open the Printer Setup Utility and choose Add Printer from the Printers menu (or Add from the
Utilities list in earlier versions of Mac OS X).

3.

In Mac OS 10.4 or later, click More Printers at the bottom of the Printer Browser.

4.

Select Bonjour or Rendezvous from the popup menu.

5.

A message may appear saying that new drivers have been detected; click OK to load them.

6.

Select your printer from the list. If you cannot identify the printer by its name, use the mDNS
Service Name that you noted earlier.

7.

Click the Add button.

8.

The connection is configured automatically, and the printer is now available on the network.

How do I... (software
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To connect your printer using Bonjour/Rendezvous:

Manual connection using AppleTalk
NOTE AppleTalk is supported only with the optional Jetdirect print server.
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Connect to a network (Mac OS X)
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To connect your printer using AppleTalk:
1.

Go to the front panel and select the
configuration.

2.

The front panel will display some information, including the printer's AppleTalk name. Make a
note of the AppleTalk name.

3.

Make sure that the AppleTalk protocol is active by double-clicking the System preference icon
on the Dock menu bar and selecting Network. Select Built-in Ethernet as well as AppleTalk
from the Show menu to confirm that AppleTalk is active.

4.

Open the Printer Setup Utility and choose Add Printer from the Printers menu (or Add from the
Utilities list in earlier versions of Mac OS X).

5.

In Mac OS 10.4 or later, click More Printers at the bottom of the Printer Browser.

6.

Select AppleTalk from the popup menu.

7.

A message may appear saying that new drivers have been detected; click OK to load them.

8.

Select your printer from the list.

9.

Click the Add button.

icon, then I/O setup > Jetdirect EIO > View

10. The connection is configured automatically, and the printer is now available on the network.

Manual connection using TCP/IP
To connect your printer using TCP/IP:
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1.

Go to the front panel and select the

2.

The front panel will display some information, including the printer's IP address. Make a note of
the IP address (16.23.61.128 in this example).

3.

Open the Printer Setup Utility and choose Add Printer from the Printers menu (or Add from the
Utilities list in earlier versions of Mac OS X).

4.

Select IP Printing from the popup menu.

5.

Select Socket/HP Jetdirect.

6.

Enter the printer's IP address (which you noted in step 2) and a queue name.

7.

Select HP and your printer model.

8.

Click the Add button.

9.

The connection is configured automatically, and the printer is now available on the network.
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Connect to a network (Mac OS 9) [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
You can connect your printer to a network under Mac OS 9 using the following methods:
●

TCP/IP

●

AppleTalk

Using TCP/IP
Before you begin, make sure that your printer is switched on and connected to the network.
To connect your printer using TCP/IP:
1.

Go to the front panel and select the

2.

The front panel will display some information, including the printer's IP address. Make a note of
the IP address (16.23.61.128 in this example).

3.

Go to your computer and open the Desktop Printer Utility located in the HP Designjet 4000ps
folder on the hard disk.

4.

Choose the AdobePS driver and the Printer (LPR) connection. Click OK.

5.

Use the first Change button to select the HP Designjet 4000 PS3 PostScript Printer Description
(PPD) file.

6.

Use the second Change button to enter the printer's IP address into the Printer Address field.
Click Verify and then OK.

7.

Check that your changes appear correctly on the screen, then click Create.

8.

Click Save to save your new printer setup on the desktop.
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Using AppleTalk
NOTE AppleTalk is supported only with the optional Jetdirect print server.
Before you begin, make sure that your printer is switched on and connected to the network.
To connect your printer using AppleTalk:
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1.

Go to the front panel, select the
icon, and then I/O setup > Jetdirect EIO > View
configuration. Note the AppleTalk name of your printer, as shown on the front panel. You may
need it later on.

2.

Select Chooser from the Apple menu.

Connect to a network (Mac OS 9) [4000]
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3.

Click the Adobe PostScript driver icon.

4.

In the AppleTalk Zones list, select the AppleTalk zone where your printer is located (if it exists).
Make sure that the AppleTalk protocol is Active.

5.

The Chooser will check all the printers that are connected by AppleTalk in your zone.

6.

Select your printer. If you have several similar printers, you can identify the correct one by its
AppleTalk name.

7.

Click the Create button in the Chooser to set up the printer.

8.

The type of printer is selected automatically. A new printer icon will appear on your desktop.

9.

Close the Chooser. An icon will appear on your desktop.

Connect directly to a computer (Mac OS X)
You can connect your printer directly to a computer without going through a network, by using the
printer's built-in FireWire (IEEE 1394) socket or the optional USB 2.0 socket. First, install the printer
driver on the computer:
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1.

Make sure the printer is powered off.

2.

Insert the Drivers and Documentation CD into your CD drive.

3.

Open the CD icon on your desktop.

4.

Open the OS X HP DJ 4000ps Install or OS X HP DJ 4500ps Install icon, depending on your
printer model.

5.

Follow the instructions on your screen.

6.

When the printer driver has been installed, the HP Printer Setup Assistant will start
automatically, to set up a connection to your printer. Follow the instructions on your screen..

7.

When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

The HP Printer Setup Assistant can be run separately from the CD, if the printer driver is already
installed.
If for some reason you prefer not to use the HP Printer Setup Assistant, you can follow the
instructions below for the specific type of connection that you have chosen.

Manual connection with FireWire (IEEE 1394)
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1.

Connect the FireWire cable between your printer and the computer.

2.

Power on the printer.

3.

Open the Printer Setup Utility and choose Add Printer from the Printers menu (or Add from the
Utilities list in earlier versions of Mac OS X).

4.

Select FireWire from the popup menu.

5.

The printer icon is automatically added to the list of available printers.

Chapter 4
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Manual connection with USB
1.

Connect the USB cable between your printer and the computer.

2.

Power on the printer.

3.

Open the Printer Setup Utility and choose Add Printer from the Printers menu (or Add from the
Utilities list in earlier versions of Mac OS X).

4.

In Mac OS 10.4 or later, click More Printers at the bottom of the Printer Browser.

5.

Select USB.

6.

A message may appear saying that new drivers have been detected; click OK to load them.

7.

Select your printer from the list.

8.

Click the Add button.

9.

The printer icon is automatically added to the list of available printers.
NOTE Under Mac OS X 10.2 only, the new printer appears as a Generic printer. To correct
this, first delete the Generic printer icon. Then click the Add button, select USB from the
popup menu in the Add Printer dialog, select the name of your printer, and click the Add button.

Sharing the printer
NOTE Printer sharing between users is supported under Mac OS X 10.2.x and later.

1.

Double-click the System Preferences icon in the Dock menu bar on your desktop.

2.

Enable printer sharing by going to Sharing > Services > Printer Sharing.

3.

From the client computer, the printer will now be displayed in the list of available printers in the
Printer Setup Utility.

How do I... (software
setup topics)

If your computer is connected to a network, you can make your directly-connected printer available to
other computers on the same network.

Connect directly to a computer (Mac OS 9) [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
You can connect your printer directly to a computer without going through a network, by using the
optional USB 2.0 socket.

ENWW

1.

Make sure the printer is powered off.

2.

Insert the Drivers and Documentation CD into your CD drive.

3.

In Finder, navigate to the CD.

4.

Double-click on OS 9 HP DJ 4000ps Install to launch the installer.

5.

The installer takes you through various steps until you reach the main install dialog box. We
recommend that you choose the Easy install option.

6.

Click the Install button.

7.

The printer driver installs and a status bar is displayed.

Connect directly to a computer (Mac OS 9) [4000]
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8.

Click Restart to restart the computer.

9.

Connect the USB cable between your printer and the computer.

10. Power on the printer.
11. Run the Desktop Printer Utility in the HP Designjet 4000ps folder.
12. Choose the AdobePS driver and the USB connection.
13. Click the Change button in the USB Printer Selection section to select the printer.
14. Click the Auto Setup button to set up the printer automatically. You can click the Change button
to select the PostScript Printer Description (PPD) file.
15. Once you have selected the correct PPD file, click the Create button to save the desktop printer.

Sharing the printer
If you have Mac OS 9.1 or later, and your computer is connected to a network through TCP/IP, you
can make your directly-connected printer available to other computers on the same network.
1.

In the Apple menu, go to Control Panels > USB Printer Sharing.

2.

Click the Start button.

3.

Click the My Printers tab. The printer will be displayed. Check the box next to the printer name
to enable sharing.

4.

To connect to the printer from another Macintosh, first install the printer driver software: insert
the Drivers and Documentation CD and follow the instructions on the screen.

5.

In the Apple menu, go to Control Panels > USB Sharing.

6.

Click the Network Printers tab. You will see a list of shared printers.

7.

If your printer is in the list, click the Use checkbox next to the printer's name.
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If your printer is not in the list, click the Add button, open the neighborhood where the printer is
shared, and choose the printer.
8.

Run the Desktop Printer Utility in the HP Designjet 4000ps folder.

9.

Choose the AdobePS driver and the USB connection.

10. Click the Change button in the USB Printer Selection section to select the printer.
11. Click the Auto Setup button to set up the printer automatically. You can click the Change button
to select the PostScript Printer Description (PPD) file.
12. Once you have selected the correct PPD file, click the Create button to save the desktop printer.

Uninstall the printer driver (Mac OS 9) [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
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1.

Insert the Drivers and Documentation CD into your CD drive.

2.

In Finder, navigate to the CD.

3.

Double-click on OS 9 HP DJ 4000ps Install to launch the installer.
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4.

The installer takes you through various steps until you reach the main install dialog box. You
have two options:
●

Easy install

●

Uninstall driver

Choose Uninstall driver.
The printer driver uninstalls and a status bar is displayed. Quit the installer when the
uninstallation is complete.

How do I... (software
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5.
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Uninstall the printer driver (Mac OS 9) [4000]
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How do I... (printer operation topics)

●

Switch on and off

●

Restart

●

Change the language of the front panel

●

Access the Embedded Web Server

●

Change the language of the Embedded Web Server

●

Password-protect the Embedded Web Server

●

Request E-mail notification of specific error conditions

●

Set the date and time

●

Change the sleep mode setting

●

Turn off the buzzer

●

Change the front panel contrast

●

Change the units of measurement

●

Adjust for altitude

How do I... (printer
operation topics)
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Switch on and off
Hint The printer is Energy Star compliant and can be left switched on without wasting
energy. Leaving it on improves response time and overall system reliability. When the printer
has not been used for a certain period of time (30 minutes by default), it will save power by
going into sleep mode. However, any interaction with the printer will return it to active mode,
and it can resume printing immediately.
If you wish to switch the printer on or off, the normal and recommended method is to use the Power
key on the front panel.

When you switch off the printer this way, the printheads are automatically stored with the printhead
cleaners, which prevents them from drying out.
However, if you plan to leave the printer switched off for a long period of time, you are recommended
to switch it off using the Power key, and then also switch off the power switch at the rear.

To switch it back on later, use the power switch at the rear, and then the Power key.
When the printer is switched on, it will take some time to initialize itself. This time is about three
minutes for the HP Designjet 4000 series, and about three and a half minutes for the Designjet 4500
series.

Restart
How do I... (printer
operation topics)

In some circumstances you may be advised to restart the printer. Please proceed as follows:
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1.

Press the Power key on the front panel to switch the printer off, wait a few moments, then press
the Power key again. This should cause the printer to restart; if not, continue with step 2.

2.

Use the Reset key on the front panel. You will need an implement with a narrow tip to operate
the Reset key. This normally has the same effect as step 1 above, but may work if step 1 does
not.

3.

If neither of the above steps seem to have any effect, you should switch off the printer using the
power switch at the rear of the printer.
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4.

Remove the power cord from the power socket.

5.

Wait for 10 seconds.

6.

Insert the power cord into the power socket and switch on the printer using the power switch.

7.

Check that the Power light on the front panel comes on. If it does not, use the Power key to
switch the printer on.

Change the language of the front panel
There are two possible ways to change the language of the front-panel menus and messages.
●

●

If you can understand the current front panel language, go to the front panel and select the
icon, then Printer configuration > Front panel options > Select language.
If you cannot understand the current front panel language, start with the printer powered off. At
the front panel, press the Select key and hold it down. While holding the Select key down, press
the Power key and hold it down. Continue to hold down both keys until the green light on the left
side of the front panel starts flashing, then release both keys. You can expect a delay of about
one second. If the green light starts flashing without any delay, you may need to start again.

Whichever method you used, the language selection menu should now appear on the front panel.

Highlight your preferred language, then press the Select key.

Access the Embedded Web Server
The Embedded Web Server enables you to manage your printer and your printing jobs remotely
using an ordinary Web browser running on any computer.
NOTE In order to use the Embedded Web Server, you must have a TCP/IP connection to
your printer. If you have an AppleTalk, Novell, or USB connection to your printer, you will not
be able to use the Embedded Web Server.
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●

Internet Explorer 5.5 or later, for Windows.

●

Internet Explorer 5.2.1 or later, for Mac OS 9.

●

Internet Explorer 5.1 or later, for Mac OS X.

●

Netscape Navigator 6.01 or later.

●

Mozilla 1.5 or later.

●

Safari.

How do I... (printer
operation topics)

The following browsers are known to be compatible with the Embedded Web Server:

Change the language of the front panel
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There are several ways to access the Embedded Web Server:
●

On any computer, open your Web browser and give the address of your printer. You can find
out the address of your printer (starting with http:) from the front panel, by highlighting the
icon.

●

Select Status of my printer or Manage my printer's queue from the Services tab of your
Windows printer driver, or from the Services panel of your Mac OS printer driver.

●

On a computer running Windows with your printer software installed, double-click the Printer
Access Utility icon on your desktop, then select your printer.

If you have followed these instructions but failed to get through to the Embedded Web Server, see I
cannot access the Embedded Web Server from my browser.

Using IP over FireWire with Mac OS X 10.3 and later
If you are using Mac OS X 10.3 or a later version, and have a FireWire connection to your printer, it
is possible to set up an IP address for the printer in order to use the Embedded Web Server. To do
this:
1.

Open System Preferences and click Network.

2.

Choose Network Port Configurations from the Show popup menu.

3.

If you see no FireWire port configuration in the list, click New, then choose FireWire from the
Port popup menu. You can give the new port configuration a name, such as FireWire.

4.

Drag the port configuration to the top of the Port Configuration list. This ensures that the port is
assigned an IP address.

5.

Click Apply Now.

If you don't drag the FireWire port configuration to the top of the Port Configuration list, you need to
choose Manually (or DHCP with manual address) from the Configure IPv4 popup menu, and then
enter an IP address. See http://www.apple.com/ for more detail or updated information on activating
IP over FireWire.
When the printer is connected through FireWire, we recommend adding the printer using the
FireWire modules in order to take full advantage of FireWire printing, and to use the IP over FireWire
only to visit the printer’s Embedded Web Server.
If you connect your printer through FireWire and the printer is also connected to the network through
Fast Ethernet or Gigabit Ethernet, the printer’s IP over FireWire will not be available and you will not
be able to access the Embedded Web Server from the Printer Dialog. However, you will be able to
print through FireWire.
Also in the case of printer sharing over FireWire, remote users will not be able to access the
Embedded Web Server from the Printer Dialog, although they will be able to print.

How do I... (printer
operation topics)

Change the language of the Embedded Web Server
The Embedded Web Server can work in the following languages: English, Portuguese, Spanish,
Catalan, French, Italian, German, Simplified Chinese, Traditional Chinese, Korean, and Japanese. It
will choose whichever language you have specified in your Web browser's options. If you have
specified a language that it cannot support, it will work in English.
To change the language, you must change your Web browser's language setting. For example, in
Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then
ensure that the language you want is at the top of the list in the dialog box.
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To complete the change, you must close and reopen your Web browser.

Password-protect the Embedded Web Server
1.

In the Embedded Web Server, go to the Security page, which you can find in the Settings tab.

2.

Enter a password of your own choice in the New password field.

3.

Enter it again in the Confirm password field to guard against misspelling.

4.

Click Set password.

Now no-one will be able to perform the following actions with the Embedded Web Server without
giving the password:
●

Manage print jobs in the queue (cancel, delete)

●

View previews of print jobs

●

Delete stored jobs

●

Clear accounting information

●

Update the printer's firmware
NOTE If you forget the password, see I cannot access the Embedded Web Server from my
browser.

Request E-mail notification of specific error conditions
1.

In the Embedded Web Server, go to the E-mail server page, which you can find in the Settings
tab, and ensure that the following fields are correctly filled in:
●

SMTP server: the IP address of the outgoing mail server (SMTP) that will process all Email messages from the printer. If the mail server requires authentication, E-mail
notifications will not work.

●

Printer E-mail address: each E-mail message sent by the printer must include a return
address, which does not need to be a real, functional E-mail address, but it should be
unique, so that recipients of the message can identify the printer that sent it.

2.

Go to the Notification page, which is also in the Settings tab.

3.

Click New to request new notifications (or Edit to edit notifications that have already been set
up). Then fill in the E-mail addresses to which notifications should be sent, and select the
incidents that should result in notification messages. Initially the most commonly-specified
incidents are shown; to see all the possibilities, click Show all alerts.

How do I... (printer
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Set the date and time
The printer's date and time settings are mainly useful in job accounting (see Request accounting
data by E-mail). These settings can be changed using the Embedded Web Server or the printer's
front panel.
●
●

ENWW

In the Embedded Web Server, go to the Settings tab and select Configuration, then Date &
Time.
icon, then Printer configuration > Date and time options >
At the front panel, select the
Set date or Set time or Set time zone.

Password-protect the Embedded Web Server
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If you are using the HP Designjet 4000 Printer series, and you find that these options are not
available, please download the latest firmware revision (see Update my printer's firmware). Date and
time setting will be available from Spring 2006.

Change the sleep mode setting
If the printer is left switched on but unused for a certain period of time, it will go automatically into
sleep mode to save power. To change the time the printer waits before it goes into sleep mode, go to
the front panel and select the
icon, then Printer configuration > Sleep mode wait time.
Highlight the wait time you want, then press the Select key.

Turn off the buzzer
To turn the printer's buzzer on or off, go to the front panel and select the
configuration > Front panel options > Enable buzzer.

icon, then Printer

Change the front panel contrast
To change the contrast of the front panel display, select the
icon, then Printer configuration >
Front panel options > Select display contrast, and choose a value using the Up or Down key.
Press the Select key to set the value you have chosen.

Change the units of measurement
To change the units of measurement displayed in the front panel, select the
configuration > Select units, and select English or Metric.

icon, then Printer

The units of measurement can also be changed in the Embedded Web Server.

Adjust for altitude
Your printer will work better if you tell it roughly at what altitude it is. To set the altitude, go to the front
panel and select the

icon, then Printer configuration > Select altitude, and select a range.

How do I... (printer
operation topics)
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How do I... (paper topics)

6

How do I... (paper topics)

●

Load a roll onto the spindle [4000]

●

Load a roll into the printer [4000]

●

Unload a roll from the printer [4000]

●

Load a single sheet [4000]

●

Unload a single sheet [4000]

●

Load a roll onto the spindle [4500]

●

Load a roll into the printer [4500]

●

Unload a roll from the printer [4500]

●

Trim the paper with the manual cutter [4500]

●

View information about the paper

●

Download media profiles

●

Use non-HP paper

●

Cancel the drying time

●

Change the drying time
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Load a roll onto the spindle [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.

1.

Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

2.

Lower the spindle lever.

3.

Remove the right-hand end of the spindle (1) from the printer, then move it to the right in order
to extract the other end (2). Do not insert your fingers into the spindle supports during the
removal process.

The spindle has a stop at each end to keep the roll in position. The stop at the left-hand end can
be removed to mount a new roll, it slides along the spindle to hold rolls of different widths.
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4.

Remove the blue paper stop (1) from the left-hand end of the spindle.

5.

If your roll has a three-inch cardboard core, ensure that the core adaptors supplied with the
printer have been installed. See below:

6.

The roll may be very long; rest the spindle horizontally on a table and load the roll on the table.
Bear in mind that you may need two people to handle it.
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7.

Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle.
NOTE There is also a label on the spindle showing the correct orientation.

Ensure there is no space between the roll and the fixed stop at the right-hand end of the spindle.
8.

Put the blue paper stop on to the upper end of the spindle, and push it towards the end of the roll.

9.

Ensure the blue paper stop is pushed in as far as it will go, without using excessive force.

10. With the blue paper stop on the left, slide the spindle into the printer left and then right as shown
by the arrows 1 and 2.

ENWW

Load a roll onto the spindle [4000]
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11. To make sure that the right end of the spindle is in place, check that the spindle lever is in its
top position (horizontal). You can move the lever yourself if necessary.

If you are a regular user of different paper types, you can change rolls more quickly if you pre-load
rolls of different paper types on different spindles. Extra spindles are available for purchase.

Load a roll into the printer [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
To start this procedure you need to have a roll loaded on the spindle. See Load a roll onto the
spindle [4000].
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1.

At the printer's front panel, select the

2.

The front panel displays a list of paper types.

3.

Select the paper type you are using. If it is not clear which you should select, see Supported
paper types.

4.

Wait until the front panel prompts you to open the window.
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icon, then Paper load > Load roll.
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5.

Lift the paper load lever.

6.

Pull out approximately 1 m (3 ft.) of paper.

7.

Carefully insert the leading edge of the roll above the black roller.
WARNING! Take care not to touch the rubber wheels on the platen while loading
paper: they may rotate and trap skin, hair, or clothing.
WARNING! Take care not to push your fingers inside the printer's paper path. It is not
designed to accommodate fingers, and the results may be painful.

ENWW

Load a roll into the printer [4000]
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8.

Wait until the paper emerges from the printer as shown below.

NOTE If you have an unexpected problem at any stage of the paper loading process,
see The paper cannot be loaded successfully [4000].
9.

Align the right-hand edge of the paper with the blue line and the left edge of the half-circle on
the right of the platen.

10. When the paper is correctly aligned with the blue line and half-circle, lower the paper load lever.

11. The front panel prompts you to wind excess paper onto the roll.
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12. Wind the excess paper onto the roll. Use the paper stop to turn the roll in the direction shown.

13. Lower the window.
14. The front panel again prompts you to wind excess paper onto the roll.

15. The printer will perform a color calibration, if it has not already calibrated the paper type you are
using, and if color calibration is turned on. See Perform color calibration.
16. The front panel displays the Ready message and the printer is ready to print.

Unload a roll from the printer [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
Before unloading a roll, check whether the end of the roll is still attached to the spindle, and follow
the appropriate procedure as described below.

The normal procedure (roll attached to spindle)
If the end of the roll is still attached to the spindle, use the following procedure.
1.

At the printer's front panel, select the

2.

The paper will normally be removed from the printer.

icon, then Paper unload > Unload roll.

If the paper is not automatically removed from the printer, the front panel will prompt you to lift
the paper load lever and turn the paper stop (1) by hand until the paper is removed from the
printer. When you have finished, lower the paper load lever.

ENWW

3.

Turn the paper stop (1) by hand, until the paper is fully wound onto the roll.

4.

Press the Select key.

Unload a roll from the printer [4000]
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5.

Press the spindle lever (2) down and remove the roll from the printer, pulling out the right-hand
end first. Do not insert your fingers into the spindle supports during the removal process.

Roll detached from spindle
If the end of the roll is visible but no longer attached to the spindle:
1.

If you have already selected Paper unload at the front panel, press the Cancel key to cancel
that procedure.

2.

Lift the paper load lever. If the front panel displays a warning about the lever, ignore it.

3.

Pull out the paper from the front of the printer.

4.

Press the spindle lever down and remove the empty spindle from the printer, pulling out the
right-hand end first. Do not insert your fingers into the spindle supports during the removal
process.

5.

Lower the paper load lever.

6.

If the front panel is displaying a warning message, press the Select key to clear it.

No paper visible
If the end of the roll has entirely disappeared into the printer:
1.

Press the Form Feed and Cut key on the front panel, and the remaining paper will be ejected.

2.

Press the spindle lever down and remove the empty spindle from the printer, pulling out the
right-hand end first. Do not insert your fingers into the spindle supports during the removal
process.

Load a single sheet [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
Any loaded roll must be unloaded before loading a sheet. See Unload a roll from the printer [4000].
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At the printer's front panel, select the

How do I... (paper topics)

1.

icon, then Paper load > Load sheet.

NOTE As usual, you must press the Select key to select this option.

ENWW

2.

The front panel displays a list of paper types.

3.

Select the paper type you are using. If it is not clear which you should select, see Supported
paper types.

4.

Wait until the front panel prompts you to open the window.

5.

Lift the paper load lever.

Load a single sheet [4000]
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6.

Insert the sheet into the printer as shown below.

7.

Insert the sheet until it reappears from the printer as shown below.
WARNING! Take care not to touch the rubber wheels on the platen while loading
paper: they may rotate and trap skin, hair or clothing.
WARNING! Take care not to push your fingers inside the printer's paper path. It is not
designed to accommodate fingers, and the results may be painful.

8.
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Pull the sheet out from the top.
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9.

Align the leading edge of the sheet with the metal bar in the platen.
Align the right-hand edge of the sheet with the left edge of the half-circle on the platen, as
shown below.

10. Lower the window.
11. Lower the paper load lever.

12. If the paper has been loaded successfully, the front panel displays the Ready message and the
printer is ready to print. If something has gone wrong (paper mispositioned or misaligned),
follow the instructions on the front panel.
13. If you are printing on a sheet of paper less than 900 mm in length (up to A1 size), deploy the
three mobile stoppers on the bin.

NOTE When printing on sheet paper you are recommended to select Normal or Best print
quality, see Change the print quality.
NOTE If you have an unexpected problem at any stage of the paper loading process, see
The paper cannot be loaded successfully [4000].
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Load a single sheet [4000]
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Unload a single sheet [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.

At the printer's front panel, select the

icon, then Paper unload > Unload sheet.

To give the ink time to dry, the printer holds the sheet for some time (see Drying time).

Load a roll onto the spindle [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.

1.

Push the grey button and remove the blue paper stop from the spindle.

2.

If your roll has a three-inch cardboard core, ensure that the core adaptors supplied with the
printer have been installed. See below:

3.

The roll may be long and heavy; rest the spindle horizontally on a table and load the roll on the
table. Bear in mind that you may need two people to handle it.

4.

Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle.
NOTE There is also a diagram on the outside face of each paper stop showing the
correct orientation.
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Press the roll towards the black paper stop until it clicks into place.
NOTE If you have difficulty with this, try turning the spindle to a vertical position, so that
gravity presses the roll against the stop.

ENWW

6.

Ensure there is no space between the roll and the black stop.

7.

Put the blue paper stop on to the other end of the spindle, and push it towards the end of the roll.

8.

Ensure there is no space between the roll and the blue stop.

Load a roll onto the spindle [4500]
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If you are a regular user of different paper types, you can change rolls more quickly if you pre-load
rolls of different paper types on different spindles. Extra spindles are available for purchase.

Load a roll into the printer [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
To start this procedure you need to have a roll loaded on the spindle. See Load a roll onto the
spindle [4500].

1.

At the printer's front panel, select the

icon, then Paper load > Load roll 1 or Load roll 2.

Hint This step is optional. You may skip it and start the loading process without using
the front panel, by pulling out the drawer as shown below.
2.
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Lift the drawer upwards a little, then pull it towards you.
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Load the roll and spindle into the drawer. Hold the roll as shown by the paper stops at each end
of the spindle. Try to avoid touching the paper surface.
CAUTION Two people may be needed to load a heavy roll.

4.

Lift the paper load lever. Lift the upper lever if you are loading the upper roll, the lower lever if
you are loading the lower roll.

5.

Make sure that the leading edge of the paper is free from wrinkles, tears, and excessive curl, as
these defects may cause a paper jam. If necessary, trim the leading edge before loading (see
Trim the paper with the manual cutter [4500]).

6.

Carefully insert the leading edge of the roll into the front path.
WARNING! Take care not to push your fingers inside the front path. It is not designed
to accommodate fingers, and the results may be painful.

7.

ENWW

The printer beeps when the paper has been inserted far enough.

Load a roll into the printer [4500]

121

How do I... (paper topics)

3.

How do I... (paper topics)

8.

Lower the paper load lever.

9.

Push the drawer back into position.

10. Wind excess paper back onto the roll. Use the paper stop to turn the roll in the direction shown.

11. The front panel displays a list of paper types.

12. Select the paper type you are using. If it is not clear which you should select, see Supported
paper types.
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13. The front panel asks you to specify the length of the roll you are loading. After you have done
so, it will start to load the roll.

NOTE Specifying the roll length is not obligatory (you can select Not known) and has
no effect on the printer's behavior. However, if you give the length, subsequently the
printer will keep track of how much paper is used, and will keep you informed of the
remaining length (assuming that the value you originally gave was accurate).
14. If the printer's first attempt to load the roll is unsuccessful, it will automatically wind the paper
backwards and try again without requiring any assistance.
If this second attempt is unsuccessful, it will try a third time, but this time the front panel will
request your assistance.
15. The printer will perform a color calibration, if it has not already calibrated the paper type you are
using, and if color calibration is turned on. See Perform color calibration.
16. The front panel displays the Ready message and the printer is ready to print.

The roll currently ready to print is shown highlighted on the front panel (roll 1 in the above
example).

Unload a roll from the printer [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
Before unloading a roll, check whether the end of the roll is still attached to the spindle, and follow
the appropriate procedure as described below.

The normal procedure (roll attached to spindle)
If the end of the roll is still attached to the spindle, use the following procedure.
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Unload a roll from the printer [4500]
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1.

At the printer's front panel, select the
roll 2.

icon, then Paper unload > Unload roll 1 or Unload

Hint Alternatively, you may start the unloading process without using the front panel, by
lifting and then lowering the paper load lever.
2.

The paper will normally be removed from the printer.
If the paper is not automatically removed from the printer, the front panel will prompt you to lift
the paper load lever and turn the paper stop by hand until the paper is removed from the printer.
When you have finished, lower the paper load lever.

3.

Turn the paper stop by hand, until the paper is fully wound onto the roll.

4.

Press the Select key.

5.

Lift the drawer upwards a little, then pull it towards you.

6.

Remove the roll from the printer, pulling out the right-hand end first. Do not insert your fingers
into the spindle supports during the removal process.

Roll detached from spindle
If the end of the roll is visible but no longer attached to the spindle:
1.

If you have already selected Paper unload at the front panel, press the Cancel key to cancel
that procedure.

2.

Lift the paper load lever.

3.

Lift the drive pinch lever.

If the front panel displays a warning about the levers, ignore it.
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4.

Pull out the paper from the front of the printer.

5.

Lift the drawer upwards a little, then pull it towards you.
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Remove the empty spindle from the printer, pulling out the right-hand end first. Do not insert
your fingers into the spindle supports during the removal process.

7.

Lower the drive pinch and paper load levers.

8.

If the front panel is displaying a warning message, press the Select key to clear it.

How do I... (paper topics)

6.

No paper visible
If the end of the roll has entirely disappeared into the printer:
1.

Press the Form Feed and Cut key on the front panel, and the remaining paper will be ejected.

2.

Lift the drawer upwards a little, then pull it towards you.

3.

Remove the empty spindle from the printer, pulling out the right-hand end first. Do not insert
your fingers into the spindle supports during the removal process.

Trim the paper with the manual cutter [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
The manual cutter can be used to trim the leading edge of the paper if it is dirty or uneven. This helps
to avoid paper jams during loading.
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1.

Open the drawer of the roll that you intend to trim.

2.

With your left hand, pull the leading edge of the paper over the top of the roll and then down in
front of the drawer.

3.

Find the manual cutter on the right side of the drawer.

Trim the paper with the manual cutter [4500]
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4.

With your right hand, grip the cutter and rotate it as shown on the cutter's top cover, to make the
initial cut, then pull it gently across the paper.

5.

Remove the cut-off piece of paper.

6.

Rotate the spindle backwards to move the paper edge out of the way.
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7.

Return the cutter to the right-hand side of the drawer.

View information about the paper
At the printer's front panel, select the
source on which you want information.

or

icon, then Paper information, then choose the paper

You will see the following information displayed on the front panel:
●

The roll or sheet status
NOTE The HP Designjet 4500 Printer series prints on roll paper only.

●

The paper manufacturer's name

●

The paper type you have selected

●

The width of the paper in millimeters (estimated by the printer)

●

The length of the paper in millimeters (estimated by the printer)

If no paper is loaded, the message Out of paper is displayed.
The same information (apart from the manufacturer's name) is displayed on the Embedded Web
Server's Supplies page.

Download media profiles
Each supported paper type has its own characteristics. For optimum print quality, the printer changes
the way it prints on each different paper type. For example, some may need more ink and some may
require a longer drying time. So the printer must be given a description of the requirements of each
paper type. This description is called the “media profile”. The media profile contains the ICC profile,
which describes the color characteristics of the paper; it also contains information on other
characteristics and requirements of the paper that are not directly related to color. Existing media
profiles for your printer are already installed in the printer's software.
However, you would find it inconvenient to scroll through a list of all paper types available for your
printer, so your printer contains media profiles for only the most commonly used paper types. If you
buy a paper type for which your printer has no media profile, you will find that you cannot select that
paper type in the front panel. To download the correct media profile, go to:
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●

http://www.hp.com/support/designjet-downloads/ for the HP Designjet 4000 series

●

http://www.hp.com/support/designjet/profiles4500/ for the HP Designjet 4500

View information about the paper
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●

http://www.hp.com/support/designjet/profiles4500ps/ for the HP Designjet 4500ps

●

http://www.hp.com/support/designjet/profiles4500mfp/ for the HP Designjet 4500mfp

If you do not find the media profile you want on the Web, you may find that it has been added to the
latest firmware for your printer. You can check the firmware release notes for information. See
Update my printer's firmware.

Use non-HP paper
HP's own paper types have been fully tested with the printer and can be expected to give the best
print quality.
However, you can print on paper from any manufacturer. In that case, you should select (in the front
panel) the HP paper type that is most similar to the paper you will be using. If in doubt, try several
different HP paper type settings, and choose the one that provides you with the best print quality. If
results are not entirely satisfactory with any paper type setting, see General advice.

Cancel the drying time
Press the Form Feed and Cut key (1) on the front panel.

CAUTION A print that has had insufficient time to dry can suffer from quality problems.

Change the drying time
You may wish to change the drying time setting to suit special printing conditions.
Select the

icon, then Select drying time. You can select Extended, Optimal, Reduced, or None.

See Drying time.
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●

Submit a job with the Embedded Web Server

●

Save a job

●

Print a saved job

●

Cancel a job

●

Manage the print queue

●

Nest jobs to save roll paper

How do I... (print job
topics)
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Submit a job with the Embedded Web Server
Access the Embedded Web Server (see Access the Embedded Web Server).

2.

Go to the Submit job page.

3.

Browse your computer and select the file to print.

How do I... (print job
topics)

1.

NOTE Submitting a job to be printed via the Embedded Web Server does not require
you to have the printer driver nor the file's native application installed on your computer.
4.

If you want to submit more than one file, click the Add files button and select all the files you
want.
NOTE If you are not using Internet Explorer for Windows, you will see the Add another
file button, which allows you to select additional files one at a time.

5.

Set the job options.
If you leave an option set to Default, the setting saved in the job will be used. If the job contains
no setting for that option, the setting in the printer will be used. The setting in the printer can be
changed from the front panel, or in some cases from the Device Setup page in the Embedded
Web Server.

6.

Click the Print button.

Save a job
If you intend to reprint a job later with some changes to the job settings (such as size or quality), you
can store the job inside your printer so that you will not need to resubmit it later.
NOTE If you want to reprint a job without changes, you can do that from the print queue
without needing to save the job.
You can save a job only while submitting it for printing:
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1.

Access the Embedded Web Server (see Access the Embedded Web Server).

2.

Go to the Submit job page.
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3.

Browse your computer and select the file to print.

4.

If you want to submit more than one file, click the Add another file button to add another file. All
files submitted together will have the same job settings.

5.

In the job options, check the Store job in printer option.

6.

Set the rest of the job options.

7.

Click the Print button.

How do I... (print job
topics)

NOTE If you are using Windows and Internet Explorer, you can click the Add files
button and select multiple files at once.

Print a saved job
1.

Access the Embedded Web Server (see Access the Embedded Web Server).

2.

Go to the Stored jobs page.

3.

Select the job or jobs that you want to print, using the check box beside each job name.

4.

Click the Print button to print the job with the original settings, or Advanced Print to change the
settings.

Cancel a job
A job can be canceled from the front panel by pressing the Cancel key, or from the Embedded Web
Server by selecting the job and clicking the Cancel icon..
The printer advances the paper as though the print were finished.
NOTE A multi-page job or a big file may take longer to stop printing than other files.

Manage the print queue
Your printer can store pages in a queue while it is printing the current page. The queue may contain
pages from more than one job.
NOTE This information applies only if you are using one of the drivers that came with your
printer or the Embedded Web Server to submit printing jobs.

Turning off the queue [4000]
HP Designjet 4000 series users can turn off the queue from the Web server (Settings tab > Device
setup > Queue), or from the front panel: select the
Disable queue.

icon and then Job management options >

HP Designjet 4500 series users cannot turn off the queue.

The When To Start Printing options
NOTE The When To Start Printing options cannot be used with PostScript jobs.
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Print a saved job
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You can select at what point you want to print a file you have in the queue. From the Web server,
select the Settings tab > Device setup > When to start printing; or, from the front panel, select the
icon and then Job management options > When to start printing.
There are three options you can select:

How do I... (print job
topics)

●

When After Processing is selected, the printer waits until the whole page has been processed
and then it starts to print. This is the slowest setting but offers the best print quality.

●

When Immediately is selected, the printer prints the page as it is processed. This is the
quickest setting, but the printer may stop halfway through a print to process data. This setting is
not recommended for complex images with dense color.

●

When Optimized is selected (this is the default setting), the printer calculates the best time to
begin printing the page. It is usually the best compromise between the After Processing and
Immediately settings.

Identifying a job in the queue
The best way to look at the queue is in the Embedded Web Server (Information > Jobs queue),
where you can manage the queue and get full information on every job (by clicking the name of the
file).
However, you can also manage the queue from the front panel. To do so, select the
then Job queue, where you can see a list of the jobs in the queue.

icon and

Each has an identifier, comprising:
<position in queue>: <image name>
The job currently being printed is in position 0. The next job to be printed is in position 1, the previous
job already printed is in position -1.

Prioritizing a job in the queue
To make any job in the queue the next one to be printed, select it and choose Reprint (in the
Embedded Web Server) or Move to front (in the front panel).
If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to
be printed next, and on its own on the roll, first turn nesting off and then move it to the front of the
queue as described above.

Deleting a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will
just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and
want to avoid any chance of it being reprinted, you can simply delete it, by selecting it and choosing
Delete (in the Embedded Web Server or in the front panel).
In the same way, you can delete a job that has not been printed yet.
If the job is currently being printed (Status = printing in the Web server, or its queue position is 0 in
the front panel), and you want both to cancel the job and to delete it, first click the Cancel icon in the
Web server, or press the Cancel key on the front panel, and then delete it from the queue.

Making copies of a job in the queue
To make extra copies of any job in the queue, select the job in the Embedded Web Server and click
the Reprint icon, then specify the number of copies you want. The job will be moved to the top of the
queue.
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You can also do this from the front panel: select the job and choose Copies, then specify the number
of copies required and press the Select key. This overrides any value set by your software.
NOTE If Rotate was On when you sent the file, every copy will be rotated.
If the job has already been printed, use Move to front to move it to the top of the queue.

Understanding job status
●

receiving: the printer is receiving the job from the computer

●

waiting to process: the job has been received by the printer and is waiting to be rendered (for
jobs submitted through the Embedded Web Server only)

●

processing: the printer is parsing and rendering the job

●

preparing to print: the printer is performing writing system checks before printing the job

●

waiting to print: the job is waiting for the print engine to become free to proceed with printing

●

waiting for nest: the printer is set up with Nesting=On and is waiting for other jobs in order to
complete the nest and proceed with printing

●

on hold: the job was sent with the on hold for preview option and is on hold

How do I... (print job
topics)

These are the possible job status messages, approximately in the order in which they may be seen:

NOTE If the printer hangs up while printing a job, and the queue facility is turned on,
the partially printed job will appear in the queue as on hold when the printer is next
turned on. When you resume the job, it will start printing at the page at which it was
interrupted.
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●

on hold for paper: the job can't be printed because the paper it needs is not loaded in the
printer (see An “on hold for paper” message [4500]): load the required paper and then click
Continue to resume the job

●

on hold for accounting: the job can't be printed because the printer requires all jobs to have
an account ID: enter the account ID and then click Continue to resume the job

●

printing

●

drying

●

cutting paper

●

ejecting page

●

canceling: the job is being canceled, but will remain in the printer job queue

●

deleting: the job is being deleted from the printer

●

printed

●

canceled: the job has been canceled by the printer

●

canceled by user

●

empty job: the job does not contain anything to print

Manage the print queue
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Nest jobs to save roll paper
Nesting means placing pages side by side on the paper, rather than one after the other. This is done
to avoid wasting paper.

How do I... (print job
topics)

1.

Direction of paper flow

2.

Nesting off

3.

Nesting on

4.

Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true:
●

The printer is loaded with roll paper, not sheet paper.

●

In the front panel's Job Management menu or the Embedded Web Server's Device Setup page,
Nest is On.

Which pages can be nested?
All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll,
or unless there are too many of them to fit into the remaining length of the roll. A single group of
nested pages cannot be split between two rolls.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible in all of the following ways:
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●

All pages must have the same print quality setting (Fast, Normal, or Best).

●

Pages must be all Optimized for Drawings/Text or all Optimized for Images.

●

The Maximum Detail setting must be the same on all pages.

●

The Margins setting must be the same for all pages (Extended or Normal).

●

The Mirror setting must be the same for all pages.

●

The Rendering Intent must be the same for all pages.

●

The Cutter setting must be the same for all pages.

●

The color adjustment settings must be the same for all pages. These are known as Advanced
Color Settings in the Windows driver, and CMYK Settings in the Mac OS driver.
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●

Pages must be all color, or all grayscale: not some in color and some in grayscale.

●

All pages must be in one or other of the following two groups (the two groups cannot be mixed
in the same nest):
HP-GL/2, RTL, CALS G4

●

PostScript, PDF, TIFF, JPEG

JPEG, TIFF, and CALS G4 pages with resolutions greater than 300 dpi may not nest with other
pages in some cases.

How long does the printer wait for another file?
So that the printer can make the best nest possible, it waits after a file has been received to check
whether a subsequent page will nest with it or with pages already in the queue. This waiting period is
the nest wait time; the factory default nest wait time is two minutes. This means that the printer waits
for up to two minutes after the last file is received before printing the final nest. You can change this
icon, then Job management options > Nest
waiting time from the printer's front panel: select the
options > Select wait time. The available range is 1 to 99 minutes.
While the printer is waiting for nesting to time out, it displays the remaining time on the front panel.
You can print the nest (cancel the nest wait) by pressing the Cancel key.
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Nest jobs to save roll paper
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How do I... (stacker topics) [4500]

NOTE This chapter applies to the HP Designjet 4500 Printer series only.
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●

Install the stacker

●

Uninstall the stacker

●

Change the temperature

●

Change paper rolls while using the stacker

●

Clean the exterior of the stacker

●

Clean the stacker rollers

●

Move or store the stacker

How do I... (stacker
topics) [4500]

The stacker is an optional accessory for the HP Designjet 4500 Printer series. It stacks prints flat, on
top of one another, instead of letting them fall into the bin.
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Install the stacker

How do I... (stacker
topics) [4500]

1.

Connect the cables between the stacker and the printer.

2.

Switch on the stacker.

3.

Select the
icon on the printer's front panel, then Accessories > Stacker > Install stacker.
The front panel will prompt you to attach the stacker to the printer.

4.

There are two latches on the stacker that engage with the printer deflectors. To attach the
stacker to the printer, attach first one side and then the other (because less force is required
that way).

Some warm-up time is necessary, especially when the stacker has just been switched on.
NOTE The stacker operates on cut sheets of paper. When it is switched on, the cutter is
automatically enabled. It cannot work if the cutter is turned off or if the printing material cannot
be cut (canvas, for example).

Uninstall the stacker
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1.

To uninstall the stacker, select the
Stacker > Uninstall stacker.

2.

The front panel will then prompt you to detach the stacker from the printer. Pull the stacker from
one side to detach it on that side, then detach the other side.

3.

Disconnect the stacker cables.
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Change the temperature
The stacker contains a heated roller to remove the curl from the paper. To change the temperature of
the roller, select the
icon on the printer's front panel, then Accessories > Stacker > Select
temperature level. There are three options:
●

Normal is the default and recommended setting.

●

High sets the roller to a higher temperature, which may be useful for particularly stiff paper.

●

Low sets the roller to a lower temperature, which may be useful for paper with a particularly
sensitive coating.

Change paper rolls while using the stacker
1.

Remove the stack of cut paper from the stacker in order to make the stacker easier to handle.

2.

Detach the stacker from the printer: first one side, then the other.

3.

Change the rolls in the normal way: see Unload a roll from the printer [4500] and Load a roll into
the printer [4500].

How do I... (stacker
topics) [4500]

Clean the exterior of the stacker
See Clean the exterior of the printer.

Clean the stacker rollers
WARNING! The stacker becomes hot during use. Before cleaning, switch it off and give it
time to cool.
Ink tends to stick to the main stacker roller and the small output rollers, which should therefore be
cleaned regularly using a fabric cloth dampened with water.
The frequency with which cleaning is needed depends to some extent on the paper type in use.
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●

For plain, coated, or heavyweight coated paper, once a month may be sufficient.

●

For translucent, vellum, glossy, or natural tracing paper, cleaning may be required once a week
even with the slowest print modes.

Change the temperature
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Move or store the stacker
Before moving or storing the stacker, take a couple of steps to reduce the amount of space it
occupies.
Undo the screws at either side of the stacker tray, and let the tray hang vertically.

2.

Remove the pin from each leg extension, and rotate the leg extension upwards.

How do I... (stacker
topics) [4500]

1.

140

Chapter 8

How do I... (stacker topics) [4500]

ENWW

ENWW

How do I... (image adjustment topics)

●

Change the page size

●

Create a custom page size

●

Change the print quality

●

Choose print quality settings

●

Print at maximum speed

●

Adjust the margins

●

Print on oversize pages

●

Print without added margins

●

Select the orientation of the image

●

Rotate an image

●

Print a mirror image

●

Scale an image

●

Change the palette settings

●

Change the treatment of overlapping lines

●

Change the graphic language setting

How do I... (image
adjustment topics)
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Change the page size
The page size can be specified in the following ways:
●

Using a Windows printer driver: select the Paper/Quality tab, then Size is.

●

Using a Mac OS printer driver: select Page Setup from the File menu, select your printer in the
Format for popup menu, then Paper size.

●

Using the Embedded Web Server: go to the Page Size section of the Submit Job page.

●

Using the front panel: select the
Select paper size.

icon, then Default printing options > Paper options >

NOTE If a page size is set with the printer driver or with the Embedded Web Server, it
overrides the page size set with the front panel.

Create a custom page size
You can create a custom page size using a printer driver or the Embedded Web Server.

Using the HP-GL/2 & RTL printer driver for Windows
1.

Select the Paper/Quality tab.

2.

Press the Custom button.

3.

Enter your choice of name for your custom page size.

4.

Enter its width and length.

5.

Press the Save button.

6.

Press the OK button.

7.

In order to use the new custom page size, you must close the driver software and then reopen it.

How do I... (image
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Using the PostScript printer driver for Windows XP or Windows 2000
1.

Select the Paper/Quality tab.

2.

Press the Custom button.

3.

Enter your choice of name for your custom page size.

4.

Enter its width and length.

5.

Press the Save button.

6.

Press the OK button.

7.

In order to use the new custom page size, you must close the driver software and then reopen it.

Using the PostScript printer driver for Windows Me or Windows 98
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1.

Select the Paper/Quality tab.

2.

Select Custom page 1, Custom page 2, or Custom page 3 from the Size is list.
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3.

Choose the width and length of your custom page.

4.

Press the OK button.

Using the PostScript printer driver for Windows NT
1.

Select the Page Setup tab.

2.

Select PostScript Custom Page Size from the list of page sizes.

3.

Choose the width and length of your desired page size.

4.

Press the OK button.

Using the PostScript printer driver for Mac OS X
1.

Select Page Setup from the File menu.

2.

Select Manage Custom Sizes at the end of the Paper Size list.
NOTE Under Mac OS X 10.3 or earlier, select Custom page size from the Settings
option.

3.

Press the New or + button.

4.

Enter your choice of name for your custom page size.

5.

Enter its width and length.

6.

Under Mac OS X 10.3 or earlier, press the Save button.

1.

Select Page Setup from the File menu.

2.

Select the Page Attributes panel.

3.

Select the Custom Page Default panel.

4.

Enter your choice of name for your custom page size.

5.

Enter its width and length.

6.

Press the Add button.

How do I... (image
adjustment topics)

Using the PostScript printer driver for Mac OS 9

Using the Embedded Web Server
1.

Go to the Page Size section of the Submit Job page.

2.

Select the Custom option.

3.

Choose the width and length of your desired page size.

Change the print quality
Your printer has three different print quality options: Best, Normal, and Fast. There are also two
supplementary options that have an effect on print quality: Optimize for drawings/text or Optimize
for images, and Maximum detail. See Choose print quality settings for guidance on choosing
among these options.
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Change the print quality
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You can specify the print quality in the following ways:
●

Using a Windows printer driver: go to the Print Quality section of the Paper/Quality tab.

●

Using a Mac OS printer driver: go to the Image Quality panel.

●

Using the Embedded Web Server: go to the Image Quality section of the Submit Job page.

●

Using the front panel: select the

icon, then Default printing options > Image quality.

NOTE If a print quality is set with the printer driver or with the Embedded Web Server, it
overrides the print quality setting from the front panel.
NOTE You cannot change the print quality of pages that the printer is already receiving or
has already received (even if they have not started to print yet).

Choose print quality settings
The following table shows suggested print quality settings and paper types for various different kinds
of prints, assuming that you are using roll paper. You are not obliged to follow these suggestions, but
you may find them helpful.
If you are using sheet paper, you are recommended to set print quality to Best.
If you are not sure how to change the print quality settings, see Change the print quality.
NOTE High-density images should be printed on heavier paper (heavyweight or glossy).
Image quality settings

Paper types

Print content

Lines (draft)

Print quality

Optimized for

Maximum detail

Fast

Drawings/text

Off (or On for
higher quality,
lower speed)

Bright White
Bond Paper

How do I... (image
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Translucent materials*
Coated Paper
Lines

Normal

Drawings/text

Off

Bright White
Bond Paper
Translucent materials*
Coated Paper

Lines and fills (fast)

Normal

Drawings/text

On

Bright White
Bond Paper
Translucent materials*
Coated Paper
Heavyweight Coated Paper
Productivity Photo Gloss

Lines and fills

Best

Drawings/text

Off

Bright White
Bond Paper
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Image quality settings

Paper types

Print content
Print quality

Optimized for

Maximum detail
Translucent materials*
Coated Paper
Heavyweight Coated Paper
Productivity Photo Gloss

Lines and images –
high quality maps

Best

Drawings/text

On

Coated Paper
Heavyweight Coated Paper
Productivity Photo Gloss

In-store advertising

Normal

Images

Off

Coated Paper
Heavyweight Coated Paper
Productivity Photo Gloss

Renderings

Best

Images

Off

Heavyweight Coated Paper
Productivity Photo Gloss

Best

Images

Off

Productivity Photo Gloss

How do I... (image
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Photographs

* Translucent materials include Vellum, Translucent Bond, Natural Tracing Paper, Clear Film, and
Matte Film.
For technical details of print resolution, see Functional specifications.

Print at maximum speed
There are two paper type settings in the front panel especially designed for printing at maximum
speed.
Image quality settings

Paper types (front panel)

Print content

Lines (draft)

ENWW

Print quality

Optimized for

Maximum detail

Fast

Drawings/text

Off

Max Speed Bright White*

Print at maximum speed
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Image quality settings

Paper types (front panel)

Print content
Print quality

Optimized for

Maximum detail
Max Speed Bond Paper†

* To use Max Speed Bright White, load HP Bright White Inkjet Bond Paper and select Max Speed
Bright White from the list of paper types in the front panel.
† To use Max Speed Bond Paper, load HP Universal Inkjet Bond Paper and select Max Speed Bond
Paper from the list of paper types in the front panel.

Adjust the margins
The printer margins determine the printable area of the page that can be used by your application.
There are three margin options: Small, Normal, and Extended (see also Print without added
margins). For the dimensions of the margins, see Functional specifications.
You can specify the margins in the following ways:
●

Using the Windows HP-GL/2 printer driver: Normal margins are selected by default. To select
the other options, select the Paper/Quality tab and press the Margins/Layout button.

●

Using the Windows PostScript printer driver: select the Paper/Quality tab, then Size is. You
select the page size and the margins at the same time.

●

Using a Mac OS printer driver: select Page Setup from the File menu, then Paper size. You
select the page size and the margins at the same time.

●

Using the Embedded Web Server: select from the Margins list on the Submit Job page.

●

How do I... (image
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Using the front panel: select the
Select margins.

icon, then Default printing options > Paper options >

NOTE If margins are set with the printer driver or with the Embedded Web Server, they
override the margins set with the front panel.

Print on oversize pages
For technical reasons, it is impossible to print an image that covers the full width or length of the
paper. There must always be a margin around the image. However, if you want to print, for example,
an A3-sized image with no margins around it, you can print on paper larger than A3 (leaving margins
around the image as usual), and then cut off the margins after printing.
Oversize page layouts are designed for this purpose. Each oversize page is large enough to
accommodate a standard paper size plus margins.
You can specify an oversize page layout in the following ways:
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●

Using the Windows HP-GL/2 printer driver: select the Paper/Quality tab and press the Margins/
Layout button, then select Oversize from the layout options.

●

Using the Windows PostScript printer driver: select the Paper/Quality tab, then Size is. You
select the oversize page and the margins at the same time.
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●

Using a Mac OS 9 or 10.1 printer driver: create a custom paper size with zero margins, and take
into account that the margins added to the final job will be the ones that are set in the printer's
front panel.

●

Using a newer Mac OS printer driver: select the printer in the Format for popup menu, select
the paper size, and then margins options will appear. You can select the oversize page and the
margins at the same time.

●

Using the Embedded Web Server: on the Submit Job page, select Oversize from the Margin
layout list.

●

Using the front panel: select Default printing options > Paper options > Select layout >
Oversize.

When using oversize pages, you can select the width of the margins as usual (see Adjust the
margins).
See also Print without added margins.

Print without added margins
For technical reasons, it is impossible to print an image that covers the full width or length of the
paper. There must always be a margin around the image. However, if your image already contains
adequate margins (white space around the edges) then you can tell the printer not to add margins to
the image when printing it. In this case it will, in fact, clip the edges of your image, assuming that the
edges contain nothing that needs to be printed.
You can request no added margins in the following ways:
Using the Windows HP-GL/2 printer driver: select the Paper/Quality tab and press the Margins/
Layout button, then select Clip Contents By Margins from the layout options.

●

Using the Embedded Web Server: on the Submit Job page, select Clip Contents By Margins
from the Margin layout list.

●

Using the front panel: select Default printing options > Paper options > Select layout > Clip
contents by margins.
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●

This option is not available from the Windows PostScript driver or the Mac OS drivers.
When using this option, you can select the width of the margins as usual (see Adjust the margins).
The printer continues to use margins: it just takes them out of the image instead of adding them to
the image.

Select the orientation of the image
The orientation of the image may be portrait or landscape. When you see it on screen:
●

ENWW

The height of a portrait image is greater than its width (a tall image).

Print without added margins
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●

The width of a landscape image is greater than its height (a wide image).

You should select the orientation that your image has when you see it on screen. If you have a
landscape image and you select portrait, or if you have a portrait image and you select landscape,
the image may be clipped when printed.
You can select the orientation using a printer driver or the Embedded Web Server.
●

Using the PostScript printer driver for Windows NT: go to the Orientation section of the Page
Setup tab.

●

Using any other printer driver for Windows: go to the Orientation section of the Finishing tab.

●

Using the PostScript printer driver for Mac OS: select Page Setup from the File menu, then go
to the Orientation section of the Page Attributes panel.

●

Using the Embedded Web Server: go to the Orientation section of the Submit Job page.

Rotate an image
By default, images are printed with their shorter sides parallel to the leading edge of the paper, like
this:
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You may wish to rotate your images by 90 degrees in order to save paper, like this:
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You can do this in the following ways:
●

Using a Windows printer driver: select the Finishing tab, then Rotate by 90 degrees.

●

Using a Mac OS printer driver: select the Finishing panel, then Rotate.

●

Using the Embedded Web Server: select the Submit Job page, then Rotate.

●

Using the front panel: select the
Rotate.

icon, then Default printing options > Paper options >

NOTE If rotation is set with the printer driver or with the Embedded Web Server, it overrides
the setting in the front panel.
NOTE When you rotate a job, the page length may be increased to avoid clipping, because
the top and bottom margins are usually larger than the side margins.
CAUTION With either rolls or sheets, if you rotate an image to landscape whose original
orientation was portrait, the paper may not be wide enough for the image. For example,
rotating a portrait D/A1-size image on D/A1-size paper by 90 degrees will probably exceed the
width of the paper. If you are using the Embedded Web Server, the preview screen will
confirm this with a warning triangle. If you are using the HP Designjet 4500 Printer series, the
job will be put “on hold for paper”.

Autorotate
The HP-GL/2 printer driver provides an Autorotate option, which will automatically rotate by 90
degrees any oversized portrait images in order to save paper.

Print a mirror image

●

Using a Windows printer driver: select the Finishing tab, then Mirror image.

●

Using a Mac OS printer driver: select the Finishing panel, then Mirror image.

●

Using the Embedded Web Server: select the Submit Job page, then Mirror image.

●

Using the front panel: select the
Enable mirror.

How do I... (image
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If you are using clear imaging paper, sometimes called backlit, you may want to print a mirror image
of your drawing, so that when the paper is lit from behind it is in the correct orientation. To do this
without changing the image in your application:

icon, then Default printing options > Paper options >

NOTE If mirror image is set with the printer driver or with the Embedded Web Server, it
overrides the setting in the front panel.

Scale an image
You can send an image to the printer at a certain size but tell the printer to rescale it to a different
size (normally larger). This may be useful:
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●

If your software does not support large formats

●

If your file is too large for the printer's memory—in this case you can reduce the page size in
your software and then scale it up again using the front panel option

Print a mirror image
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You can rescale an image in the following ways:
●

●

Using a Windows printer driver: select the Effects tab, then Resizing options.
●

The Print document on option adjusts the image size to the page size selected for your
printer. For example, if you have selected ISO A2 as the page size and you print an A4size image, it will be enlarged to fit the A2 page. If the ISO A3 page size is selected, the
printer would reduce a larger image to fit the A3 size.

●

The % of normal size option enlarges the printable area of the original page by the
percentage indicated and adds the printer margins to make up the output page size.

Using a Mac OS printer driver: select the Finishing panel, then Print document on.
The driver adjusts the image size to the page size selected for your printer.

●

Using the Embedded Web Server: select the Submit Job page, then Resizing.

●

Using the front panel: select the

icon, then Default printing options > Paper options > Scale.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the page,
otherwise clipping will occur.

Change the palette settings
You cannot change the Factory palette, but you can define Palettes A and B to be whatever you
choose.
These palettes will be applied only to HP-GL/2 jobs with no software palette embedded.
NOTE All HP-GL/2 jobs generated by the HP-GL/2 driver that comes with the printer will
include an embedded software palette, and thus any palette settings in the front panel will be
ignored.
To redefine Palette A:

How do I... (image
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1.

Go to the front panel, select the
Define palette > Palette A.

2.

Scroll to the pen number you want to change and press Select.

3.

You can see the current width assigned to this pen by selecting Width; for example Width=0.35
mm. If you want to change it:

4.

Press Select.

5.

Scroll to the width you want.

6.

Press Select again.

7.

Press Back to get to the previous menu: Color/Width. Otherwise, scroll to Color.

8.

When you select Color, the current color assigned to the pen is displayed, for example
Color=110. If you want to change it:

9.

Press Select.
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10. Scroll to the color you want.
11. Press Select again.
12. Press Back to get to the previous menu.
13. When both width and color are correct, press Back.
14. Scroll to the next pen number you want to change, press Select and then repeat the above
process.
15. When all pen definitions are correct, press Back to exit the menus.
NOTE The palette you have just defined will take effect only when you select it to be the
current palette.
If you do not get the results you expect, see Pen settings seem to have no effect.

Change the treatment of overlapping lines
The Merge setting controls the overlapping lines in an image. There are two settings, Off and On.
●

If Merge is Off, where the lines cross only the color of the top line is printed.

●

If Merge is On, where the lines cross the colors of the two lines are merged.

How do I... (image
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To turn Merge on, select the
icon, then Default printing options > HP-GL/2 options > Enable
merge. You can set the merge setting from your software in some applications. Settings in your
software override the front-panel settings.

NOTE Merge settings have no effect on PostScript files.

Change the graphic language setting
Unless you are troubleshooting one of the problems mentioned below, you should not need to
change the default setting (Automatic), and you are not recommended to do so, because setting a
specific graphic language means that you will be able to print only files in that language.
icon, then Default printing options > Select
To change the graphic language setting, select the
graphics language, where the following options are available.
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●

Select Automatic to let the printer determine which type of file it is receiving. This setting works
for most software applications.

●

Select HP-GL/2 if you are not working with PostScript files, and you have experienced image
position problems or timing problems.

●

Select PS if you are printing only PostScript files and your PostScript jobs do not start with the
standard PostScript header (%!PS) and do not include PJL language switching commands.
Alternatively, select PS if you have experienced problems while downloading PostScript fonts.
In this case, please reselect Automatic after you have downloaded the fonts.
If you are downloading fonts over a USB connection, select the
options > PS options > Select encoding > ASCII.

●

icon, then Default printing

Select TIFF, JPEG, PDF, or CALS G4 only if you are sending a file of the appropriate type
directly to the printer without going through a printer driver. This is normally done only from the
Embedded Web Server, in which case the language setting is done by the Embedded Web
Server and you do not have to do it yourself.
NOTE The PS and PDF options are available with PostScript printers only.

How do I... (image
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10 How do I... (color topics)

Perform color calibration

●

Perform black point compensation

●

Set the rendering intent

●

Select the color emulation mode

●

Produce matching prints from different HP Designjets

●

Get accurate colors from Adobe Photoshop CS (HP–GL/2 & RTL driver)

●

Get accurate colors from Adobe Photoshop CS (PostScript driver)

●

Get accurate colors from Adobe InDesign CS

●

Get accurate colors from QuarkXPress 6

●

Get accurate colors from Autodesk AutoCAD

●

Get accurate colors from Microsoft Office 2003

●

Get accurate colors from ESRI ArcGIS 9
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Perform color calibration
Color calibration improves color consistency between prints, and from one printer to another.
It is normally performed whenever a printhead is replaced, and whenever a new paper type is
introduced that has not been calibrated yet with the new printhead(s). However, this automatic
behavior can be turned off, and a default color correction used for each of the known paper types.

1.

From the front panel, select the

2.

The available options for color calibration are:

3.

icon, then Printer configuration > Color calibration.

●

On: the printer performs color calibration whenever you introduce a new paper type that
has not yet been calibrated with the current set of printheads. The color correction resulting
from the calibration is then used for subsequent prints on that paper type with the same
print quality setting.

●

Off: the printer uses a default color correction, different for each paper type and print
quality setting.

The printer calibrates the colors by printing a calibration strip, scanning the strip with a built-in
optical sensor, and calculating the color corrections required. The color calibration strip is 269
mm wide, and 18 mm long when using glossy paper; on other paper types, it is 109 mm long.
Color calibration takes about three to six minutes, depending on the paper type.
NOTE Color calibration can be requested manually at any time from the front panel, by
selecting the

icon, then Printhead management > Calibrate color.

CAUTION Color calibration can be performed successfully on opaque materials only. Do not
attempt to calibrate transparent film.

Perform black point compensation
How do I... (color topics)

The black point compensation option controls whether to adjust for differences in black points when
converting colors between color spaces. When this option is selected, the full dynamic range of the
source space is mapped into the full dynamic range of the destination space. It can be very useful in
preventing blocking shadows when the black point of the source space is darker than that of the
destination space. This option is allowed only when the relative colorimetric rendering intent is
selected (see Set the rendering intent).
Black point compensation can be specified in the following ways:
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●

Using a Windows PostScript printer driver: select the Color tab, then Black point compensation.

●

Using a Mac OS printer driver: select the Color Options panel, then Black point compensation.
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●
●

Using the Embedded Web Server: select the Submit Job page, then Black point compensation.
Using the front panel: select the
Black point compensation.

icon, then Default printing options > Color options >

Set the rendering intent
Rendering intent is one of the settings used when doing a color transformation. As you probably
know, some of the colors you want to print may not be reproducible by the printer. The rendering
intent allows you to select one of four different ways of handling these so–called out–of–gamut colors.
●

Saturation (graphics): best used for presentation graphics, charts, or images made up of
bright, saturated colors.

●

Perceptual (images): best used for photographs or images in which colors blend together. It
tries to preserve the overall color appearance.

●

Relative colorimetric (proofing): best used when you want to match a particular color. This
method is mainly used for proofing. It guarantees that, if a color can be printed accurately, it will
be printed accurately. The other methods will probably provide a more pleasing range of colors
but do not guarantee that any particular color will be printed accurately. It maps the white of the
input space to the white of the paper on which you are printing.

●

Absolute colorimetric (proofing): the same as relative colorimetric, but without mapping the
white. This rendering is also used mainly for proofing, where the goal is to simulate the output of
one printer (including its white point).

The rendering intent can be specified in the following ways:
●

Using a Windows PostScript printer driver: select the Color tab, then Rendering intent.

●

Using a Mac OS printer driver: select the Color Options panel, then Rendering intent.

●

Using the Embedded Web Server: select the Submit Job page, then Rendering intent.

●

Using the front panel: select the
Select rendering intent.

icon, then Default printing options > Color options >

Select the color emulation mode
You can set the color emulation mode in the following ways:
Using a Windows printer driver: select the Color Management section of the Color tab.

●

Using a Mac OS printer driver: select the Color Options panel.

●

Using the Embedded Web Server: select the Color Management section of the Submit Job page.

●

Using the front panel: select the

How do I... (color topics)

●

icon, then Default printing options > Color options.

See Color emulation modes.

Produce matching prints from different HP Designjets
See Color matching between different HP Designjets.
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Get accurate colors from Adobe Photoshop CS (HP–GL/2
& RTL driver)
This topic outlines one way to have good control over the printed colors you will obtain from your
printer; there are many other ways. Before starting, ensure that your paper type has already been
calibrated.

Application settings
1.

Open Adobe Photoshop and select Color Settings from the Edit menu.
●

Working spaces: the working space is the color space you want to use when manipulating
the image. We recommend using the color space that comes with the image (see Color
Management Policies below), if any; otherwise, our recommended default settings are:
RGB: Adobe RGB 1998, CMYK: SWOP for the USA and Euroscale Coated v2 for the rest
of the world.

●

Color Management Policies: select 'Preserve Embedded Profiles'.

●

Rendering Intent: see Set the rendering intent.

●

Black Point Compensation: this option is recommended if you have chosen the Relative
Colorimetric rendering intent. See Perform black point compensation.

How do I... (color topics)
156

Chapter 10

How do I... (color topics)

ENWW

2.

Open the image. Accept the embedded color profile if there is one:

Otherwise accept the default that Adobe Photoshop proposes:

ENWW

Once you have defined the color space in which you are going to work, you can if you like make
a soft proof, which means emulating on the screen how the image will look when printed. To do
this, you will need an ICC profile for your monitor. Select View > Proof Setup > Custom. Use
the following information to select options in the Proof Setup window.
●

Profile: choose the profile based on the printer model and paper type you intend to use.

●

Preserve Color Numbers: this checkbox tells the application how to simulate the
document's appearance without converting colors from the Document Space to the Proof
Profile Space. It simulates the color shifts that may occur when the document's color
values are interpreted using the Proof Profile instead of the Document Profile. This option
is not recommended.

●

Intent: this menu allows you to choose a rendering intent for the conversion from
document space to simulation space, letting you preview the effects of different renderings.
See Set the rendering intent.

●

Use Black Point Compensation: this option is recommended if you have chosen the
Relative Colorimetric rendering intent. See Perform black point compensation.

●

Paper White: this checkbox emulates the whiteness of the paper on the monitor. The
effect is the same as using the Absolute Colorimetric rendering intent.

●

Ink Black: this checkbox turns off the black point compensation for the rendering from
simulation to the monitor. So, if the simulation space black is lighter than the monitor black,
you will see the washed-out blacks on the monitor. This option is not recommended.

●

Preview: if this checkbox is enabled (recommended), the changes you make in this
window are reflected in the image immediately.

Get accurate colors from Adobe Photoshop CS (HP–GL/2 & RTL driver)
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3.

4.

When you are ready to print the image, open the Print with Preview window from the File menu.
In the Color Management tab you can select:
●

Source Space: 'Document' (automatically assigned for you).

●

Profile: select the profile you will use. We recommend using Adobe RGB. If neither Adobe
RGB or sRGB is selected, then choose the appropriate ICC profile for the paper loaded,
and remember to select later on in the driver the option Managed by Application.

●

Intent: See Set the rendering intent.

How do I... (color topics)

Driver settings
In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print Quality to Best.
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In the Color tab (Windows) or Color Options panel (Mac OS), you have the following Color
Management options. Select the same option that you selected in the Print dialog box above (Print
Space section, Profile option).
●

sRGB: this is the default color space. The input RGB data are converted to CMYK using the
printer's internal color maps, which depend on the paper type and print quality selected. These
are the most “versatile” color maps, producing saturated colors for CAD and office applications
and also producing good results with photographic images.

●

AdobeRGB: similar to sRGB, but using the AdobeRGB to CMYK internal color maps, which are
designed for AdobeRGB input data with a bigger source gamut. Best suited to digital
photography.

●

Managed by Application: the driver will not perform any color correction. This path can be
used when building custom RGB printer profiles and applying them within the application (the
application is responsible for applying the right color management by using the custom RGB
printer profiles). In this case, make sure that you have selected the right media profile in the
"Print Space, Profile" option in the application print command (see above).

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you intend to use.

How do I... (color topics)

Get accurate colors from Adobe Photoshop CS
(PostScript driver)
This topic outlines one way to have good control over the printed colors you will obtain from your
printer; there are many other ways. Before starting, ensure that your paper type has already been
calibrated.
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Application settings
1.

Open Adobe Photoshop and select Color Settings from the Edit menu (Windows) or from the
Photoshop menu (Mac OS).
●

Working spaces: the working space is the color space you want to use when manipulating
the image. We recommend using the color space that comes with the image (see Color
Management Policies below), if any; otherwise, our recommended default settings are:
RGB: Adobe RGB 1998, CMYK: SWOP for the USA and Euroscale Coated v2 for the rest
of the world.

●

Color Management Policies: select 'Preserve Embedded Profiles'.

●

Rendering Intent: see Set the rendering intent.

●

Black Point Compensation: this option is recommended if you have chosen the Relative
Colorimetric rendering intent. See Perform black point compensation.
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2.

Open the image. Accept the embedded color profile if there is one:

Otherwise accept the default that Adobe Photoshop proposes:
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Once you have defined the color space in which you are going to work, you can if you like make
a soft proof, which means emulating on the screen how the image will look when printed. To do
this, you will need an ICC profile for your monitor. Select View > Proof Setup > Custom. Use
the following information to select options in the Proof Setup window.
●

Profile: choose the profile based on the printer model and paper type you intend to use.

●

Preserve Color Numbers: this checkbox tells the application how to simulate the
document's appearance without converting colors from the Document Space to the Proof
Profile Space. It simulates the color shifts that may occur when the document's color
values are interpreted using the Proof Profile instead of the Document Profile. This option
is not recommended.

●

Intent: this menu allows you to choose a rendering intent for the conversion from
document space to simulation space, letting you preview the effects of different renderings.
See Set the rendering intent.

●

Use Black Point Compensation: this option is recommended if you have chosen the
Relative Colorimetric rendering intent. See Perform black point compensation.

●

Paper White: this checkbox emulates the whiteness of the paper on the monitor. The
effect is the same as using the Absolute Colorimetric rendering intent.

●

Ink Black: this checkbox turns off the black point compensation for the rendering from
simulation to the monitor. So, if the simulation space black is lighter than the monitor black,
you will see the washed-out blacks on the monitor. This option is not recommended.

●

Preview: if this checkbox is enabled (recommended), the changes you make in this
window are reflected in the image immediately.

Get accurate colors from Adobe Photoshop CS (PostScript driver)
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3.

4.

When you are ready to print the image, open the Print with Preview window from the File menu.
In the Color Management tab you can select:
●

Source Space: 'Document' (automatically assigned for you). This is the color space in
which you have been working while editing the image.

●

Profile: select PostScript Color Management (if you do not see this option, select Printer
Color Management). With this option, the application tells the driver which source profile
and rendering intent should be used for the conversion to the print space. In this case the
driver will use the 'Document' profile and the rendering intent selected below. The driver's
Input Profile and Rendering Intent settings are overridden.

●

Intent: see Set the rendering intent.
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Driver settings
The application's PostScript Color Management option will override the color settings of the driver
(Input Profile and Rendering Intent). In this case, the driver will use the application's "Document"
profile and selected rendering intent. Then, we have only to select in the driver:
●

In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print Quality to Best.

●

In the Color tab (Windows) or Color Options panel (Mac OS), check the Automatic PANTONE
Calibration or HP Professional PANTONE Emulation box.

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you intend to use.

Get accurate colors from Adobe InDesign CS
This topic outlines one way to have good control over the printed colors you will obtain from your
printer; there are many other ways. We describe the hard-proofing technique that shows you on your
printer how your colors will appear when reproduced in a press. Before starting, ensure that your
paper type has already been calibrated.
NOTE EPS, PDF, and grayscale images don't allow page-layout applications to manage
their colors. In addition, such images are displayed very poorly on a monitor.

Application settings
Open Adobe InDesign and select Color Settings from the Edit menu.
●

Working spaces: the working space is the color space you want to use when manipulating
the image. We recommend using the color space that comes with the image (see Color
Management Policies below), if any; otherwise, our recommended default settings are:
RGB: Adobe RGB 1998, CMYK: SWOP for the USA and Euroscale Coated v2 for the rest
of the world.

●

Color Management Policies: select 'Preserve Embedded Profiles'.

●

Rendering Intent: see Set the rendering intent.

●

Black Point Compensation: this option is recommended if you have chosen the Relative
Colorimetric rendering intent. See Perform black point compensation.
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2.

Create or open the image with its own or the most appropriate color space. Then retouch the
image as needed.

3.

When you have the image ready to send to the output device, that is the moment to simulate on
your printer what will appear on the output device. You must convert the image from the source
or work profile to the output CMYK device, and then again from the output CMYK device to the
printer profile (calibrated).
In InDesign we recommend the Proof Setup command (View > Proof Setup -> Custom). This
command lets you select the "proof profile" in the source space when printing. You can also see
a simulation on your monitor. We recommend as follows:

How do I... (color topics)

Each object in InDesign has its own color management. The InDesign elements (native) use the
working spaces (default profiles) and the rendering intent defined in Color Settings , and the
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placed objects have their own assigned profile and rendering intent. Then, each element is
converted from its own color space to the simulation color space, using its own rendering intent.
Profile: select the profile that corresponds to the device you want to emulate (usually a
particular press profile or an standard press profile)

●

Paper White: this checkbox emulates the whiteness of the paper on the monitor. The
effect is the same as using the Absolute Colorimetric rendering intent.

●

Ink Black: this checkbox turns off the black point compensation for the rendering from
simulation to the monitor. So, if the simulation space black is lighter than the monitor black,
you will see the washed-out blacks on the monitor. This option is not recommended.

Select File > Print to print the image, converting it to an output space that depends on the
printer, the paper type, and the print quality.
●

Select the Output tab (on the left), and then select Composite CMYK, in order to see the
CMYK profiles.

●

Select the Color Management tab to see the following options.

●

Source Space: select 'Proof' to emulate the proof color space.

●

Profile: choose the profile based on the printer model and paper type you intend to use.

●

Intent: select Relative or Absolute Colorimetric. The only difference is that Absolute
Colorimetric emulates the background color of the paper to be used by the press, while
Relative Colorimetric maps the paper color of the press to the paper color of the printer.
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4.

●

Driver settings
The PostScript driver is recommended for page-layout applications because it can color–manage
CMYK data, RGB data, or both simultaneously.
In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print Quality to Best.
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In the Color tab (Windows) or Color Options panel (Mac OS), select 'Application Managed Colors'
and check the Automatic PANTONE Calibration box. When the application performs color conversion
to the printer's color space, the printer should accept these colors without changing them. Make sure
you have selected the right media profile in “Print Space, Profile” above.

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you intend to use.

Get accurate colors from QuarkXPress 6
This topic outlines one way to have good control over the printed colors you will obtain from your
printer; there are many other ways. We describe the hard-proofing technique that shows you on your
printer how your colors will appear when reproduced in a press. Before starting, ensure that your
paper type has already been calibrated.
NOTE EPS, PDF, and grayscale images don't allow page-layout applications to manage
their colors. In addition, such images are displayed very poorly on a monitor.

Application settings
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1.

Open QuarkXPress and select Preferences from the Edit menu (Windows) or the QuarkXPress
menu (Mac OS). Then select Quark CMS from the Preferences dialog box.

2.

Ensure that the Color Management Active box is checked.

3.

The Destination Profiles area lets you choose profiles that correspond to your devices: Monitor
profile, Composite Output profile, and Separation Output profile. Select in the Separation Output
profile the profile of your output device (press) which you want to emulate on your printer later.
Select in the Composite Output profile your printer profile; remember that it depends on the
printer model, paper type, and print quality option.
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4.

In the Default Source Profiles you must set the default profiles for solid colors and images that
don't have embedded profiles. The following default profiles are recommended: RGB: Adobe
RGB 1998, CMYK: SWOP for the USA and Euroscale Coated v2 for the rest of the world. Also
select the rendering intent, which QuarkXPress uses for all conversions; if in doubt, select
Relative Colorimetric. See Set the rendering intent.

5.

Check the box Color Manage RGB sources to RGB destinations in the RGB Default Source
Profiles and Color Manage CMYK sources to CMYK destinations in the CMYK Default
Source Profiles.

6.

The Display Simulation tells QuarkXPress how the display simulation should behave:
●

None means that it doesn't simulate anything on the display.

●

Monitor Color Space means that it converts from the source profile to the display profile
for display only.

●

Composite Output Color Space makes the display simulate a composite printer: that is, a
printer without separate plates for different colors, such as an inkjet printer.

●

Separation Output Color Space makes the display simulate a separations printer: that is,
a printer with separate plates for different colors, such as a digital press.

You can select Monitor Color Space if you want to display only, or you can select the
Separation Output Color Space if you also want to see the simulation of the output device on
the monitor. You can simulate the final output with the printer (hard–proofing) and with the
monitor (soft-proofing ).
7.

Open and retouch the document as you like.

8.

Select File > Print > Setup > Printer Description, and select your printer.

9.

Select File > Print > Profiles.
Select the appropriate Separation Output Profile (emulation) and Composite Output Profile
(printer).

●

Check the Composite Simulates Separation box, then Quark will perform the simulation.
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NOTE Each object in QuarkXpress has its own color management. The solid colors use the
color profile and rendering intent selected in the default source profiles for Solid Colors (RGB,
CMYK, or Hexachrome) of the Color Management Preferences dialog box. The imported
objects have their own assigned profile and rendering intent. QuarkXPress will use the
rendering intent assigned to the image for both conversions, from the image color space to the
simulation color space, and from the simulation color space to the printer color space.

Driver settings
The PostScript driver is the best choice for page-layout applications because it can color–manage
CMYK data, RGB data, or both simultaneously.
In the Image Quality panel, set Print Quality to Best.
In the Color Options panel, select Application Managed Colors and check the Automatic
PANTONE Calibration box. When the application performs color conversion to the printer's color
space, the printer should accept these colors without changing them. Make sure you have selected
the right media profile in Composite Output in the Preferences dialog box.

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you intend to use.

Get accurate colors from Autodesk AutoCAD
AutoCAD has no color management settings, so the best you can do is to configure the driver
correctly. If you are using the HP-GL/2 and RTL driver, click the Properties button and configure the
driver as follows.
●

In the Paper/Quality tab, set Print Quality to Best.

●

In the Color tab, ensure that the Print In Grayscale box is unchecked, and set Color Matching
Method to 'sRGB'.

Get accurate colors from Microsoft Office 2003
Microsoft Office has no color management settings, so the best you can do is to configure the driver
correctly. If you are using the HP-GL/2 and RTL driver, click the Properties button and configure the
driver as follows.
●

In the Paper/Quality tab, set Print Quality to Best.

●

In the Color tab, ensure that the Print In Grayscale box is unchecked, and set Color
Management to 'sRGB'.
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Get accurate colors from ESRI ArcGIS 9
ArcGIS is a scalable system of software for geographic data creation, management, integration,
analysis, and dissemination for every organization, from an individual to a globally distributed
network of people.
The application always sends RGB data to the printer driver; you can choose between several
different printer engines. The printer engine determines the format and method used by ArcMap to
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send the print job to the printer. There are from one to three options available, depending on license
and printer configurations.
●

Windows is the default and is always available, regardless of the printer in use. It allows the
application to use the installed HP-GL/2 and RTL driver.

●

PostScript is available only if your printer supports PostScript and the PostScript driver was
selected in the Name section. This allows you to output the file as a Postscript file. This option
may be useful in certain specific cases, but in general it is not recommended.

●

ArcPress is an extension that can be purchased for printing from ArcGIS. It is a software RIP
that takes the original metafile and rasterizes it before sending it to the printer, so that the
printer does not need to rasterize it. This is beneficial because some printers are not capable of
rasterization or do not have enough memory to process large jobs. Use ArcPress always with
HP RTL (RGB) TrueColor.

1.

Ensure that you have installed the HP-GL/2 and RTL driver.

2.

When you are ready to print, select File > Page and Print Setup, and select the HP-GL/2 and
RTL driver.

3.

Click the Properties button and configure the driver as follows.

4.

ENWW

●

In the Paper/Quality tab, set Print Quality to Best.

●

In the Color tab, ensure that the Print In Grayscale box is unchecked, and set Color
Matching Method to 'sRGB'.
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Printing with the Windows printer engine

Click the OK button.
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5.

Select File > Print.
●

Printer Engine: select Windows Printer (it will use the selected raster driver).

●

Output Image Quality (Resample Ratio): this setting alters the number of pixels sampled
when an ArcMap print file is generated; it determines how many pixels in the map
document will be used to create the file sent to the printer.
●

Fast = 1:5

●

Normal = 1:3

●

Best = 1:1 (as is)

The 'Best' choice requires a lot of resources to process the print job, and could cause long
processing times and perhaps out–of–memory messages, depending on the map size. If
you have these problems, select an Output Image Quality lower than 'Best'. Bear in mind
that you will gain no advantage in print quality by sending an image whose resolution is
higher than the printer's input resolution.

6.

You can print now (click the OK button).

Printing with the ArcPress printer engine
How do I... (color topics)

1.

You must have the driver you need installed, although it will function only as a port.

2.

When you are ready to print, select File > Page and Print Setup, select the driver (the driver
settings have no effect), and click the OK button.

3.

Select File > Print.
●
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Printer Engine: select ArcPress.
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Click the Properties button, select the HP RTL (RGB) TrueColor driver, and select the
resolution that will be sent to the printer.

●

Select the Color Adjustment tab if you want to adjust gamma, brightness, contrast, or
saturation. You can preview the changes.

You can print now: click the OK button in this dialog box and in the Print dialog box.
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4.

●
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●

Remove an ink cartridge

●

Insert an ink cartridge

●

Remove a printhead

●

Insert a printhead

●

Manage printhead monitoring

●

Recover (clean) the printheads

●

Clean a printhead's electrical connections

●

Align the printheads

●

Remove a printhead cleaner

●

Insert a printhead cleaner

●

Check the status of the ink system

●

Get ink cartridge statistics

●

Get printhead statistics
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Remove an ink cartridge
There are two types of ink cartridge removal.
●

The ink cartridge is very low and you want to replace it with a full cartridge for unattended
printing (you can use up the remaining ink in the first cartridge at a more convenient time).

●

The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION Do not try to remove an ink cartridge while printing.
CAUTION Remove an ink cartridge only if you are ready to insert another one.
WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.

174

1.

At the printer's front panel, select the

2.

The ink cartridge door is on the left-hand side of the printer.
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icon, then Replace ink cartridges.
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Release the door catch by pressing on the top until it clicks.

4.

Pull the door fully open.

5.

Grip the blue tab in front of the cartridge you wish to remove.

6.

Pull the blue tab down.

How do I... (ink system
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3.

Remove an ink cartridge
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7.

Then pull it outwards, towards you.

8.

The cartridge comes out, in its drawer.

9.

Lift the cartridge out of its drawer.

NOTE Avoid touching the end of the cartridge that is inserted into the printer, as there
may be ink on the connection.
NOTE Avoid storing partially used ink cartridges on their ends.
10. The front panel display will identify the missing ink cartridge.
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1.

Pick up the new ink cartridge and find the label identifying the ink color. Hold the ink cartridge so
that you can see the identifying colored label at the top of the side facing you.

2.

Check that the colored label above the empty slot in the printer matches the color of the label on
the cartridge.

3.

Insert the ink cartridge into the cartridge drawer.

Position the cartridge at the rear of the drawer as indicated below.
NOTE A larger black ink cartridge is available that uses the whole length of the drawer.

4.

Slide the drawer and cartridge into the slot until it locks into position.

If you have difficulty, see I cannot insert an ink cartridge.

ENWW

Insert an ink cartridge
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Insert an ink cartridge

How do I... (ink system
topics)

5.

When all cartridges have been inserted, close the door (push it until it clicks shut).

6.

The front panel display confirms that all cartridges have been correctly inserted.

Remove a printhead
WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.
Printhead replacement must be performed with the printer switched on at the power isolation switch.

1.

At the printer's front panel, select the
printheads.

2.

The printer moves the carriage into the correct position.

icon, then Printhead management > Replace

CAUTION If the carriage is left in the central part of the printer for more than seven
minutes. it will try to move back to its normal position in the right-hand end.
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When the carriage has stopped moving, the front panel will ask you to open the window.

4.

Locate the carriage.

5.

Pull up and release the latch on top of the carriage.

6.

Lift up the cover. This will now give you access to the printheads.

Remove a printhead
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3.
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7.

To remove a printhead, lift up the blue handle.

8.

Using the blue handle, gently disengage the printhead.

9.

Gently pull the blue handle upward until the printhead is released from the carriage.
CAUTION Do not pull abruptly because this can damage the printhead.

10. The front panel display identifies the missing printhead.
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Insert a printhead
1.

If the printhead is new:
a.

Remove the blue protective cap by pulling down on it.

b.

Remove the clear protective tape from the printhead's nozzles by pulling on the paper tab.

The printhead is designed to prevent you from accidentally inserting it into the wrong position.
Check that the colored label on the printhead matches the colored label of the carriage position
into which the printhead is to be inserted.
2.

Insert the new printhead into its correct position in the carriage.
CAUTION Insert the printhead slowly and vertically, straight down. It may be damaged
if you insert it too fast, or at an angle, or if you turn it as you insert it.

ENWW

Insert a printhead
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3.

Push down as indicated by the arrow shown below.

When installing the new printhead there may be some resistance, so you need to press it down
firmly but smoothly.
If you have difficulty, see I cannot insert a printhead.
4.

Insert any other printheads that need to be installed, and close the carriage cover.

When all the printheads have been inserted correctly and accepted by the printer, the printer will
beep.
NOTE If the printer does not beep when you insert the printhead and the Replace
message appears on the front panel, the printhead may need to be reseated.
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5.

Latch the carriage cover.

When the carriage has been correctly latched, it looks like this:

6.

Close the window.

7.

The front panel display confirms that all printheads are correctly inserted.

8.

Now replace the printhead cleaners for any printheads that have been changed. See Remove a
printhead cleaner and Insert a printhead cleaner.
CAUTION Leaving the old printhead cleaner in the printer will shorten the new
printhead's life and possibly damage the printer.

Manage printhead monitoring
The printer automatically checks the status of the printheads from time to time in order to monitor
their health and detect any problems that might affect print quality. The frequency of these checks is
optimized to maintain good throughput.
If you want to increase the frequency of printhead monitoring in order to detect any problems sooner,
icon, then Printer configuration > Printhead monitoring > Intensive. When the
select the
printer is printing and printhead monitoring is set to Intensive, the front panel and the Embedded
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Web Server printer status line will display the following message: Printing. Printhead monitoring
(instead of just Printing).
NOTE When Intensive is selected, the throughput of the printer will be reduced because of
the increased frequency of printhead checks.
To return to the default printhead monitoring frequency, select the
configuration > Printhead monitoring > Optimized.

icon, then Printer

Recover (clean) the printheads
To clean the printheads (which often enables them to recover from problems), go to the printer's front
panel and select the
icon, then Printhead management > Recover printheads. Cleaning takes
about two to four minutes.

Clean a printhead's electrical connections
In some extreme cases it is possible that the printer will not recognize a printhead after it has been
installed. This is due to the build-up of ink deposits on the electrical connections between the
printhead and the printhead carriage. Under these circumstances you are recommended to clean the
printhead's electrical connections. Routine cleaning of the connections when there are no apparent
problems is not recommended.
Included with your printer (in the Maintenance Kit box) is a carriage interconnect wiper.

This should be used for cleaning the electrical interconnects of both the printhead carriage and the
printhead, which should be done if the front panel persistently displays the Reseat or Replace
message next to the printhead.
1.

Remove a new pre-moistened replacement sponge from its pouch.

A supply of sponges is included in the box with the wiper. If all sponges have been used, more
can be obtained by contacting your customer service representative.
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2.

Open the carriage interconnect wiper.

3.

Load the sponge into the carriage interconnect wiper by positioning the sponge on the face of
the carriage interconnect wiper with the shorter tab in the locating slot.

4.

Close the carriage interconnect wiper, trapping the sponge in place.

5.

Open the printhead carriage latch and extract the printhead that has the problem, as indicated
on the front panel. See Remove a printhead.

Clean a printhead's electrical connections
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6.

Insert the carriage interconnect wiper into the printhead slot at the back. Wipe the electrical
contacts by inserting the tool between the electrical connections at the back of the slot and the
steel spring with the sponge facing away from you and towards the electrical contacts. Try to
avoid picking up any ink deposit which may have accumulated on the bottom surface of the slot.
CAUTION If the carriage is left in the central part of the printer for more than seven
minutes. it will try to move back to its normal position in the right-hand end.
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7.

Rub the sponge against the contacts with a light force along the entire depth of the flex
connector as allowed by the mechanical stop on the tool.

8.

Take special care to clean all contacts thoroughly, including the ones at the lowest point of the
connector.
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9.

Using the same sponge, clean the lower strip of electrical contacts on the printhead (unless the
printhead is new), avoid touching the upper set of electrical contacts.

CAUTION Do not touch the surface of the printhead containing the nozzles, which are
easily damaged.
10. After waiting a few moments to allow both connectors to dry, replace the printhead into the
printhead carriage. See Insert a printhead.
11. On completion of the cleaning process, open the carriage interconnect wiper by pulling on the
sponge tab.

12. Remove the soiled sponge from the carriage interconnect wiper.

ENWW

Clean a printhead's electrical connections
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13. Dispose of the soiled sponge in a safe place to prevent the transfer of ink onto hands and
clothing.

If the front panel continues to display the Reseat or Replace message, replace the printhead or
contact your customer service representative.

Align the printheads
The printer will normally perform printhead alignment whenever printheads are replaced. If there is
no paper loaded when a printhead is replaced, the printer will perform the alignment the next time
you load paper.
NOTE You can turn off these automatic printhead alignments from the front panel: select the
icon, then Printer configuration > Auto printhead alignment > Off.
In addition, you should align the printheads if the Image Diagnostics Print indicates an alignment
error. See How do I... (Image Diagnostics Print topics).
1.

Make sure that you have a roll of opaque paper loaded in the printer; the best results will be
achieved with the type of paper that you normally use for printing. Single sheets of paper, and
transparent materials such as translucent bond, clear film, matte film, tracing paper, and vellum
are not suitable for printhead alignment.

2.

To request printhead alignment (if the alignment is not being performed automatically), go to the
front panel, select the
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3.

If you are close to the beginning of a roll, the front panel will report that the printer may need to
feed up to 3 m (≈ 10 ft) of paper before starting the printhead alignment. This is necessary to
ensure a successful alignment. In this case, you will be given the following options:
●

To continue with the printhead alignment, allowing the printer to feed as much paper as
necessary

●

To schedule the printhead alignment to be performed later, after you have used a few
meters of paper for printing

●

To cancel the printhead alignment

If you choose to continue with the printhead alignment, the process will start immediately,
unless an image is currently being printed, in which case the alignment will be done as soon as
the current print job is finished.
The alignment process takes about twelve minutes.

Remove a printhead cleaner
After you have replaced a printhead, the front panel will prompt you to replace the printhead cleaner.
CAUTION When replacing a printhead, always replace the corresponding printhead cleaner.
Leaving the old cleaner in the printer will seriously shorten the new printhead's life and
possibly damage the printer. A new printhead cleaner is provided with each new printhead.
When removing a printhead cleaner:
●

Be careful not to get ink on your hands. There may be ink on, around, and inside the replaced
printhead cleaner.

●

Always handle and store the replaced printhead cleaner upright to avoid spilling any ink.
WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.

1.

ENWW

The printhead cleaners are located in slots underneath the front panel, at the front of the printer.
Press the top of the service station door to release the catch.

Remove a printhead cleaner
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2.

Open the door.

3.

Each printhead cleaner has a handle on the front. To remove the cleaner, press inward and
upward as indicated by the arrow shown here, until the cleaner is released.

4.

Lift up the printhead cleaner to remove it from the slot, and slide it out horizontally as shown
below.

See also Insert a printhead cleaner.

Insert a printhead cleaner
The plastic bag in which the new printhead cleaner comes can be used to dispose of the old
printhead and printhead cleaner.
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Insert each printhead cleaner into the correct color slot location, in the service station, in the
direction indicated by the arrow shown here.

2.

When the printhead cleaner has been pushed all the way in, press inwards and downwards as
indicated by the arrow shown here, until it clicks into place.

How do I... (ink system
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1.

If you have difficulty, see I cannot insert a printhead cleaner.
NOTE The front panel will not show the new printhead cleaner until the right-hand door
is closed.
3.

When you have inserted the printhead cleaner(s) into the printer, close the door.

NOTE The printer needs all the ink cartridges, printheads, and printhead cleaners to be
installed before it can continue.
4.

ENWW

If no paper is loaded, the front panel will instruct you to load some.

Insert a printhead cleaner
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Whenever you insert a new printhead and cleaner, the printer will normally perform a printhead
alignment and color calibration. Both are recommended for best print quality. In some cases, you
may decide to postpone printhead alignment until after some further printing has been done.
NOTE If you prefer to save some time at the expense of print quality, you can turn off these
icon, then Printer
automatic procedures from the front panel, by selecting the
configuration > Auto printhead alignment > Off and Printer configuration > Color
calibration > Off.
The front panel may request that you load paper that is suitable for printhead alignment. The
printhead alignment procedure requires a roll of opaque paper: not a single sheet, and not any kind
of transparent or translucent material.
When the front panel displays Ready, you are ready to print.
NOTE Make sure the printer window and the right-hand door are closed after you replace
the supplies. The printer will not print while these are open.

Check the status of the ink system
1.

Access the Embedded Web Server (see Access the Embedded Web Server).

2.

Go to the Supplies page.

The Supplies page shows you the status of the ink cartridges (including the ink levels), the
printheads, the printhead cleaners, and the loaded paper.
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Get ink cartridge statistics
To get information on your ink cartridges:
1.

Go to the front panel and select the

2.

Select Ink cartridge information, then select the cartridge on which you want information.

3.

The front panel displays:
●

Its color

●

Its product name

●

Its product number

●

Its serial number

●

Its status

●

Its ink level, if known

●

Its total ink capacity in milliliters

●

Its manufacturer

●

Its warranty status

icon.

You can also get most of this information without leaving your computer by using the Embedded
Web Server.
For an explanation of the ink cartridge status messages, see An ink cartridge status message.

Get printhead statistics
To get information on your printheads:
1.

Go to the front panel and select the

2.

Select Printhead information, then select the printhead on which you want information.

3.

The front panel displays:
●

Its color

●

Its product name

●

Its product number

●

Its serial number

●

Its status

●

The volume of ink it has used

●

Its warranty status

●

The status of its cleaner

icon.

You can also get most of this information without leaving your computer by using the Embedded
Web Server.
For an explanation of the printhead and printhead cleaner status messages, see A printhead status
message and A printhead cleaner status message.
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Get ink cartridge statistics
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If the warranty status is See warranty note, this indicates that non-HP ink is being used. See
Worldwide Limited Warranty—HP Designjet 4000/4500 Printer series and 4500mfp for details of the
warranty implications.
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Get accounting information from the printer

●

Check printer usage statistics

●

Check ink and paper usage for a job

●

Request accounting data by E-mail
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Get accounting information from the printer
There are various different ways of getting accounting information from your printer.

How do I... (accounting
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●

View printer usage statistics for the whole lifetime of the printer, or for particular periods. See
Check printer usage statistics.

●

View ink and paper usage for each of your recent jobs by using the Embedded Web Server or
the printer's front panel. See Check ink and paper usage for a job.

●

Request accounting data by E-mail. The printer sends data in XML at regular intervals to a
specified E-mail address; the data may be interpreted and summarized by a third-party
application, or displayed as an Excel spreadsheet. See Request accounting data by E-mail.

●

Use a third-party application to request printer status, printer usage, or job accounting data from
the printer through the Internet. The printer provides data in XML to the application whenever
requested. HP provides a Software Development Kit to facilitate the development of such
applications.

Check printer usage statistics
1.

Access the Embedded Web Server (see Access the Embedded Web Server).

2.

Go to the Usage page.

3.

Go to the Historical tab to see the accumulated usage of the printer since the first day.

4.

Go to the Snapshot tab to save a record of the accumulated usage since the first day, and
reset the Accumulated tab's counters to zero.

5.

Go to the Accumulated tab to view the accumulated usage since the last snapshot.
NOTE The accuracy of these usage statistics is not guaranteed.

Check ink and paper usage for a job
1.

Access the Embedded Web Server (see Access the Embedded Web Server).

2.

Go to the Accounting page, which shows you all the information regarding the jobs recently
printed by the printer.
Alternatively, go to the Jobs Queue page, and click on the name of the job on which you want
information. Its properties page will then be displayed.

Request accounting data by E-mail
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1.

Ensure that the printer's date and time have been set correctly. See Set the date and time.

2.

Also in the Settings tab, check that the E-mail server has been set correctly.

3.

Also in the Settings tab, select Device setup and choose settings in the Accounting section.
You must enter an E-mail address to which accounting files can be sent, and the frequency with
which they will be sent.

4.

You may also choose to require an account ID with every print job. In this case, anyone sending
a print job must provide an account ID, otherwise the printer will hold the job in the queue until
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an ID is provided. You can supply an account ID when submitting a job with the Embedded Web
Server or with a printer driver (using the Accounting tab).
5.

When you have completed the above steps, the printer will send accounting data by E-mail with
the frequency that you specified. The data are provided in XML and can easily be interpreted by
a third-party program. The data provided on each job include the job name, the account ID if
any, the user name, when the job was submitted, when the job was printed, the printing time,
the type of image, the number of pages, the number of copies, the paper type and size, the
amount of each color of ink used, and various other attributes of the job.

●

A: Low-coverage lines (less than 0.5 ml/m²)

●

B: High-coverage lines (0.5 to 2 ml/m²)

●

C: Maps and low-coverage renders (2 to 5 ml/m²)

●

D: Photographs (more than 5 ml/m²)

How do I... (accounting
topics)

Images are categorized into four types:

You can download an Excel template from HP Designjet Online (http://www.hp.com/go/designjet/)
that will enable you to display the XML data more readably in the form of a spreadsheet.
Analysis of the accounting data will enable you to bill customers precisely and flexibly for the use of
your printer. You can, for instance:
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●

Bill each customer for the total amount of ink and paper used by that customer over a particular
period.

●

Bill each customer separately per job.

●

Bill each customer separately for each project, broken down by job.

Request accounting data by E-mail
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●

Clean the exterior of the printer

●

Clean the input rollers

●

Clean the platen

●

Lubricate the printhead carriage

●

Replace the manual cutter blades

●

Maintain the ink cartridges

●

Move or store my printer

●

Update my printer's firmware
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Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part of
normal operation (e.g. ink cartridge drawer handles) as required with a damp sponge or a soft cloth
and a mild household cleaner such as non-abrasive liquid soap.
WARNING! To avoid an electric shock, make sure that the printer is switched OFF and
unplugged before you clean it. Do not let water get inside the printer.
CAUTION Do not use abrasive cleaners on the printer.

Clean the input rollers
You should plan to clean your printer's input rollers on a regular basis, once a year or when you
notice a loss of roll switching performance.
1.

Unload all paper from the printer.

2.

At the front panel, select the
icon, then Paper handling options > Clean roller > Input
roller 1 or Input roller 2. This command will rotate the roller so that the whole circumference
can be cleaned.

How do I... (printer
maintenance topics)

NOTE If you are using the HP Designjet 4000 Printer series, and you find that these
commands are not available, please download the latest firmware revision (see Update
my printer's firmware). It will be available from Spring 2006.
3.

Use a clean, absorbent lint-free cloth, slightly dampened with isopropyl alcohol, to wipe off any
dirt or paper particles from the input rollers.
NOTE Isopropyl alcohol is not provided in the Maintenance Kit.

4.

When you have finished cleaning a roller, press the Select key on the front panel to stop the
rotation.

Clean the platen
You should plan to clean your printer's platen on a regular basis, every few months or when needed.
NOTE If you print on wide paper after using narrower paper for some time, you may find that
the left side of the platen has become dirty and will leave marks on the back of the paper if not
cleaned.
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Follow these instructions to clean the platen.

Unload all paper from the printer.

2.

Open the window.

3.

With a dry brush, remove ink deposits from the cutter groove.

4.

With the same dry brush, remove ink deposits from the platen surface.

5.

At the front panel, select the
icon, then Paper handling options > Clean roller > Clean
platen. This command will rotate the small rollers on the platen so that the whole circumference
can be cleaned.

How do I... (printer
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1.

NOTE If you are using the HP Designjet 4000 Printer series, and you find that this
command is not available, please download the latest firmware revision (see Update my
printer's firmware). It will be available from Spring 2006.
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Clean the platen
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6.

Use a clean, absorbent lint-free cloth, slightly dampened with isopropyl alcohol, to wipe off
loosened ink deposits from the platen.
NOTE Isopropyl alcohol is not provided in the Maintenance Kit.

CAUTION Do not use commercial cleaners or abrasive cleaners. Do not wet the platen
directly because you will leave too much moisture behind.

How do I... (printer
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7.

Clean the cutter ramp with the damp cloth.

8.

Clean the exposed part of the wheels with a dry cloth. Ideally you should clean the whole
circumference of these wheels.
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Lubricate the printhead carriage
The printhead carriage occasionally (about once a year) needs lubrication to slide easily along the
slider rod.
1.

To gain access to the carriage, go to the front panel and select the
icon, then Printhead
management > Replace printheads. The carriage will slide into the middle section of the
printer.

2.

Take the bottle of oil from the Maintenance Kit that is supplied with your printer. A replacement
kit can be ordered if necessary.

3.

Open the window and apply a few drops of oil from the Maintenance Kit to the pads on either
side of the carriage.

4.

Apply a few drops of oil directly to the slider rod on either side of the carriage.

5.

Close the window.

How do I... (printer
maintenance topics)

CAUTION If the carriage is left in the central part of the printer for more than seven
minutes. it will try to move back to its normal position in the right-hand end.

Replace the manual cutter blades
It is unlikely that the cutter blades will need replacing unless you use them to cut a lot of heavyweight
paper. However, each cutter contains a spare blade. If you find that a cutter no longer cuts
effectively, you can replace the blade as follows.

ENWW

1.

Start with the cutter in its normal position on the right-hand side of the drawer.

2.

Remove the screw from underneath the cutter, holding on to the bottom cover to stop it falling.

3.

Remove the bottom cover by rotating it downwards and pulling outwards.

Lubricate the printhead carriage

203

4.

Remove the worn blade from the cutter.
WARNING! Take care not to touch the cutting edge of the blade.

5.

Remove the spare blade from the cutter and fix it in place of the used blade.

6.

Replace the bottom cover.

7.

Replace the screw in the bottom cover and use a screwdriver to secure it.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, you should replace a cartridge when it has reached its expiration date,
which is the date marked on the cartridge plus 6 months.

Move or store my printer
If you need to move your printer or store it for an extended period of time, you need to prepare it
properly to avoid possible damage to it. To prepare your printer, follow the instructions below.

How do I... (printer
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1.

Do not remove the ink cartridges, printheads, or printhead cleaners.

2.

Make sure that no paper is loaded.

3.

Make sure that the printhead carriage is located in the service station (the right-hand end of the
printer).

4.

Make sure that the front panel displays Ready.

5.

Switch off the power using the Power key on the front panel.

6.

Also switch off the power switch at the rear of the printer.

7.

Disconnect the printer's power cable and any cables connecting the printer to a network, a
computer, or a scanner.

8.

If you have the HP Designjet 4500 stacker, disconnect and detach it.
NOTE We strongly recommend that you do not try to disassemble the HP Designjet 4500
roll module.

Update my printer's firmware
Your printer's various functions are controlled by software that resides in the printer, otherwise known
as firmware.
From time to time firmware updates will be available from Hewlett-Packard. These updates increase
your printer's functionality and enhance the features that your printer already possesses. Firmware
can be downloaded from the Internet and installed into your printer using the Embedded Web
Server's Firmware update page (found in the Settings tab).
If you are unable to use the Embedded Web Server because you do not have a TCP/IP connection
to your printer (for instance, when using USB or AppleTalk), you can obtain HP Designjet 4000
series firmware updates and installation software from these Web pages:
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●

http://www.hp.com/support/designjet/fw4000/

●

http://www.hp.com/support/designjet/fw4000ps/
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And you can obtain HP Designjet 4500 series firmware updates and installation software from:
●

http://www.hp.com/support/designjet/fw4500/

●

http://www.hp.com/support/designjet/fw4500ps/

●

http://www.hp.com/support/designjet/fw4500mfp/
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The firmware includes a set of the most commonly used media profiles. Extra media profiles can be
downloaded separately; see Download media profiles.
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Print the Image Diagnostics Print

●

Respond to the Image Diagnostics Print

●

Interpret Image Diagnostics part 1

●

Interpret Image Diagnostics part 2

●

Interpret Image Diagnostics part 3

●

If I still have a problem
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Print the Image Diagnostics Print
The Image Diagnostics Print consists of patterns designed to highlight print quality problems. It helps
you to check whether you have a print quality problem, and if you have, what the cause of the
problem is and how to resolve it.
Before using the Image Diagnostics Print, check that you have been using appropriate print quality
settings (see Choose print quality settings).
To print the Image Diagnostics Print:
1.

Ensure that you have paper of at least A3 size (29.7 × 42 cm = 11.7 × 16.5 in) loaded into the
printer. Use the same paper type that you were using when you detected a problem.

2.

Ensure that the front panel has the same print quality settings that you were using when you
detected the problem (see Change the print quality). In the Image Diagnostics Print, the only
difference between Drawings/text and Images is that the latter uses more ink in part 2, so that
the colors appear darker.
To print the Image Diagnostics Print will take about two minutes if you choose Images;
sometimes less if you choose Drawings/text (depending on the paper type).

3.

icon, then Internal prints > Image diagnostics prints
At the printer's front panel, select the
> Print drawings/text or Print images.

When the print is ready, see Respond to the Image Diagnostics Print.

How do I... (Image
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Respond to the Image Diagnostics Print
The Image Diagnostics Print is in three numbered parts.
1.

Part 1 tests printhead alignment. See Interpret Image Diagnostics part 1.

2.

Part 2 tests printhead performance and the paper advance mechanism. See Interpret Image
Diagnostics part 2.

3.

If Part 2 has revealed a printhead problem, Part 3 identifies which of the eight printheads is
responsible for it. See Interpret Image Diagnostics part 3.
If Part 2 has not revealed any problem, you can and should ignore Part 3.

Interpret Image Diagnostics part 1
The purpose of part 1 is to identify color-to-color alignment and bidirectional alignment problems.
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If you have horizontal misalignment, you will see something like this:

How do I... (Image
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If you have vertical misalignment, you will see something like this:

If you have bidirectional misalignment, you will see something like this:

Corrective action

ENWW

1.

Align the printheads, using the same paper type with which you were experiencing
unacceptable print quality, if feasible (some paper types are not suitable for printhead
alignment). See Align the printheads.

2.

If there is no improvement in print quality, contact your customer service representative.

Interpret Image Diagnostics part 1
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Interpret Image Diagnostics part 2
The purpose of part 2 is to test whether the printheads and the paper advance mechanism are
working correctly. This part of the print should not be used to check for color consistency or accuracy.

Banding
Banding has occurred when you see repetitive horizontal bands within the printed image. They can
appear as light bands:

or dark bands:

How do I... (Image
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or as a more gradual wave effect:
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Horizontal bands across strips of one color only
If a printhead is faulty, you will see horizontal bands across strips of one color only; or at least the
horizontal bands will be much more noticeable in one color than in the others.
NOTE Banding in the green strips is more difficult to see; and it may be caused by a yellow
printhead or by a cyan printhead. If you see banding only in the green strip, it is caused by a
yellow printhead; if you see banding in the green and cyan strips, it is caused by a cyan
printhead.

Corrective action
Check that you are using appropriate print quality settings. See Choose print quality settings.

2.

Clean the printheads. See Recover (clean) the printheads.

3.

Reprint the Image Diagnostics Print. If you still see banding, continue with steps 4 and 5.

4.

As there are two printheads for each color, check exactly which printhead is responsible for the
problem, using Part 3 of the Image Diagnostics Print. See Interpret Image Diagnostics part
3Part 3.

5.

Replace the printhead that shows the problem. See Remove a printhead and Insert a printhead.

How do I... (Image
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1.

Horizontal bands across all the colored strips
If the printer has paper advance problems you will see horizontal bands across all the colored strips.
NOTE Banding in the green strips is more difficult to see.

Corrective action
1.

Check that you are using appropriate print quality settings. See Choose print quality settings.

2.

If you are using low-quality paper, try better-quality paper. The performance of your printer can
be guaranteed only if you use recommended papers. See Supported paper types.

3.

Perform paper advance calibration with the same paper type that you intend to use for the final
print. See How do I... (paper advance calibration topics).

4.

If there is no improvement in print quality, contact your customer service representative.

Interpret Image Diagnostics part 3
If part 2 has revealed a printhead problem, the purpose of part 3 is to identify which particular
printhead is faulty. Each rectangle in this plot is labelled with the number of the printhead that
produced it.
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Here are three examples of a black rectangle in close-up, showing the fine lines of which it is made:

In the first two examples above, there are so many missing lines that the printhead may be faulty. In
the third case there are only a few missing lines, which are acceptable, because the printer can
compensate for such minor problems.

How do I... (Image
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Corrective action
If part 3 shows a problem with one printhead, but part 2 shows no problem, there is no immediate
need to take any corrective action, because the printer is able to compensate for the problem and
maintain print quality. However, if part 2 also shows a problem, continue as follows:
1.

Clean the printheads. See Recover (clean) the printheads.

2.

If there is no improvement in print quality, replace the printhead that shows the problem. See
Remove a printhead and Insert a printhead.

If I still have a problem
If the entire Image Diagnostics Print contains no defects and you still experience print quality
problems, here are some things to check:
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●

Try using a higher print quality option. See Choose print quality settings and Change the print
quality.

●

Check the driver you are using to print with. If it is a non-HP driver, go to http://www.hp.com/go/
designjet/ and download the correct HP driver.

●

If you are using a non-HP RIP, its settings may be incorrect. Refer to the documentation that
came with the RIP.
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Check that your printer's firmware is up to date. See Update my printer's firmware.

●

Check that you have the right settings in your software application.

●

If you are seeing a problem only at the top of the page, see A defect near the start of a print.
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If I still have a problem
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topics)

Your printer was calibrated at the factory to ensure that it advances the paper accurately when using
supported paper types in normal environmental conditions. However, you may find it useful to
recalibrate in certain circumstances:
●

Unsupported paper: different paper manufacturers provide papers with a wide range of
properties such as paper thickness or stiffness, which may benefit from calibration. You can
expect the best print quality when using HP's recommended papers (see Supported paper
types).

●

Abnormal but stable environmental conditions: if you are printing in unusual conditions of
temperature or humidity (see Environmental specifications), and those conditions are expected
to remain stable, recalibration may be worthwhile.

However, paper advance calibration assumes that you have an image quality problem and that you
have already followed the appropriate troubleshooting procedure for that problem. If you have no
particular problem, there is no need to perform the calibration.
Before performing paper advance calibration, use the Image Diagnostics Print to check that the
printheads are correctly aligned (see Print the Image Diagnostics Print).
NOTE In theory, paper advance calibration should improve print quality. However, if you find
the calibration print difficult to interpret, you may choose the wrong paper advance setting and
thus degrade print quality. In this case, you can restore the original factory settings by
or
icon at the front panel, and then Paper advance calibration > Optim.
selecting the
for drawings/text or Optimize for images > Select Pattern > Factory Default.
●

Overview of the calibration process

●

The calibration process in detail

●

After calibration

1.

Use the front panel to print a colored pattern stored in the printer seven times, each time with a
different paper advance setting.

2.

Decide which pattern has been printed most successfully.

3.

Use the front panel to tell the printer which pattern was best—and therefore which paper
advance setting to use in future.
NOTE There are separate paper advance settings for each paper type name in the front
panel: each must be calibrated separately. When you calibrate a particular paper type, the
settings for all other paper types are unaffected.
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NOTE There are separate paper advance settings for Optimized for drawings/text and
Optimized for images: each must be calibrated separately.
NOTE Papers from different manufacturers may require different paper advance settings
even if they are of the same type, therefore the calibration will be useful only for the particular
paper you calibrated. Remember that, when you perform the calibration, you will overwrite any
previous paper advance settings for this paper type.

The calibration process in detail
Step 1. Load the printer with the type of paper that you plan to use for printing subsequently. The
paper must be at least 41 cm wide (16 in) and 75 cm long (30 in).
Step 2. At the front panel, highlight the
or
icon. If you are using an HP Designjet 4500 series
printer, and you have two rolls loaded, make sure that the roll you intend to calibrate is ready to print
(it should be highlighted on the front panel).
Step 3. Press the Select key, then Paper advance calibration.

Step 4. Select Optim. for drawings/text or Optimize for images, depending on the type of prints
you wish to make subsequently.
NOTE It is very important to use the same setting that you will later use for printing in the
driver, the Embedded Web Server, or the front panel (Optimized for drawings/text or
Optimized for images). Otherwise the calibration has no effect.
Step 5. Select Print Patterns. The printer will print a series of numbered patterns (1 to 7), each
looking like this if you selected Drawings/text:

or like this if you selected Images:

How do I... (paper
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The Optim. for drawings/text print takes about three minutes, the Optimize for images print takes
about five minutes. When the calibration print has finished printing, the printer will cut the paper.
Step 6. Look at each of the printed patterns (1 to 7) and decide which one shows the best quality.
Each pattern has one part on the left that is a continuous color gradient (A), and another part on the
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right (B). Either part can be used to help you decide which is the best of the series of patterns; it will
depend on your circumstances. However, if you are using glossy paper or canvas, you are
recommended to ignore part A and make your selection by looking at part B only.
In the color gradient, part A, you should look for light or dark horizontal bands (banding), which
indicate that the paper advance is not quite right. Usually you will see dark bands across the first
pattern and light bands across the last pattern (see the examples below). The best pattern is one
with no banding; if in doubt, select the pattern in the middle, between the last pattern with dark bands
and the first pattern with light bands.

If you find it difficult to identify the best pattern, the following scenario descriptions may help you.
Where you have only one pattern which is clearly the best and the ones above and below
contain light/dark bands, select this pattern.

How do I... (paper
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●

Where you have two patterns next to each other which do not show signs of banding, see
below, use the patterns above and below these two to help you select. For example, if the
pattern above the two equal ones contains less banding then choose the pattern just below it.

●

Where you have three patterns which show no signs of banding, select the middle pattern.

If you look at part B of the print, you will probably see that it appears darker in some patterns than in
others. The best pattern is the one that appears lightest, most uniform, and least grainy.
or
icon, and then Paper advance calibration > Optim. for drawings/text
Step 7. Select the
or Optimize for images > Select pattern.
Step 8. Select the number of the pattern (1 to 7) that printed best. If you found it difficult to choose
between two patterns e.g. patterns 3 and 4, then select “Between pattern 3 and 4”.
The calibration is complete.

After calibration
If you find that the paper advance calibration has reduced but not eliminated your print quality
problem, you could try step 7 again and select a different number. If you are seeing light bands, try
selecting a lower number than your original selection; if you are seeing dark bands, try a higher
number.
If you later want to cancel your calibration and restore the paper advance setting with which the
or
icon, and then Paper advance calibration > Optim. for
printer left the factory, select the
drawings/text or Optimize for images > Select pattern > Factory default.
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16 How do I... (scanner topics) [4500]

NOTE This chapter applies to the HP Designjet 4500 Printer series only.

ENWW

●

Calibrate the scanner

●

Calibrate the touch screen pointer

●

Create a new media profile

●

Copy a document

●

Scan a document to a file

●

Print a file

●

View or delete a file

●

Scan heavyweight paper or cardboard

●

Preview copies

●

Add a new printer

●

Save files on a CD or DVD

●

Access the shared folder from my computer

●

Adjust color

●

Enable or disable scanner accounts

●

Check the printer queue

●

Collate copies

●

Clean the glass

●

Set sleep and wake-up timers
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Calibrate the scanner
Your scanner should be recalibrated once a month to maintain the best scan quality.
1.

Before calibrating, read the scanner's online guide on how to clean the scan area. Then turn off
the scanner and clean the scan area. Calibration will not work well if the scan area is not clean.

2.

When you have finished cleaning the scan area, turn on the scanner and leave it on for at least
an hour before proceeding to the next step.

3.

Press the Options button in the Setup tab.

4.

Press the Scanning button in the Options box.

5.

Press the Scanner Maintenance button in the Scan Options box.

6.

The Maintenance Wizard will guide you step by step through the procedures of camera
alignment, stitching, and calibration. You will need the Maintenance Sheet that came with your
scanner.

Calibrate the touch screen pointer
1.

Press the Setup tab.

2.

Press the Options button.

3.

Press the System button.

4.

Press the Calibrate Touch Screen button and follow the instructions on the screen.

Calibration is done by pressing the targets that appear in different positions on the screen. Press
each target with whatever pointer you normally use to operate the touch screen (your finger, or some
other object) and keep pressing until the target disappears.

220

Chapter 16

How do I... (scanner topics) [4500]

ENWW

How do I... (scanner
topics) [4500]

Create a new media profile
Before starting this procedure, make sure you have calibrated the scanner (see Calibrate the
scanner) and loaded the correct paper type into the printer.
1.

Press the Setup tab.

2.

If the correct printer is not already selected, press the Printer button to select it.

3.

Press the Media Profile button. You will see a list of existing media profiles. If one of them is
currently selected, it is greyed out. The paper type currently loaded in the printer, for which you
need to generate a media profile, is also included in the list.

4.

Press the Print Color Sheet button.

5.

The printer will calibrate itself, and then print a color patch reference sheet. Wait until this
process has finished.

6.

In the list of media profiles, select the paper type loaded in the printer. You will be asked to
generate a new media profile.

7.

Press the Media Profile button.
NOTE The Media Setup window varies according to the printer model.

8.

Load the color sheet into the scanner face down, centering the sheet on the scanner as usual.

9.

Press the Scan Color Sheet button.

10. Close the window when the color sheet has been scanned.
The media profile is now in the list of available media profiles.
You can use the Delete button to delete media profiles. Only user-created profiles can be deleted.

Copy a document
1.

If you do not already have a media profile for the paper type you are planning to print on, you
must create one. See Create a new media profile.

2.

Insert your document.

3.

a.

Place the document face down with the top edge forward in the scanner insertion slot.
Align the center of the document with the centre of the insertion slot.

b.

Slide the document gently into the insertion slot until you feel it pulled into the start position.

Select color or black-and-white copying.
Your selection determines which type-of-original templates will be available in the following step.
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4.

Select the type-of-original template..
a.

Press the Type of original button in the Copy tab.

b.

If you would like to change the settings of these options or create a new option, press the
Tool button.

c.
5.

Select a type-of-original template that best describes your current input.

Select the input size.
a.

Press the Input size button in the Copy tab.

b.

If you would like to change the settings of these options or create a new option, press the
Tool button.

c.
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6.

Select the output size.
a.

Press the Output size button in the Copy tab.

b.

If you would like to change the settings of these options or create a new option, press the
Tool button.

c.

Select from the list the size that you want for your output copy.

If you have selected an output size that differs from the input size, the scanner will calculate the
scaling percentage and display it on the Scale button in the Copy tab after the first preview.
Alternatively, you can select a scaling percentage yourself by pressing the button.
7.

Set the number of copies.
a.

Press the Copies option if you want to make more than one copy of the loaded document.

b.

Enter the number of copies in the edit field.

This option allows you to leave the system working unattended.
8.

Start copying.
The Copy button

starts the copy process with the settings you chose.

You can use the Stop button
Press the Reset button
scanner's default values.
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to cancel the current preview or copy process.

to clear your own settings and reset the program to all of the
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Scan a document to a file
1.

Select the Scan tab and set your scan options: type of original, size, filename, etc. To set the
file format (TIFF, JPEG), press the Settings button to display the Scan Settings dialog.

Options such as margins, layout, and media profile can be set later in the Setup tab before you
print from the file.
2.

Press the File name button to enter a new name. The default filename is the current date and
time.
You can change the destination folder by pressing the File destination button.

3.

●

Use the arrows to find the folder you want in the list.

●

Press the button with three dots (...) to move up to the parent folder.

●

Press a folder name to enter a folder.

●

Create a new folder within the current folder with the New Folder button.

●

Click the OK button to return to the Scan tab.

Press the Scan to file button

to start the scan.

Print a file
Printing your files is set up and controlled through a convenient print list. You can set the number of
copies you want by defining the number for each file individually, by determining the number of sets
(how many times the whole list will be printed), or by using a combination of both.
1.

224

If you do not already have a media profile for the paper type you are planning to print on, you
must create one. See Create a new media profile.
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2.

Press the Print tab.

When you enter the Print dialog, the Copy button

changes to the Print button.

The Print list group displays the files currently selected for printing. If the list is empty or it needs
changing, you can select files by pressing the Add to List button.
3.

Check or change your Setup tab settings. The current Setup tab settings, such as margins,
layout, printer and media profile, will apply to the whole print job.

4.

Press the Print button

to send the listed files to the printer.

NOTE The Print tab is designed for printing files created with the Scan tab; it cannot be used
to print files from other sources.

View or delete a file
1.

Press the Print tab.

2.

Press the Add to List button.

3.

Press the name of the file in the list.

4.

Press the View or Delete button.

Scan heavyweight paper or cardboard
Your scanner is capable of scanning heavyweight coated paper and cardboard.
WARNING! Other thick materials are not supported and could cause damage. Remove
staples and any other abrasive attachment before scanning.

ENWW

1.

Press the Automatic Thickness Adjustment Control key on your scanner's control panel.

2.

Press and hold the arrow up key to increase the height of the insertion slot until there is enough
room to insert the document. You can change the insertion slot height from 2 to 15 mm (0.08 to
0.59 inches).

3.

Insert the document.

View or delete a file
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4.

Press and hold the arrow down key until the insertion slot stops adjusting itself.

5.

Make a test scan to check for errors. Errors will be easier to see in an image with a clear
diagonal line.
NOTE A large document may need to be supported with both hands on its way in and
out of the scanner.

If lines seem uneven, proceed as follows:
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1.

In the Setup tab, select the Options button, then the Scanning button.

2.

In the Scan Options dialog, press the Scanner button.

3.

In the Scanner dialog, press the Setup button.

4.

Select the Extended Thickness tab, and check the box labeled “Use extended thickness paper
handling”.
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Change the value for each of the scanner’s cameras. Normally, only positive values should be
used.

6.

Make test scans and readjust the values until you are satisfied that the lines are stitched
correctly.

7.

Click OK to accept your settings.
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5.

Repeat this procedure until you are satisfied with the results.
To return the insertion slot height to its normal position:
1.

Remove all material from the insertion slot.

2.

Press the Automatic Thickness Adjustment Control key.

3.

Press and hold the arrow down key until the insertion slot has stopped adjusting itself.

Try to avoid leaving the insertion slot set above minimum height for long periods of time. The
scanner periodically performs an automatic self-adjustment procedure, but only when the insertion
slot height is at minimum.

Preview copies
The previewing feature allows you to control your document size and margins visually and readjust
or relocate the paper frame on the image. Its size is determined by the size settings made in the
Copy tab dialog. The paper frame’s size and thickness in the preview window will be determined by
the Input Size, Output Size, and Margins settings.
Press the Preview button

to load a fresh preview.

Zoom all

Setting size and margins, you need a view of the whole image. Resize the image so that it exactly fits
in the preview window.

Zoom in

The zoom in axis is in the center of the preview window. Continue to press the Zoom In button to the
required level of detail.

Zoom out

The zoom out axis is in the center of the preview window. Continue to press the Zoom Out button to
the required level of detail.
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One-to-one pixel viewing

View the image with one scanned pixel shown as one screen pixel.

Resize paper frame

The Resize Paper Frame tool is especially useful for copying non-standard paper sizes.
When activated, the Resize Paper Frame Tool partitions the areas around the paper frame into
sections. When a section is touched, the closest frame side or corner is resized to the new position.

Move tool

Move the image to get any part of it centered or visible in the preview window.
There are two ways to move the image:
●

By dragging anywhere in the image window.

●

Touch a point on the screen, and that point will then be centered in the preview window.

Position the paper frame

You can position the paper frame directly in the preview and visually set your copy area.
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There are three ways to move the frame:
●

By dragging anywhere on the screen. Imagine you are gripping the frame and dragging it
around over the image.

●

Touch a point on the screen, and that point then becomes the new center for the paper frame.
This method is especially useful when you are making spot test strips for printing. It lets you
continuously and rapidly reposition the frame on important areas that you want tested.

●

Dragging the edges will resize the paper frame and is an alternative to the Resize Paper Frame
tool.

Align left and align right

The original appears crooked in the Preview Window. You do not need to reload the original. Press
the align buttons to align the image with the paper frame.

Alternatively, press the Settings button in the Copy tab or in the Scan tab, and select the Auto-align
option. This will align your image automatically. If you’re not satisfied with the result, press the Reset
alignment button, press OK, and align the image manually with the Align Left and Align Right buttons.
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Add a new printer
To add a new HP Designjet printer to the printer list in your scanner software:
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1.

In the Setup tab, press the Options button.

2.

Press the System button.

3.

Press the button with the name of the printer that you want to add.

4.

Follow the instructions on the screen.

Chapter 16

How do I... (scanner topics) [4500]

ENWW

How do I... (scanner
topics) [4500]

Save files on a CD or DVD
Your HP Designjet is capable of writing to CDs or DVDs in the same easy way as it writes to any
other storage medium.
1.

Insert a blank CD or DVD into the touch screen’s CD/DVD drive. You may also be able to write
to a partly-used CD or DVD, if the disc has not been ‘closed’.

2.

Follow the normal steps for scanning or copying, but send the files to drive E: (the CD/DVD
drive).

3.

When you have finished, the disc will normally be ejected automatically. Otherwise, press the
eject button on the drive to eject it. There will be a delay of about 45 seconds before the disc is
ejected.
NOTE If you have scanned an image to a file on the touch screen's hard disk, you cannot
then copy the file to a CD or DVD using the touch screen. To do that, you must put the saved
file in the shared folder (D:\images) and copy it to the disc using a computer on the same
network (see Access the shared folder from my computer).

Access the shared folder from my computer
The scanner system provides a shared folder D:\images that can be accessed from other computers
over a network. For security reasons, no other folders on the scanner system can be accessed over
a network. Therefore, in order to access scanned images from other computers, you must save them
in D:\images.
In order to establish a connection over the network, you will need to know the IP address of your
scanner system. You can obtain this from the scanner's touch screen, as follows:
1.

Press the Setup tab on the touch screen.

2.

In the Setup tab, press the Options button.

3.

In the Options box, press the General button.

4.

In the General box, press the About button.

5.

You will find the scanner's IP address among the information in the About box.

Accessing the shared folder from Windows XP
1.

On your computer's desktop, double-click My Network Places.

2.

In the Network Places window, double-click Add Network Place.

3.

In the Add Network Place Wizard window, click Choose another network location, then click
Next.

4.

In the Internet or network address field, enter http://scanner_ip/images, where
scanner_ip is the IP address of your scanner system, then click Next.

5.

Enter your own choice of name by which you will refer to the folder on this computer, then click
Next.

To access the shared folder subsequently, double-click My Network Places, and you will see the
new folder in the Network Places window. You can, if you like, drag the folder to your desktop for
easier access.

ENWW

Save files on a CD or DVD

231

How do I... (scanner
topics) [4500]

Accessing the shared folder from Windows 2000
1.

On your computer's desktop, double-click My Network Places.

2.

In the Network Places window, double-click Add Network Place.

3.

In the Add Network Place Wizard window, enter http://scanner_ip/images, where
scanner_ip is the IP address of your scanner system, then click Next.

4.

Enter your own choice of name by which you will refer to the folder on this computer, then click
Finish.

To access the shared folder subsequently, double-click My Network Places, and you will see the
new folder in the Network Places window. You can, if you like, drag the folder to your desktop for
easier access.

Accessing the shared folder from Windows 98
1.

On your computer's desktop, double-click My Computer.

2.

In the My Computer window, double-click Web Folders.

3.

In the Web Folders window, double-click Add Web Folder.

4.

In the Add Web Folder window, enter http://scanner_ip/images, where scanner_ip is the IP
address of your scanner system, then click Next.

5.

Enter your own choice of name by which you will refer to the folder on this computer, then click
Finish.

To access the shared folder subsequently, double-click My Computer and then Web Folders, and
you will see the new folder in the Web Folders window. You can, if you like, drag the folder to your
desktop for easier access.

Accessing the shared folder from Mac OS X
1.

Select the Connect to Server option from the Go menu.

2.

In the Connect to Serve window, enter http://scanner_ip/images, where scanner_ip is the
IP address of your scanner system, then click Connect.

Adjust color
If you press the Type of Original button in the Copy or Scan tab, the Type of Original Setup box gives
you various options to adjust the colors of your scanned images.
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Press the Save button to save the changes you have made.
NOTE The changes are saved in your current media profile.

Enable or disable scanner accounts
1.

Press the Setup tab.

2.

Press the Account button.

3.
Press the Tool button
4.

if necessary.

In the Accounting box:
●

Press the Delete button to delete the current account (the one whose name is displayed in
the box).

●

Press the New button to create a new account, then enter a name for the new account.
The new account will automatically become the current account.

●

Press the Rename button to rename the current account.

●

Press the Reset button to reset the current account (all figures return to zero).

After pressing any of the above buttons, you will be asked to give the administrator's password.

Check the printer queue
Press the Print Queue button

at the bottom of the screen.

NOTE This button works only if you are using the HP Designjet 4500 Printer series.
The Print Queue box lets you manage any jobs waiting to be printed. You can move through the list
and delete unwanted jobs.
The Properties section contains a window for previewing the selected job in the queue and viewing
additional information.
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Collate copies
1.

Press the Print tab.

2.

Press the Add to List button.

3.

Using the check boxes, select multiple files for printing.

4.

Press the Number of Sets button and select the number of copies you wish to print.

5.

Press the Print button.

The files that you selected form a set, which is printed the number of times that you selected.

Clean the glass
1.

Turn the scanner power off and disconnect the scanner power cable.

2.

Push down on the two lever buttons found near the insertion slot on each side of the scanning
area lid. The scanning area lid locking mechanism should now be disengaged.

3.

As you hold both lever buttons down, place your free fingers in the insertion slot and flip the
scanning area lid open. The scanning area is now exposed for cleaning.

4.

Gently wipe the glass plate with a lint-free cloth dampened with a mild, streak-free, glass cleaner.
CAUTION Do not use abrasives, acetone, benzene, or fluids that contain these
chemicals. Do not spray liquids directly onto the scanner's glass plate or anywhere else
in the scanner.
The lifespan of the glass plate depends on the paper types that pass across it. Abrasive
papers such as mylar may cause premature deterioration, in which case the replacement
of the plate is the customer's responsibility.

5.

Dry the glass completely using a separate clean, dry lint-free cloth like the one provided with the
maintenance kit.

Set sleep and wake-up timers
1.

Press the Setup tab.

2.

Press the Options button.

3.

Press the System button.

4.

Press the WIDEsystem button.
●

To activate automatic power-on, select the check box for the day in the On column.
To modify the time, select the hours digits and press the up or down buttons and then
select the minutes digits and repeat the process. Select AM or PM, and press the up or
down buttons.

●
5.
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To activate automatic power off, select the check box for the day in the Off column, then
set the time as described above.

Press the Apply button to confirm your changes and continue or press the OK button to confirm
changes and exit WIDEsystem.
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●

The paper cannot be loaded successfully [4000]

●

The paper cannot be loaded successfully [4500]

●

A paper jam (paper stuck in the printer) [4000]

●

A paper jam (paper stuck in the printer) [4500]

●

A paper jam in drawer 2 [4500]

●

Prints do not stack properly in the bin [4000]

●

Prints do not stack properly in the basket [4500]

●

The printer uses a lot of paper to align the printheads

●

The paper moves while the printer is in standby mode [4500]

●

The printer unloads or trims the paper after a long period of disuse [4500]

●

The printer unloads the paper while switched off [4500]

●

The printer unloads the paper when switched on [4500]
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The paper cannot be loaded successfully [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
●

The paper may be loaded at an angle (skewed or mislocated). Check that the right-hand edge
of the paper is aligned with the half-circle on the right-hand side of the platen and, particularly in
the case of sheet paper, that the leading edge is aligned with the metal bar in the platen.

●

The paper may be crumpled or warped, or may have irregular edges.

The problem is... (paper
topics)

Rolls
●

If the paper gets stuck in the paper path to the platen, it may be that the leading edge of the
paper is not straight or clean, and needs to be trimmed. Remove the initial 2 cm (1 in) from the
roll and try again. This may be necessary even with a new roll of paper.

●

Check that the spindle is correctly inserted. The spindle lever on the right should be in the
horizontal position.

●

Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards
you.

●

Check that the paper is wound tightly on the roll.

Sheets
●

Check that the leading edge of the sheet is aligned with the cutter channel in the platen.

●

Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.
Here is a list of front panel messages related to paper loading, with the suggested corrective
action.
Front panel message

Suggested action

Right edge of roll too far from load line. The roll has not been loaded correctly, the right–hand edge was not aligned
with the half–circle on the platen. Press the Select key to try to load the roll
again.
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Right edge of sheet too far from load
line.

The sheet has not been loaded correctly, the right–hand edge was not
aligned with the half-circle on the platen. Press the Select key to try to load
the sheet again.

Right edge not found.

The printer cannot locate the right–hand edge of the paper, the paper may
be badly positioned. Press the Select key and try to load the roll again.

Sheet edge not found.

The printer cannot locate the edges of the paper, the paper may be badly
positioned. Press the Select key and try to reload the sheet.

Paper not found.

During the paper load process the printer did not detect any paper. Press the
Select key to retry.

Paper loaded with too much skew.

During the paper load process the printer detected that the paper had too
much skew. Press the Select key to try to load the paper again.

Paper too small.

During the load process the printer detected that the paper is too narrow or
too short to be loaded in the printer. Press the Cancel key to stop the load
process. See Functional specifications.

Paper too big

During the load process the printer has detected that the paper is either too
wide or too long (sheet only) to be loaded properly. Press the Cancel key to
stop the load process. See Functional specifications.
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Front panel message

Suggested action

Sheet too long.

During the load process the printer has detected that the sheet is too long to
be loaded properly. Make sure that the printer expects sheet and not roll.
Press the Select key to try to load the paper again. See Functional
specifications.

Lever lifted.

During the load process the paper load lever was lifted. This prevents the
printer from loading the paper. Press the Select key to load the paper again.

The problem is... (paper
topics)

The paper cannot be loaded successfully [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
●

The paper may be loaded at an angle (skewed or mislocated).

●

The paper may be crumpled or warped, or may have irregular edges.

●

If the paper gets stuck in the paper path to the platen, it may be that the leading edge of the
paper is not straight or clean, and needs to be trimmed (see Trim the paper with the manual
cutter [4500]). Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary
even with a new roll of paper.

●

Check that the drawer is correctly closed.

●

Check that the spindle is correctly inserted.

●

Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards
you.

●

Check that the paper is wound tightly on the roll.

Here is a list of front panel messages related to paper loading, with the suggested corrective action.
Front panel message

Suggested action

Right edge not found.

The printer cannot locate the right–hand edge of the paper, the paper may be
badly positioned. Press the Select key and try to load the roll again.

Paper not found.

During the paper load process the printer did not detect any paper. Press the
Select key to retry.

Paper loaded with too much skew.

During the paper load process the printer detected that the paper had too much
skew. Press the Select key to try to load the paper again.

Paper too small.

During the load process the printer detected that the paper is too narrow or too
short to be loaded in the printer. Press the Cancel key to stop the load process.
See Functional specifications.

Lever lifted.

During the load process the paper load lever was lifted. This prevents the printer
from loading the paper. Press the Select key to load the paper again.

A paper jam (paper stuck in the printer) [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
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When a paper jam occurs, you will normally see the Possible paper jam message in the front panel,
with one of two error codes:
●

81:01 indicates that paper cannot advance into the printer.

●

86:01 indicates that the printhead carriage cannot move from side to side.

The problem is... (paper
topics)

Check printhead path
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1.

Switch off the printer at the front panel, then also switch off the power switch at the rear.

2.

Open the window.

3.

Try to move the printhead carriage out of the way.
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Lift the paper load lever as far up as it will go.

5.

Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

6.

Carefully pull the rest of the roll or sheet down and out of the printer.

7.

Switch on the printer.

8.

Reload the roll, or load a new sheet. See Load a roll into the printer [4000] or Load a single
sheet [4000].

9.

If you find that there is still some paper causing an obstruction within the printer, it can often be
cleared by loading a rigid paper type into the printer.

10. If you find that you have print quality problems after a paper jam, try realigning the printheads.
See Align the printheads.

Check paper path
●

This problem can occur when a roll has finished and the end of the roll is stuck to the cardboard
core. If this has happened, cut the end of the roll away from the core; you should then be able to
feed the paper through the printer, and load a new roll.

●

Otherwise, follow the procedure described above, under Check printhead path.

A paper jam (paper stuck in the printer) [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
When a paper jam occurs, you will normally see the Possible paper jam message in the front panel,
with one of the following error codes:
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●

81:01 indicates that paper cannot advance into the printer.

●

84.1:01 indicates a paper jam in drawer 1.

A paper jam (paper stuck in the printer) [4500]
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4.

●

84.2:01 indicates a paper jam in drawer 2 (see A paper jam in drawer 2 [4500]).

●

86:01 indicates that the printhead carriage cannot move from side to side.

The problem is... (paper
topics)

If you press the Select key, the front panel will display an animation showing how to recover from the
paper jam. Alternatively, you can refer to this document (see below).

Check printhead path
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1.

Switch off the printer at the front panel, then also switch off the power switch at the rear.

2.

Disengage the bin or stacker from the printer.

3.

Open the window.
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Lift the drive pinch lever as far up as it will go.

5.

Lift the roll 1 paper load lever.

6.

Lift the roll 2 paper load lever.

The problem is... (paper
topics)

4.

A paper jam (paper stuck in the printer) [4500]
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7.

Lift the lower drawer upwards a little, then pull it towards you as far as it will go.

8.

Cut the paper.

9.

Remove the roll.
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10. Lift the upper drawer upwards a little, then pull it towards you as far as it will go.

11. Cut the paper.

12. Remove the roll.
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13. Lower the lock lever on the left.

The problem is... (paper
topics)

14. Lower the lock lever on the right.

15. Pull the front path towards you as far as it will go.
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16. Try to move the printhead carriage out of the way.

17. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.
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18. Push paper inwards on the platen.

The problem is... (paper
topics)

19. Carefully pull the rest of the paper down and out of the printer. Look to see if there any loose
pieces of paper left in the paper path.

20. Push the front path back into place.
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21. Lift the lock lever on the left.

22. Lift the lock lever on the right.

23. Push the upper drawer back into place.
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24. Push the lower drawer back into place.

The problem is... (paper
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25. Lower the drive pinch lever.

26. Lower the roll 1 paper load lever.
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27. Lower the roll 2 paper load lever.

28. Close the window.

29. Switch on the printer.
30. Reload the rolls. See Load a roll into the printer [4500].
If you find that there is still some paper causing an obstruction within the printer, it can often be
cleared by loading a rigid paper type into the printer.
31. Re-engage the bin or stacker with the printer.
32. If you find that you have print quality problems after a paper jam, try realigning the printheads.
See Align the printheads.

Check paper path
●

This problem can occur when a roll has finished and the end of the roll is stuck to the cardboard
core. If this has happened, cut the end of the roll away from the core; you should then be able to
feed the paper through the printer, and load a new roll.

●

Otherwise, follow the procedure described above, under Check printhead path.

A paper jam in drawer 2 [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
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A paper jam in drawer 2 is indicated on the front panel by a Possible paper jam message with the
error code 84.2:01.

The problem is... (paper
topics)

If you press the Select key, the front panel will display an animation showing how to recover from the
paper jam. Alternatively, you can refer to this document (see below).
To clear the paper jam:
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1.

Switch off the printer at the front panel, then also switch off the power switch at the rear.

2.

Disengage the bin or stacker from the printer.

3.

Open the window.
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Lift the drive pinch lever as far up as it will go.

5.

Lift the roll 2 paper load lever.

6.

Lift the lower drawer upwards a little, then pull it towards you as far as it will go.

The problem is... (paper
topics)

4.

A paper jam in drawer 2 [4500]
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7.

Cut the paper.

8.

Remove the roll.

9.

Lift the upper drawer upwards a little, then pull it towards you as far as it will go.
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10. Carefully remove the cut-off lower end of the paper.

11. Carefully remove any paper that you can lift up and out from the top of the printer.

12. Investigate the front of the roll module, behind the drawers.
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13. Remove any paper that you see there.

The problem is... (paper
topics)

14. Remove any paper trapped between the roll and the small plastic rollers.

15. Go behind the printer and find the three vertical slits at the rear of the roll module.

16. If you can see paper through the slits, try to remove it by pushing it upwards or downwards.
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17. Return to the front of the printer, and push the upper drawer back into place.

18. Push the lower drawer back into place.

19. Lower the drive pinch lever.
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20. Lower the roll 2 paper load lever.
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21. Close the window.

22. Switch on the printer.
23. Reload the rolls. See Load a roll into the printer [4500].
If you find that there is still some paper causing an obstruction within the printer, it can often be
cleared by loading a rigid paper type into the printer.
24. Re-engage the bin or stacker with the printer.
25. If you find that you have print quality problems after a paper jam, try realigning the printheads.
See Align the printheads.

Prints do not stack properly in the bin [4000]
NOTE This topic applies to the HP Designjet 4000 Printer series only.
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●

Lift up the three loop stoppers when printing small sheets.

●

Paper often tends to curl near the end of a roll, which can cause stacking problems. Load a new
roll, or remove prints manually as they are completed.

●

If you are mixing prints or nesting sets of several different sizes, you may have stacking
problems because of the different sizes of paper in the bin.
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Prints do not stack properly in the basket [4500]
●

Prints at the bottom of the basket may be damaged by the weight of the prints above them. For
this reason, we recommend to collect prints from the basket before it becomes full.

●

Coated paper with high ink content may be crumpled when falling into the basket. In this case
prints need to be collected from the basket more frequently than usual.

The problem is... (paper
topics)

NOTE This topic applies to the HP Designjet 4500 Printer series only.

The printer uses a lot of paper to align the printheads
In order to align the printheads accurately, the printer sometimes needs to feed through up to 3 m
(≈10 ft) of paper before starting the printhead alignment process. This is normal behavior and you
should not try to interrupt or prevent it. See Align the printheads.

The paper moves while the printer is in standby mode
[4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
While the printer is in standby mode, it may briefly come to life and move the paper slightly from time
to time in order to maintain the paper in the best possible condition. This is done only with certain
specific paper types (film, glossy paper, and heavyweight coated paper).

The printer unloads or trims the paper after a long period
of disuse [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
The printer may automatically unload or trim a roll if it has not been used for several days, in order to
maintain the paper in the best possible condition. This is done only with certain specific paper types
(glossy and heavyweight coated paper).

The printer unloads the paper while switched off [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
While the printer is switched off at the front panel, it may automatically unload a roll in order to
maintain the paper in the best possible condition. This is done only with certain specific paper types
(film, glossy paper, and heavyweight coated paper).

The printer unloads the paper when switched on [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
If the printer is switched off using the switch at the rear, or by disconnecting the power cable, or by a
power cut, whenever it is switched on again it may automatically unload a roll in order to maintain the
paper in the best possible condition. This is done only with certain specific paper types (film, glossy
paper, and heavyweight coated paper).
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CAUTION If you want to turn off the printer, you are strongly recommended to use the
Power button on the front panel before using the switch at the rear or disconnecting the power
cable.
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●

General advice

●

Banding (horizontal lines across the image)

●

Lines are missing or thinner than expected

●

Solid bands or lines printed over the image

●

Graininess

●

The paper is not flat

●

The print smudges when touched

●

Ink marks on the paper

●

A defect near the start of a print

●

Lines are stepped

●

Lines are printed double or in wrong colors

●

Lines are discontinuous

●

Lines are blurred (ink bleeds from lines)

●

Lines are slightly warped

●

Color accuracy

●

PANTONE color accuracy

●

Color matching between different HP Designjets
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General advice
When you have any print quality problem:
●

To achieve the best performance from your printer, use only genuine manufacturer's supplies
and accessories, whose reliability and performance have been thoroughly tested to give troublefree performance and best-quality prints. For details of recommended papers, see Supported
paper types.

●

Make sure that the paper type selected in the front panel is the same as the paper type loaded
into the printer. To check this, highlight the

or

icon on the front panel.

The problem is... (print
quality topics)

●

Bear in mind that roll paper will generally give better print quality than a single sheet of the
same kind of paper. When you are using single sheets of paper, we strongly recommend that
you always set the print quality to Best.

●

Check that you are using the most appropriate print quality settings for your purposes (see
Choose print quality settings). You are most likely to see print quality problems if you have set
the print quality to Fast.

●

To maintain the best print quality at the expense of speed, change the Printhead monitoring
setting to Intensive. See Manage printhead monitoring.

●

Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications.

Banding (horizontal lines across the image)
If your printed image suffers from added horizontal lines as shown (the color may vary):
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1.

Check that you are using appropriate print quality settings. See Choose print quality settings.

2.

If the problem persists, clean the printheads. See Recover (clean) the printheads.

3.

Consider changing to a heavier paper type: we recommend HP Heavyweight Coated Paper or
HP Productivity Photo Gloss when printing dense colors.

4.

If the problem persists, use the Image Diagnostics Print to find out more about it. See How do
I... (Image Diagnostics Print topics).
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1.

Check that the line thickness and color settings are correct in your application.

2.

Check that you are using appropriate print quality settings. See Choose print quality settings.

3.

If the problem persists, clean the printheads. See Recover (clean) the printheads.

4.

If the problem persists, use the Image Diagnostics Print to find out more about it. See How do
I... (Image Diagnostics Print topics).

The problem is... (print
quality topics)

Lines are missing or thinner than expected

Solid bands or lines printed over the image
This kind of problem can show itself in several different ways, illustrated below in magenta:
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1.

A thick colored band

2.

Thinner colored bands

3.

Discontinuous colored blocks

4.

Thin lines

Lines are missing or thinner than expected

261

In each case the recommended procedure is as follows:
1.

Clean the electrical connections of the printhead that seems to be responsible (in this example,
the magenta printhead). See Clean a printhead's electrical connections.

2.

Clean the printheads. See Recover (clean) the printheads.

3.

Reprint your image with the same settings as before.

4.

If the problem persists, replace the printhead that seems to be causing the problem. If you are
not sure which printhead is responsible, use the Image Diagnostics Print to identify it. See How
do I... (Image Diagnostics Print topics).

Graininess

The problem is... (print
quality topics)

1.

Check that you are using appropriate print quality settings. See Choose print quality settings.

2.

Use the Image Diagnostics Print to find out more about the problem. See How do I... (Image
Diagnostics Print topics).

The paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are
likely to see visible defects in the printed image, such as vertical stripes. This can happen when you
use thin paper that becomes saturated with ink.
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Try changing to a heavier paper type: we recommend HP Heavyweight Coated Paper or HP
Productivity Photo Gloss for printing dense colors. See also Choose print quality settings.

The print smudges when touched
The black ink pigment can smudge when touched by a finger or pen. This is particularly noticeable
on the following materials: vellum, translucent bond, films, productivity photo paper, and natural
tracing paper.
To reduce the smudging:
●

Try to print in an environment which is not too humid for the printer. See Environmental
specifications.

●

Change pure black objects in your image to a dark color, such as dark brown, so that they will
be printed with colored inks instead of black ink.

●

Use HP Heavyweight Coated Paper.

●

Increase the drying time (see Change the drying time).

Ink marks on the paper
This problem may occur for several different reasons.

Smears on the front of coated paper
If a lot of ink is used on coated paper, the paper absorbs the ink quickly and expands. As the
printheads move over the paper, the printheads come into contact with the paper and the printed
image is smeared.
Whenever you notice this problem, you should cancel the printing job immediately. Press the Cancel
key and also cancel the job from your computer application. Otherwise the soaked paper may
damage the printheads.
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Try the following suggestions to avoid this problem:
●

Use a recommended paper type (see Supported paper types).

●

If the image you are printing contains intense color, try using HP Heavyweight Coated Paper.

●

Use extended margins (see Adjust the margins), or try to increase the margins by relocating the
image within the page using your software application.

●

If necessary, try changing to a non-paper-based material such as transparent film.

Smears or scratches on the front of glossy paper
Glossy paper may be extremely sensitive to the bin or to anything else that it contacts soon after
printing. This will depend on the amount of ink printed and the environmental conditions at the time of
printing. Avoid any contact with the paper surface and handle the print with care.
Hint Leave a sheet of paper in the bin so that freshly-printed sheets do not make direct
contact with the bin. Alternatively, you can remove an important print as soon as it emerges
from the printer, without allowing it to fall into the bin.

Ink marks on the back of the paper
The problem is... (print
quality topics)

Ink residues on the platen or on the input rollers are likely to mark the back of the paper. See Clean
the platen and Clean the input rollers.

Ink marks when the stacker is in use [4500]
NOTE The stacker is available with the HP Designjet 4500 Printer series only.
Try the following suggestions:
●

Clean the stacker roller. See Clean the stacker rollers.

●

Check that the paper you're using is compatible with the stacker. See Using paper with the
stacker [4500].

●

When printing in Fast mode on Translucent Bond, Vellum, or Natural Tracing Paper, there could
be some ink transfer marks in highly inked areas. Select Normal or Best mode to avoid this
problem. See Change the print quality.

A defect near the start of a print
There is a type of defect that affects only the start of a print, within 5.5 cm of the leading edge of the
paper. You may see a thin or thick band of inconsistent color:
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To avoid this problem:
1.

The easiest solution is to select the Extended Margins option in the driver, the Embedded Web
Server, or the front panel. This means that the area of the paper affected by the problem (at the
start of the page) will no longer be printed on. See Adjust the margins.

2.

Align the printheads. See Align the printheads.

3.

Check that you are using appropriate print quality settings. See Choose print quality settings.

Lines are stepped

1.

The problem may be inherent in the image. Try to improve the image with the application you
are using to edit it.

2.

Check that you are using appropriate print quality settings. See Choose print quality settings.

3.

Turn on the Maximum Detail option.

The problem is... (print
quality topics)

If lines in your image appear stepped or jagged when printed:

Lines are printed double or in wrong colors
This problem can have various visible symptoms:
●

ENWW

Colored lines are printed double, in different colors.

Lines are stepped
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●

The borders of colored blocks are wrongly colored.

To correct this kind of problem:
1.

Align the printheads. See Align the printheads.

2.

Check that you are using appropriate print quality settings. See Choose print quality settings.

The problem is... (print
quality topics)

Lines are discontinuous
If your lines are broken in the following way:

1.

Check that you are using appropriate print quality settings. See Choose print quality settings.

2.

You are more likely to get good vertical lines with roll paper than with sheet paper. If you must
use sheet paper, set the print quality to Best.

3.

Consider changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP
Productivity Photo Gloss. SeeChoose print quality settings.

4.

Align the printheads. See Align the printheads.

Lines are blurred (ink bleeds from lines)
If you see that the ink is soaking into the paper, making the lines blurred and fuzzy, this could be
because of humidity in the air. Try the following:
1.

Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications.

2.

Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP
Productivity Photo Gloss. SeeChoose print quality settings.
NOTE Glossy photo paper types are especially difficult to dry. Take extra care with them.
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3.

Check that the paper type selected in the front panel is the same as the paper type you are
using.

4.

Perhaps you have adjusted the drying time at the front panel to speed up the printer output.
Select the

5.

icon, then Select drying time, and make sure it is set to Optimal.

Allow the prints time to dry separately; do not cover or stack them.

Lines are slightly warped
The paper itself may be warped. This can happen if it has been used or stored in an extreme
environment. See Environmental specifications.

Color accuracy
1.

Ensure that your paper type has been calibrated, which will give you consistency from print to
print, and from printer to printer. See Perform color calibration.

2.

Select suitable options in your application: see How do I... (color topics).
NOTE If you are not using PostScript, remember that your printer may be configured to use
one of its internal pen palettes instead of your software's palette (which is the default). See
Pen settings seem to have no effect.

Color accuracy using EPS or PDF images in page layout
applications
Page layout applications such as Adobe InDesign and QuarkXPress do not support color
management of EPS, PDF, or grayscale files.
If you have to use such files, try to ensure that the EPS, PDF, or grayscale images are already in the
same color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if
your final goal is to print the job in a press that follows the SWOP standard, at the time of creating
the EPS, PDF or grayscale you should convert the image into SWOP.

PANTONE color accuracy
Spot colors are special premixed inks to be used directly in the press, and the best–known spot
colors are PANTONE colors.
If you have the PostScript model, your printer provides a facility called Automatic PANTONE
Calibration, which can easily match most of the PANTONE Solid Coated spot colors. When an
application sends a PANTONE color to print, it sends the PANTONE name together with its own
estimate of equivalent CMYK values. The Automatic PANTONE Calibration facility recognizes the
PANTONE name and converts it to CMYK in a way that depends on the printer model and the
selected paper type, enabling the color to be rendered with greater precision than is possible with the
generic CMYK values sent by the application.
Even when using Automatic PANTONE Calibration, you cannot expect the printer to match the
PANTONE colors exactly. Your printer is certified by Pantone for some papers, but this does not
mean that it can reproduce 100% of the PANTONE colors.

ENWW

Lines are slightly warped

267

The problem is... (print
quality topics)

There are two basic requirements for color accuracy:

Using Automatic PANTONE Calibration (the best choice)
In order to use Automatic PANTONE Calibration, you need an application that recognizes the
PANTONE colors, and a calibrated PostScript printer.
The Automatic PANTONE Calibration facility emulates PANTONE Solid Coated colors only (suffix
C). Other PANTONE colors will be printed using the CMYK values sent by the application.

Converting PANTONE colors manually
If you have a non–PostScript printer, or if you are using an application (such as Adobe Photoshop)
that does not send the name of the PANTONE color to the printer, you will not be able to use
Automatic PANTONE Calibration. Instead, if you wish, you can convert each PANTONE color
manually to CMYK values in the application, using tables produced especially for your printer and
paper type.
If your application has a facility to convert PANTONE colors to CMYK values automatically, it
probably does not take account of printer or paper type, so you will get better results with a manual
conversion using the tables.
You can also obtain a PANTONE calibrated color chart in EPS, TIFF, and PDF format, which can be
convenient if your application has an eyedropper tool with which you can pick up colors from an
imported graphic.

The problem is... (print
quality topics)

Tips
●

Automatic PANTONE Calibration works with PostScript printers only.

●

Ensure that Automatic PANTONE Calibration is turned on in the driver.

●

Some applications may not support PANTONE colors fully; for example, Photoshop 7.0 does
not send the PANTONE Color with its name, it sends only the CMYK values from its standard
table.

●

Some colors may be out of gamut and impossible to match precisely with your printer and paper
type.

Color matching between different HP Designjets
If you print an image on two different printer models (for instance, on an HP Designjet 4000 Printer
series and an HP Designjet 1000 Printer series), you may find that the colors of the two prints do not
match well.
Matching two printing devices that use different ink chemistry, paper chemistry, and printheads is
unlikely to be completely successful. The information provided here is the best way to emulate one
printer with another. Even so, the end result may not be a perfect match.

Printing via separate PostScript drivers
The situation is that you are printing on each printer using the PostScript driver installed for that
printer. In this example, we are using an HP Designjet 4000 Printer series and an HP Designjet 1000
Printer series.
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1.

Ensure that both printers have been updated to the latest firmware version. See Update my
printer's firmware.

2.

Ensure that you have the latest printer driver for both printers. You can download the latest
versions for any HP printer from http://www.hp.com/go/designjet.
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3.

Ensure that Color Calibration is turned on. At the front panel of the HP Designjet 4000 series,
select the

icon, then Printer configuration > Color calibration > On .

4.

Load the printers with similar paper types.

5.

Ensure that the Paper Type setting on the front panel corresponds to the paper you have loaded.

6.

Print your image on the HP Designjet 1000 Printer series using your normal settings.

7.

Now prepare to print the same image on the HP Designjet 4000 Printer series.

8.

In your application, set the color space of the image to emulate the HP Designjet 1000 Printer
series and the specific paper type that you used in that printer. The data sent to the driver must
be already converted to this emulation color space, which is a CMYK color space. See your
application's online help for information on how to do this. In this way, the 4000 series will
emulate the colors that the 1000 series can produce when printing on that paper type.

9.

In the PostScript driver for the HP Designjet 4000 Printer series, go to the Color Management
section and set the CMYK input profile to the same HP Designjet 1000 Printer series color
space that you selected in the application (the emulation color space).

10. Set the rendering intent to Relative Colorimetric, or to Absolute Colorimetric if you want to
emulate the whiteness of the paper.
11. Print the image on the HP Designjet 4000 Printer series.

Printing via separate HP-GL/2 drivers
The situation is that you are printing on each printer using the HP-GL/2 driver installed for that printer.
1.

Ensure that both printers have been updated to the latest firmware version. See Update my
printer's firmware.

2.

Ensure that you have the latest printer driver for both printers. You can download the latest
versions for any HP printer from http://www.hp.com/go/designjet.

3.

Ensure that Color Calibration is turned on. At the front panel of the HP Designjet 4000 Printer
series, select the

ENWW

icon, then Printer configuration > Color calibration > On .

4.

Load the printers with similar paper types.

5.

Ensure that the Paper Type setting on the front panel corresponds to the paper you have loaded.

6.

With the HP-GL/2 driver for the HP Designjet 4000 Printer series, select the Color tab, and
select Printer Emulation from the list of color management options. Then choose the Designjet
1000 series from the list of emulated printers.

7.

With the HP-GL/2 driver for the HP Designjet 1000 series, select the Options tab, then Manual
Color > Color Control > Match Screen. You should also select the Paper Size tab, then Paper
Type.

Color matching between different HP Designjets
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NOTE When trying to emulate another printer you should always use CMYK colors, not
RGB.

Printing the same HP-GL/2 file
The situation is that you have produced an HP-GL/2 file (also known as a PLT file) using the HPGL/2 driver installed for one printer, and you intend to send the same file to both printers.
1.

Ensure that both printers have been updated to the latest firmware version. See Update my
printer's firmware.

2.

Ensure that Color Calibration is turned on. At the front panel of the HP Designjet 4000 Printer
series, select the

icon, then Printer configuration > Color calibration > On .

3.

Load the printers with similar paper types.

4.

Ensure that the Paper Type setting on the front panel corresponds to the paper you have loaded.

5.

If you have an HP-GL/2 file produced for an HP Designjet 1000 Printer series and you want to
print it on an HP Designjet 4000 Printer series, proceed as follows using the Embedded Web
Server or the front panel.
●
●

Using the Embedded Web Server: leave the color options set to Default.
icon, then Default printing options > Color options >
Using the front panel: select the
Select RGB input profile > HP Designjet 1000 Series.

The problem is... (print
quality topics)

For other HP Designjet printers, set both printers to match the screen colors (sRGB if
selectable), as when printing with separate HP-GL/2 drivers.

270

Chapter 18

The problem is... (print quality topics)

ENWW

19 The problem is... (image error topics)

The print is completely blank

●

The output contains only a partial print

●

The image is clipped

●

The image is in one portion of the printing area

●

The image is unexpectedly rotated

●

The print is a mirror image of the original

●

The print is distorted or unintelligible

●

One image overlays another on the same sheet

●

Pen settings seem to have no effect

●

Some objects are missing from the printed image

●

A PDF file is clipped or objects are missing

●

No output when printing from Microsoft Visio 2003

The problem is... (image
error topics)

●
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The print is completely blank
If the front-panel graphic language setting is Automatic (the default), try the other settings:
PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 file, etc. (see Change the graphic language
setting). Then send the file again.
When you have finished this particular print, remember to reset the graphic language to Automatic.

The output contains only a partial print
●

Did you press Cancel before all the data were received by the printer? If so, you have ended the
data transmission and will have to print the page again.

●

The I/O timeout setting may be too short. From the front panel, you can increase the I/O
timeout setting to a longer period and then send the print again. Select the
setup > Select I/O timeout.

icon, then I/O

●

There may be a communications problem between your computer and the printer. Check your
interface cable.

●

Check to make sure that your software settings are correct for your current page size (e.g. longaxis prints).

●

If you are using network software, make sure it has not timed out.

The image is clipped
If you are using the HP Designjet 4500 Printer series, any print liable to be clipped will normally be
be put “on hold for paper”, and actual clipping will occur only if there is a software error of some kind.
On the HP Designjet 4000 Printer series, clipping normally indicates a discrepancy between the
actual printable area on the loaded paper and the printable area as understood by your software.
●

Check the actual printable area for the paper size you have loaded.

The problem is... (image
error topics)

printable area = paper size – margins
The Windows HP-GL/2 driver displays the printable area in the Paper/Quality tab.
●

Check what your software understands to be the printable area (which it may call "printing area"
or "imageable area"). For example, some software applications assume standard printable
areas that are larger than those used in this printer.

●

If your image contains its own margins, you may be able to print it successfully by telling the
printer not to add margins to it (see Print without added margins). In this case:
printable area = paper size
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●

If you are trying to print a very long image on a roll, check that your software is capable of
printing an image of that size.

●

Check that the orientation of the paper is the same as that assumed by your software. The frontpanel Printing defaults menu > Paper options > Rotate option changes both the orientation
of a print and the orientation of the page. It is possible that a rotated image on a roll may be
slightly clipped in order to retain the correct page size.

●

You may have asked to rotate the page from portrait to landscape on a paper size that is not
wide enough.

●

If necessary, change the printable area in your software.
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There is another possible explanation for a clipped image. Some applications, such as Adobe
Photoshop, Adobe Illustrator, and CorelDRAW, use an internal 16–bit coordinate system which
means that they cannot handle an image of more than 32,768 pixels. If you try to print an image
larger than this from these applications, the bottom of the image will be clipped. In this case, the only
way to print the whole image is to reduce the resolution so that the whole image requires fewer than
32,768 pixels. The HP-GL/2 printer driver contains an option called Compatibility with 16-bit
applications, which can be used to reduce the resolution of such images automatically. You can find
this option by selecting the driver's Advanced tab, then Document options, then Printer features.

The image is in one portion of the printing area
●

Have you selected too small a page size in your application?

●

Does your application think that the image is in one portion of the page?

The image is unexpectedly rotated
At the front panel, select the
icon, then Default printing options > Paper options > Rotate.
Check that the setting is what you wanted.
For non-PostScript files: if Nesting is On, pages may be automatically rotated to save paper. See
Rotate an image.

The print is a mirror image of the original
At the front panel, select the
icon, then Default printing options > Paper options > Enable
mirror. Check that the setting is what you wanted.

●

The interface cable connecting your printer to your network (or to your computer) could be
faulty. Try another cable.

●

If the front-panel graphic language setting is Automatic (the default), try the other settings:
PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 file etc. (see Change the graphic
language setting). Then send the file again.

●

Depending on the software, drivers, and RIPs you are using with your printer, there will be
different ways of solving this problem. Refer to the vendor's user documentation for details.

The problem is... (image
error topics)

The print is distorted or unintelligible

One image overlays another on the same sheet
The I/O timeout setting may be too long. From the front panel, decrease the setting and print again.
Select the
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icon, then I/O setup > Select I/O timeout.

The image is in one portion of the printing area
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Pen settings seem to have no effect
Here are some possible explanations:
●

●

You have changed the settings in the front panel by selecting the
icon followed by Default
printing options > HP-GL/2 settings > Define palette, but you have forgotten to select that
palette in Default printing options > HP-GL/2 settings > Select palette.
If you want the software-driven pen settings, you must remember to go to the front panel and
select the
Software.

icon followed by Default printing options > HP-GL/2 settings > Select palette >

Some objects are missing from the printed image
Large quantities of data may be necessary to print a high-quality large-format print job, and in some
specific workflows there may be issues that can lead to some objects missing from the output. Here
are some recommendations for the use of the HP-GL/2 driver for Windows in these cases.
●

In the
Advanced tab, select Document options, Printer features, and set Send Job as Raster to
Enabled.

●

In the Advanced tab, select Document options, Printer features, and set 16-bit App.
Compatibility to Enabled.

●

In the Advanced tab, select Document options, Printer features, and set Max. Application
resolution to 300.

The above settings are mentioned for troubleshooting purposes and may adversely affect the final
output quality or the time necessary to generate the print job. Therefore, they should be restored to
their default values if they do not help to solve the problem.

The problem is... (image
error topics)

A PDF file is clipped or objects are missing
In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some
objects when printing with the HP-GL/2 driver at high resolution. In order to avoid such problems,
please upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From version 7
onwards, these problems should be solved.

No output when printing from Microsoft Visio 2003
For more information about problems when printing large images (more than 129 inches long) from
Microsoft Visio 2003, see Microsoft's online knowledge base (http://support.microsoft.com/search/).
To avoid these problems, it is possible to scale the image down in Visio to a size shorter than 129
inches and then to scale the drawing up in the driver by using the Scale to options in the Effects tab
of the Windows HP-GL/2 or PS drivers. If the downscaling in the application and the upscaling in the
driver match, the result will be as originally intended.
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20 The problem is... (ink system topics)

I cannot insert an ink cartridge

●

The printer will not accept a large black ink cartridge

●

I cannot remove an ink cartridge

●

I cannot insert a printhead

●

I cannot insert a printhead cleaner

●

The front panel keeps telling me to reseat or replace a printhead

●

An ink cartridge status message

●

A printhead status message

●

A printhead cleaner status message

The problem is... (ink
system topics)

●
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I cannot insert an ink cartridge
1.

Check that you have the correct type of cartridge (model number).

2.

Check that the colored label on the cartridge is the same color as the label on the slot.

3.

Check that the cartridge is correctly oriented, with the colored label at the top.
CAUTION Never clean inside the ink cartridge slots.

The printer will not accept a large black ink cartridge
Black ink cartridges of 775 cm³ capacity are supported by the HP Designet 4500 series, and by the
HP Designjet 4000 series with firmware release 4.1.1.5 or later. If you experience this problem with
an HP Designjet 4000 series printer, try updating the firmware (see Update my printer's firmware).

I cannot remove an ink cartridge
In order to remove an ink cartridge, you should first select Remove ink cartridges at the front panel
(see Remove an ink cartridge). If you try to remove the cartridge without using the front panel, the
cartridge may get stuck, and the front panel will display an error message.
To recover from this situation, press on the cartridge itself (not on the drawer or the blue tab) to push
it back into place. The error message should then disappear (it will disappear after a short time even
if you have not corrected the problem), and you can then restart the process in the correct way by
selecting Remove ink cartridges.

I cannot insert a printhead
1.

Check that you have the correct type of printhead (model number).

2.

Check that you have removed the blue protective cap and the clear protective tape from the
printhead.

3.

Check that the colored label on the printhead is the same color as the label on the slot.

4.

Check that the printhead is correctly oriented (compare with the others).

5.

Check that you have closed and latched the printhead cover.

I cannot insert a printhead cleaner
The problem is... (ink
system topics)

1.

Check that you have the correct type of cleaner (model number).

2.

Check that the colored label on the cleaner is the same color as the label on the slot.

3.

Check that the cleaner is correctly oriented (compare with the others).

The front panel keeps telling me to reseat or replace a
printhead
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1.

Remove the printhead and check that its protective film has been removed.

2.

Try cleaning the electrical connections between the printhead and the carriage. See Clean a
printhead's electrical connections.
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3.

Reinsert the printhead into the carriage and check the front panel message.

4.

If the problem remains, try a new printhead.

An ink cartridge status message
These are the possible ink cartridge status messages:
●

OK: the cartridge is working normally, with no known problems

●

Missing: there is no cartridge present, or it is not properly connected to the printer

●

Low: the ink level is low

●

Very low: the ink level is very low

●

Empty: the cartridge is empty

●

Reseat: you are recommended to remove the cartridge and then reinsert it

●

Replace: you are recommended to remove the cartridge and then reinsert it; if that fails, replace
the cartridge with a new cartridge

●

Altered: there is something unexpected about the cartridge's status—perhaps it has been refilled

A printhead status message
These are the possible printhead status messages:
●

OK: the printhead is working normally, with no known problems

●

Missing: there is no printhead present, or it is not properly installed in the printer

●

Reseat: you are recommended to start the printhead removal process from the front panel (see
Remove a printhead), but instead of removing the printhead, just press the Select key on the
front panel

●

Replace: you are recommended to remove the printhead and then reinsert it; if that fails, clean
the electrical connections; if that fails, replace the printhead with a new printhead

●

Remove: the printhead is not a suitable type for use in printing (for instance, a setup printhead)

A printhead cleaner status message
●

OK: the cleaner is working normally, with no known problems

●

Missing: there is no cleaner present, or it is not properly installed in the printer

●

Reseat cleaner: you are recommended to remove the cleaner and then reinsert it

●

Wrong stall: the cleaner has been installed in the wrong place

●

End of life: the cleaner has reached the end of its planned lifetime

●

Not replaced with printhead: you have installed a new printhead without installing the new
cleaner that came with it

The problem is... (ink
system topics)

These are the possible printhead cleaner status messages:

If a printhead cleaner needs to be removed or reseated, you must start the printhead replacement
process (see Remove a printhead). Open the window when prompted to do so by the front panel. If

ENWW

An ink cartridge status message
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the front panel shows the printheads with no printhead blinking, you do not need to touch the
printheads. Just close the window again, and the printer will proceed to printhead cleaner
replacement.

The problem is... (ink
system topics)
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●

Paper scrolling

●

The trailing edge of the paper curling up

●

The paper is not completely ejected

279
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(stacker topics) [4500]

21 The problem is... (stacker topics) [4500]

The problem is...
(stacker topics) [4500]

Paper scrolling
When printing in Fast mode with highly curled paper, the paper may scroll when ejected to the
stacker tray. To avoid this problem, you are recommended to switch to Normal mode or use a paper
roll with a 3 inch core.

The trailing edge of the paper curling up
Use the Optimize for images setting: see Change the print quality.

The paper is not completely ejected
Check for any obstruction in the paper path, such as loose objects or other pieces of paper.
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22 The problem is... (scanner topics)
[4500]

NOTE This chapter applies to the HP Designjet 4500 Printer series only.
If you notice problems with the scanner other than those described below, consult the scanner's
online guide for further advice.
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●

The diagnostics light is flashing

●

The wait light is flashing

●

The wait and diagnostics lights are both flashing

●

The scanner displays a warning message

●

The scanner software is in the wrong language

●

The scanner software does not start

●

The CD or DVD cannot be read by my computer

●

A media profile cannot be generated

●

The printer puts the job on hold

●

The printer loads the wrong roll

●

The margins are too wide

●

Streaks in the scanned image
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The diagnostics light is flashing

The problem is...
(scanner topics) [4500]

The most likely explanation is that the scanning area needs cleaning. Perform the routine
maintenance procedures explained in your online guide, which include cleaning. Restart the scanner
when you have finished the maintenance procedures.
If the light continues to flash, there may be camera position errors. In this case, contact HP Support.

The wait light is flashing

This indicates that the scanner needs to make some readjustment but is unable to do so. Remove all
paper from the scanner, ensure the insertion slot height is set to minimum, and wait for the light to
turn off.

The wait and diagnostics lights are both flashing

In this case, disregard the wait light and respond only to the diagnostics light. See The diagnostics
light is flashing.
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The scanner displays a warning message
●

Scanner Maintenance has not been run for 30 days.

●

Lamp quality fails. The filter should be replaced at the same time.

●

Glass plate quality fails.

●

Original background quality fails.

The problem is...
(scanner topics) [4500]

The scanner may recommend performing maintenance in some circumstances:

If you see any of these warnings displayed, consult the scanner's online guide for information on
recommended maintenance procedures.

The scanner software is in the wrong language
If your scanner software is in the wrong language for any reason, you can easily change the
language as follows:
1.

In the Setup tab, press the Options button.

2.

Press the System button.

3.

Press the Advanced button and give the administrator’s password.

4.

Press the Change Language button.

5.

Select your preferred language.

You will now have to wait a short time while the system shuts down and restarts.

The scanner software does not start
If your scanner system software does not start up when you turn on the touch screen, trying turning it
off and then on again.
If it persistently fails to start up, you may need to reinstall the software, using the ’System Recovery’
DVD that came with your scanner system.
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1.

With the system on, insert the System Recovery DVD in the DVD drive.

2.

Power off the touch screen and then power it on again.

3.

Follow the instructions on the screen.

4.

When the software has been reinstalled, you will be prompted to remove the DVD and restart
the touch screen.

5.

When the touch screen restarts, it will ask you to calibrate the position of the pointer. Please do
so by touching the targets that will appear three times. To obtain a good and consistent
calibration, you should be standing in your normal position and using whatever pointer you
normally use to operate the touch screen (your finger, or some other object).

6.

After touching the three targets, you will be asked to touch any part of the touch screen. If you
are happy with the result of the calibration, press the Yes button. If you are prompted to restart
the system, press No.

The scanner displays a warning message
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7.

The language selection screen should appear. Select the language you want to use for the
Designjet Scan application. The touch screen will automatically restart in the selected language.

8.

Allow time for the operating system to be reloaded. The process has finished when the touch
screen shows the Copy tab of the Designjet Scan application.

The CD or DVD cannot be read by my computer
The scanner creates CDs and DVDs compliant with the ISO 9660 standard plus Joliet Extension.
This standard is commonly supported but it cannot be guaranteed that all computers will support it.

The problem is...
(scanner topics) [4500]

A media profile cannot be generated
Check that the scanner and the printer are both switched on and ready for normal operation.

The printer puts the job on hold
This can happen if your scanner account has not been properly set up (see Enable or disable
scanner accounts), or if the printer does not have the correct paper type or size loaded.

The printer loads the wrong roll
The HP Designjet 4500 Printer series may automatically load the other roll in some circumstances in
order to save paper. To prevent this behavior, select the
icon on the printer's front panel, then
Paper handling options > Roll switching options > Minimize roll changes.

The margins are too wide
When you set the margins in the scanner software and then print an image, the printer adds its own
default margins to the margins you have defined.
You can tell the scanner to compensate for this behaviour by selecting the Setup tab, then the
Margins button, then the Clip contents by printer's margins option. Subsequently, the margins you
select in the scanner software should correspond to the printed margins. However, if image is as
wide as the paper, you may find that the edges of the image are not printed.

Streaks in the scanned image
If the problem is visible when previewing the image on screen, it may be due to dirt or scratches on
the glass. First try to clean the glass (see Clean the glass). If the problem persists, you may need to
replace the glass.
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●

The printer's start-up process does not complete

●

A front panel message

●

A “printhead monitoring” message

●

A “printheads are limiting performance” message

●

An “on hold for paper” message [4500]

●

The printer does not print

●

The printer seems slow

●

The application slows down or hangs up while generating the print job

●

Communication failures between computer and printer

●

I cannot access the Embedded Web Server from my browser

●

An out-of-memory error

●

An AutoCAD 2000 memory allocation error

●

The platen rollers squeak

The problem is... (other
topics)

23 The problem is... (other topics)
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The printer's start-up process does not complete

If the printer's start-up process stops when the front panel is displaying the number 17, this indicates
that there is a problem with the file system on the printer's hard disk, so the printer is checking the
whole file system and making any necessary corrections. This problem can arise when there has
been a power cut while the printer was switched on, or if there is a physical problem with the hard
disk.
Checking the whole file system normally takes about half an hour. There is nothing you can do to
speed it up. If you turn off the printer, the file system check will restart whenever you turn it on again.
If you experience this problem repeatedly when there has been no power cut, contact your customer
service representative.

The problem is... (other
topics)

A front panel message
The front panel displays messages of many kinds; some allow you to continue using the printer while
others require you to take action before you can continue.
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●

If the printer detects a condition of which you should be aware, it displays a message for your
information. Examples of information messages are performance limiting conditions, and printer
maintenance requirements. Once you have read the message you can remove it by pressing
the Select key and continue to use the printer.

●

If the printer detects an error, an error code and short message are displayed on the front panel.
The following table provides suggested actions to recover from these error conditions:

Code

Short message

Suggested action

13:01

Reseat all cartridges

Remove and re-insert all the print cartridges; see Remove an
ink cartridge and Insert an ink cartridge. If the problem
persists, please contact your customer service representative.

26.0:01

Reseat yellow cartridge

The yellow cartridge is not detected, please try to re-install it;
see Remove an ink cartridge and Insert an ink cartridge. If the
problem persists, please contact your customer service
representative.

26.1:01

Reseat magenta cartridge

The magenta cartridge is not detected, please try to re-install
it; see Remove an ink cartridge and Insert an ink cartridge. If
the problem persists, please contact your customer service
representative.

26.2:01

Reseat black cartridge

The black cartridge is not detected, please try to re-install it;
see Remove an ink cartridge and Insert an ink cartridge. If the
problem persists, please contact your customer service
representative.

26.3:01

Reseat cyan cartridge

The cyan cartridge is not detected, please try to re-install it;
see Remove an ink cartridge and Insert an ink cartridge. If the
problem persists, please contact your customer service
representative.

Chapter 23

The problem is... (other topics)

ENWW

Short message

Suggested action

27:03

Restart the printer. If problem persists, call
HP support.

An error has been detected during printhead detection. Reseat
all the printheads; see Remove a printhead and Insert a
printhead and Restart. If the problem persists, please contact
your customer service representative.

38.1:01

Stacker communication error

No communications have been received from the stacker.
Check that the stacker is switched on and connected to the
printer. If necessary, you can remove the stacker completely
and continue printing without it (if printing has not started yet)
or cancel a half-printed job and restart. If you cancel a halfprinted job, the paper will be cut, and ejected when the stacker
is restarted.

Check connections

38.2:01

Status mismatch. Reset stacker.

The stacker has been switched off and on in the middle of a
print job. The job is automatically canceled, the paper is cut
and ejected.

39:01

Input rollers 1 and 2 need cleaning. Press
Enter to quit, or Cancel to continue.

See Clean the input rollers.

61:01

Wrong file format. The printer cannot
process the job.

The file format is wrong and the printer cannot process the job.
Check the graphic language setting of your printer (see
Change the graphic language setting). If you are sending
PostScript from Mac OS over a USB connection, select ASCII
encoding in both the driver and the application. Check for the
latest firmware and driver releases.

61:04.1

Update system software (firmware)

Even if you have the latest version installed on your printer,
you are recommended to repeat the update process to clear
this error. See Update my printer's firmware.

61:08.1

File with password cannot be printed.

Resend this file without password protection.

62:04

Restart the printer. If problem persists, call
HP support.

An error has been detected with the parallel port. See Restart
If the problem persists, check for the latest firmware release.

63:04

Restart the printer. If problem persists, call
HP support.

An error has been detected with a LAN port. See Restart If the
problem persists, check for the latest firmware release.

64:04

Restart the printer. If problem persists, call
HP support.

An error has been detected with the USB port. See Restart If
the problem persists, check for the latest firmware release.

66:08

Please resubmit the job as the paper type
has changed

The paper type has changed since the job was submitter. The
job cannot be printed on the paper that is loaded; please
resubmit the job or change the paper.

71:03

Restart the printer. If problem persists, call
HP support.

Out of memory failure. You are recommended to remove any
unnecessary files from the hard disk using the Embedded Web
Server. See Restart.

76:03

Restart the printer. If problem persists, call
HP support.

The hard disk is full. If the problem persists, you are
recommended to remove any unnecessary files from the hard
disk, using the Web server. See Restart.

77:04

Restart the printer. If problem persists, call
HP support.

The Embedded Web Server does not seem to be working. See
Restart If the problem persists, check for the latest firmware
release.

81:01

Possible paper jam

A paper jam has been detected within the printer. See A paper
jam (paper stuck in the printer) [4000] or A paper jam (paper
stuck in the printer) [4500].

83.y:1x

Stacker internal error

The print job is automatically canceled and cut. Switch the
stacker off and then on again. If the problem remains, remove
the stacker and continue printing without it.

Reset stacker
84.1:01
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Possible paper jam

A paper jam has been detected in drawer 1. See A paper jam
(paper stuck in the printer) [4500].

A front panel message
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Code

Code

Short message

Suggested action

84.1:03

Restart the printer. If the problem persists,
call HP support.

Check that the cable between the printer and roll module 2 is
well connected.

84.2:01

Possible paper jam

A paper jam has been detected in drawer 2. See A paper jam
in drawer 2 [4500].

86:01

Possible paper jam

A paper jam has been detected in the platen area. See A
paper jam (paper stuck in the printer) [4000] or A paper jam
(paper stuck in the printer) [4500].

Stacker communication error. Check
connections.

No communication received from the stacker. Connect the
stacker or turn it on.

Stacker disengaged. Attach it to printer.

Switch off the stacker, attach it to the printer, then switch it on
again.

Stacker full of media

Remove the accumulated pile of paper from the stacker.

Stacker paper jam

Remove the accumulated pile of paper from the stacker. Turn
it off and then on again.

The problem is... (other
topics)

If your printer front panel is displaying an error code which is not in the list above, try the following:
restart the printer (see Restart) and/or check to make sure you have the latest firmware and driver
versions (see Update my printer's firmware). If the problem persists, contact your customer service
representative.

A “printhead monitoring” message
This is not an error message. The message is displayed whenever the Printhead monitoring option
is set to Intensive. If you change the setting to Optimized, the message will not appear. See
Manage printhead monitoring.

A “printheads are limiting performance” message
This message appears on the front panel during printing when the printer has detected that one or
more printheads are not performing optimally, and so it needs to make extra passes to maintain print
quality. To eliminate this message, choose one of the following:
●

Select a higher print quality; see Change the print quality.

●

Clean the printheads; see Recover (clean) the printheads.

●

Use the Image Diagnostics Print to identify which printhead is causing the problem; see How do
I... (Image Diagnostics Print topics).

An “on hold for paper” message [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
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Your print job may be described as “on hold for paper” for one or more of the following reasons:
●

You have requested a specific paper type for the job which is not currently loaded.

●

You have requested a specific paper roll for the job (1 or 2) which is not currently loaded.

●

The width of the job is greater than the width of any roll currently loaded.

When this happens, you have two possible ways of printing the job:
●

Correct the problem by loading the specified paper type, or the specified roll, or a roll of the
correct width. You can select Properties to see the requirements of the job. Then select
Continue in the Embedded Web Server or in the front panel. This is the recommended solution.

●

Select Continue in the Embedded Web Server or in the front panel without changing anything
on the printer. A warning message will be displayed and you will be asked for confirmation. If
you confirm, the job will be printed, possibly on the wrong paper type (which may affect print
quality) or on paper that is too narrow (which will cause clipping).
NOTE To see the job queue at the front panel, select the

icon and then Job queue.

If all is in order (paper loaded, all ink components installed, and no file errors), there are still reasons
why a file you have sent from your computer may not start printing when expected:
●

You may have an electrical power problem. If there is no activity at all from the printer, and the
front panel does not respond, check that the power cable is connected correctly and that there
is power available at the socket.

●

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic
fields or severe electrical disturbances, which can cause the printer to behave strangely, or
even stop working. In this case, turn off the printer using the Power key on the front panel, wait
until the electromagnetic environment has returned to normal, and then turn it on again. If you
still experience problems, please contact your customer service representative.

●

You may have the wrong
graphic language setting. See Change the graphic language setting.

●

You may not have installed in your computer the correct driver for your printer. See the Setup
instructions.

●

The right paper may not be available to print the job, perhaps because:
●

The selected roll is not loaded.

●

The selected paper type is not loaded on any roll.

●

There is not enough paper of the selected type to print the whole job.

On the HP Designjet 4500 series, a job may be held in the queue for one of these reasons,
while other jobs in the queue are printed because the right paper is available for them. In this
case, you can print the held job by loading the correct paper and using the front panel or the
Embedded Web Server to continue the job.
●

If you are using Mac OS with a FireWire or USB connection, you may find that you need to
icon, then Default printing options > PS options >
change the data encoding. Select the
Select encoding > ASCII. Then configure your application to send ASCII data.
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The printer does not print

●

The print file may lack a proper file terminator and the printer is therefore waiting for the
specified I/O timeout period before assuming it is complete.
icon, then Default
If you are using Mac OS with a FireWire or USB connection, select the
printing options > PS options > Select encoding > ASCII. Then configure your application to
send ASCII data.

●

Nesting may be on and the printer is waiting for the specified nest wait timeout period before
calculating the appropriate nests. In this case, the printer display shows the remaining time for
the nesting timeout.

●

You may have requested a print preview from your printer driver. This is a function you can use
to check that the image is the one you want. In this case, the preview is displayed in a Web
browser window, and you must click a button to start printing.

The printer seems slow
Here are some possible explanations.

The problem is... (other
topics)

●

Did you set the print quality to Best? Best-quality prints take longer.

●

Did you specify the correct paper type when loading the paper? To find out the printer's current
paper type setting, see View information about the paper.

●

Are you using the printer with the AppleTalk serial port on a Macintosh computer? It is normal
for the AppleTalk port to be slow. Consider using the EtherTalk interface to connect your printer
to your Macintosh.

●

Do you have a network connection to your printer? Check that all components used in the
network (network interface cards, hubs, routers, switches, cables) are capable of high-speed
operation. Is there a lot of traffic from other devices on the network?

●

Did you specify Extended drying time in the front panel? Try changing the drying time to
Optimal; see Drying time.

●

Are your printheads in good condition? The printer may print slower to maintain print quality
when a printhead is faulty. Check the printhead status in the front panel or in the Embedded
Web Server, and recover or replace printheads if necessary.

●

Do you have high-density black areas in your image? In this case, the printer may change
temporarily to a slower print quality option in order to maintain quality.

The application slows down or hangs up while
generating the print job
Large quantities of data may be necessary to generate a high-quality large-format print job. In some
cases, this may cause your application to slow down very noticeably (taking several minutes to
generate the print job) or even to hang up.
To avoid this behavior in the Windows HP-GL/2 driver, try selecting the Advanced tab, then
Document options, Printer features, and set Max. Application resolution to 300. We recommend
restoring this setting to its default value subsequently, because a setting of 300 may adversely affect
final print quality.
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Communication failures between computer and printer
Some symptoms are:
●

The front-panel display does not show the “Receiving” message when you have sent an image
to the printer.

●

Your computer displays an error message when you are trying to print.

●

Your computer or printer “hangs” (stays idle) while communication is taking place.

●

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

●

Ensure that you have selected the correct printer in your software.

●

Ensure that the printer works correctly when printing from other software.

●

Remember that very large prints may take some time to receive, process, and print.

●

If the printer is connected to a network, try using it when connected directly to your computer
through a FireWire or USB cable. See Connecting the printer.

●

If your printer is connected to your computer through any other intermediate devices, such as
switch boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected
directly to your computer.

●

Try another interface cable. See Connecting the printer.

●

Ensure that the graphic language setting is correct. See Change the graphic language setting.

The problem is... (other
topics)

To solve a communication problem:

I cannot access the Embedded Web Server from my
browser
If you have not done so already, please read Access the Embedded Web Server.
●

Have you set a password for the Embedded Web Server, and then forgotten the password? If
so, select the

●

icon, then Printer configuration > Resets > Reset EWS password.

At the printer's front panel, select the

icon, then Printer configuration > Allow EWS > On.

●

Check that you have a TCP/IP (network or FireWire) connection to your printer. If you connect
directly to your printer with a USB cable, you cannot use the Embedded Web Server.

●

If you are using a FireWire connection, make sure that your computer's operating system
supports IP over IEEE-1394 (FireWire). For example, Windows XP and Windows 2003 Server
support IP over FireWire, but Windows 2000 does not. Mac OS X 10.3 and later versions also
support IP over FireWire (see Access the Embedded Web Server). Make sure that your
operating system is configured to use IP over FireWire.

●

At the printer's front panel, check that IP is enabled for the type of connection you are using.
icon, then I/O setup, then the type of connection you are using, then View
Select the
information, and check that you see IP enabled. If not, you may need to use a different type of
connection.

●

If you normally access the Web through a proxy server, try bypassing the proxy server and
accessing the Web server directly. You can do this by modifying your browser settings.
For instance, if you are using Internet Explorer 6 for Windows, go to Tools > Internet Options
> Connections > LAN Settings, and check the 'Bypass proxy server for local addresses' box.
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Alternatively, for more precise control, click the Advanced button and add the printer's IP
address to the list of Exceptions for which the proxy server is not used.
●

Try switching off the printer (with the Power key on the front panel) and then switching it on
again.

An out-of-memory error
There is no direct relationship between the size of a file in your computer and the amount of memory
needed in the printer to print the file. In fact, because of file compression and other complicating
factors it is often impossible to estimate how much memory will be needed. So it is possible that a
print will fail for lack of memory even though you may have successfully printed larger files in the
past. In this case you may need to consider adding more memory to your printer.
If you are using the Windows HP-GL/2 driver, you can often solve printer memory problems by
selecting the Advanced tab, then Document options, then Printer features, then Print job as raster.
NOTE If you select this option, the time needed to process the job in your computer may be
considerably longer.

The problem is... (other
topics)

An AutoCAD 2000 memory allocation error
After installing the printer driver, when you try to print for the first time from AutoCAD 2000, you may
see a message saying Memory allocation error, after which your image is not printed.
This is due to a problem in AutoCAD 2000, and it can be fixed by downloading the Plotting Update
Patch (plotupdate.exe) from the Autodesk Web site, http://www.autodesk.com/.
This patch is also worth trying if you have any other strange problems when printing from AutoCAD
2000.

The platen rollers squeak
It may occasionally be necessary to oil the rollers. The Maintenance Kit, which came with your
printer, contains a bottle of suitable oil.
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1.

Turn off the printer using the Power key on the front panel.

2.

Open the window.

Chapter 23
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3.

There are small holes in the platen beside some of the rollers.
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4.

Repeat the process until all of the holes in the platen have had three drops of oil placed in them.

5.

Be careful not to spill oil onto the platen.

The platen rollers squeak
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Using the bottle of oil supplied with the Maintenance Kit, insert the pointed end of the bottle into
each hole in turn, and put three drops of oil into each hole.

6.

If there is oil on the platen, wipe it away with the cloth supplied with the kit.

7.

Lower the window.

The problem is... (other
topics)
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The Embedded Web Server is the control center for remote management of your printer. From any
computer, you can use an ordinary Web browser to contact your printer's Embedded Web Server
(see Access the Embedded Web Server).

With the Embedded Web Server, you can:
●

Submit jobs to the printer in various file formats (HP-GL/2, HP-RTL, PostScript, PDF, JPEG,
TIFF, CALS G4) without the need of a driver nor an application: see Submit a job with the
Embedded Web Server.
NOTE PostScript and PDF formats can be used with PostScript printers only.
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●

Control and manage all aspects of your print jobs: see Manage the print queue.

●

View the status of the ink cartridges, the printheads, the printhead cleaners, and the paper: see
Check the status of the ink system.

●

View statistics on ink and paper usage: see Check printer usage statistics.

●

Request E-mail notification when specified warning or error conditions occur (such as low ink
level): see Request E-mail notification of specific error conditions.

●

Update the printer's firmware: see Update my printer's firmware.

●

Change various printer settings (on the Device Setup page)

●

Set a password to restrict Web access to the printer: see Password-protect the Embedded Web
Server.
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Color emulation modes

●

Connecting the printer

●

The printer's rear lights

●

The printer's internal prints

●

Preventive maintenance

Tell me about... (printer
topics)

●

ENWW

297

Color emulation modes
Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and
CMYK devices such as presses and printers. See Select the color emulation mode.
If you have problems making your printer emulate another HP Designjet printer, seeColor matching
between different HP Designjets.
For a good emulation, the printer needs a specification of the colors these devices can reproduce.
The standard way of encapsulating such information is in ICC profiles. As part of the solution, we
provide the most common standards for the different devices. Apart from selecting the appropriate
ICC profile, you should select the appropriate rendering intent depending on the type of print:
business presentation, photography, or proof. See Set the rendering intent. For reference information
on the broader aspects of color printing refer to: http://www.hp.com/hpinfo/community/environment/
productinfo/psis_inkjet.htm
The options are as follows.
NOTE PDF and PostScript files can be used with PostScript printers only.

CMYK color emulation
All CMYK emulation options apply to PDF, PostScript, TIFF, and JPEG files only.
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●

None (Native): no emulation, for use when the color conversion is done by the application or
operating system, and therefore the data arrive at the printer already color–managed.

●

HP CMYK Plus: a set of HP proprietary re-rendering rules that will produce a good result for
most digital commercial printing jobs, by expanding the reduced gamut of your press into the
wider gamut of your printer.

●

U.S. Sheetfed Coated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 350% total area of ink coverage, negative plate,
bright white offset stock

●

U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality separations using
U.S. inks under the following printing conditions: 260% total area of ink coverage, negative
plate, uncoated white offset stock

●

U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality separations using
U.S. inks under the following printing conditions: 300% total area of ink coverage, negative
plate, coated publication-grade stock

●

U.S. Web Uncoated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 260% total area of ink coverage, negative plate,
uncoated white offset stock

●

Euroscale Coated 2 uses specifications designed to produce quality separations using
Euroscale inks under the following printing conditions: 350% total area of ink coverage, positive
plate, bright white coated stock

●

Euroscale Uncoated 2 uses specifications designed to produce quality separations using
Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive
plate, uncoated white offset stock

●

JMPA: Japanese standard for offset press

●

Photoshop 4 Default CMYK
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●

Photoshop 5 Default CMYK

●

Other HP Designjet printers can be emulated

In the front panel and the Embedded Web Server, some further options are available:
●

Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper. It
is designed to produce quality separations using 350% total ink coverage, positive film, and
coated paper

●

Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated)
paper. It is designed to produce quality separations using 310% total ink coverage, positive film,
and uncoated paper

●

Japan Web Coated (Ad) uses specifications developed by the Japan Magazine Publisher
Association for digital proofing of images in the Japanese magazine/advertising market

●

Toyo is designed to produce quality separations for Toyo printing presses

●

DIC is designed to produce quality separations for Dainippon Ink Company printing presses
NOTE These options have no effect if the application is defining its own CMYK space,
known as calibrated CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation
These options apply to PDF, PostScript, TIFF, and JPEG files. For HP-GL/2 and RTL files, only
sRGB and AdobeRGB are supported.
If you want to print an RGB image, it must be converted to CMYK data (although you may be able to
do it in the application or operating system). To perform this conversion, your printer is provided with
the following color profiles:
None (Native): no emulation. The printer will use its default internal conversion from RGB to
CMYK, without following any color standard. This does not imply that results will be bad.

●

sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard
space is endorsed by many hardware and software manufacturers, and is becoming the default
color space for many scanners, printers, and software applications.

●

ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space
provides a smaller gamut alternative to Adobe RGB (1998) for print production work.

●

Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety
of desktop publishing applications. Use this space for files that you plan to display on Apple
monitors, or for working with old desktop publishing files.

●

Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to
do print production work with a broad range of colors.
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Connecting the printer
Your printer comes with a 100base-TX network interface (Fast Ethernet) for network connections,
and a FireWire interface for direct connection to your computer.
A USB 2.0 interface, 1000base-T (Gigabit Ethernet) network interface, or Jetdirect print server may
be installed as optional accessories.
If you are not sure which interface to use, see Choose which connection method to use.
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To find the sockets for these interfaces on your printer, see Connect the printer (4000 series) or
Connect and switch on the printer (4500 series).
To set up your operating system to use the printer, see one of the following:
●

Connect to a network (Windows)

●

Connect to a network (Mac OS X)

●

Connect to a network (Mac OS 9) [4000]

●

Connect directly to a computer (Windows)

●

Connect directly to a computer (Mac OS X)

●

Connect directly to a computer (Mac OS 9) [4000]

The printer's rear lights
At the rear of the printer, above the power switch, are three small lights:
●

The amber light on the left is on when the printer is in sleep mode.

●

The blue light in the center is on when the printer is on (when it has electrical power).

●

The green light on the right is on when the printer is printing.

NOTE You should never see all three lights on at the same time, because the printer cannot
print in sleep mode.

The printer's internal prints
Tell me about... (printer
topics)

The internal prints give various kinds of information about your printer. They can be requested from
the front panel without using a computer.
Before requesting any internal print, make sure that paper is loaded (roll or sheet), and that the front
panel displays the Ready message. The paper should be at least 36 in (91.44 cm) wide, otherwise
the print may be clipped (HP Designjet 4000 series) or put “on hold for paper” (HP Designjet 4500
series).
To print any internal print, select the
print you want.
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The following internal prints are available:
●

Demo: shows some of the capabilities of the printer.

●

Menu map: shows details of all the front panel menus.

●

Configuration: shows all the current front panel settings.

●

Usage report: shows estimates of the total number of prints, number of prints by paper type,
number of prints by print quality option, and total amount of ink used per color. The accuracy of
these estimates is not guaranteed.

●

HP-GL/2 palette: shows the color or grayscale definitions in the currently-selected color palette.

●

PostScript font list: lists the PostScript fonts installed in the printer (PostScript printers only).

●

Image diagnostics: helps you to solve print quality problems. See How do I... (Image
Diagnostics Print topics).

●

Service information: provides information needed by service engineers.

Preventive maintenance
During the life of your printer, components that are used constantly can wear out with time and use.
To avoid these components being so worn that the printer breaks down, the printer keeps track of the
number of cycles the printer carriage makes across the axis of the printer and on the total quantity of
ink printed.

●

Maintenance #1 required

●

Maintenance #2 required

These messages mean that some components are nearing the end of their lives. You can continue
printing for quite some time, depending on your use of the printer. However it is strongly
recommended that you contact your customer service representative and arrange for a preventive
maintenance on-site visit. The service engineer can then replace the worn parts, which will prolong
the life of the printer for a further period.
The benefits of arranging a service engineer's visit when the front panel displays these messages
are two-fold:
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●

The printer components can be replaced at a time that is convenient for you and so will not
disturb your daily workflow.

●

When the service engineer performs a preventive maintenance visit he will replace several parts
at once. This will avoid the need for repeat visits.

Preventive maintenance
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The printer uses this number to advise you of the need for preventive maintenance, displaying one of
the following messages on the front panel:

Tell me about... (printer
topics)
302

Chapter 25

Tell me about... (printer topics)

ENWW

Tell me about... (ink
system topics)

26 Tell me about... (ink system topics)

ENWW

●

Ink cartridges

●

Printheads

●

Printhead cleaners

●

Ink system tips
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Ink cartridges
The printer's four ink cartridges provide yellow, magenta, black, and cyan ink to the printheads. The
color cartridges supplied with the printer have a capacity of 225 cm³, and the black cartridge has a
capacity of 400 cm³. It is also possible to buy and use color cartridges with a capacity of 400 cm³ and
black cartridges with a capacity of 775 cm³.
NOTE The 225 cm³ and 400 cm³ cartridges are physically the same size: only the internal
capacity varies. The 775 cm³ black cartridge is longer.

Ink cartridges require no maintenance or cleaning. As long as each ink cartridge is inserted correctly
into its slot, the ink will flow to the printheads. Because the printheads control the amount of ink
transferred to the page, you will continue to see high-quality printing results even when the ink levels
are getting low.

Replacing ink cartridges
You can highlight the
below).

icon at any time to check the ink levels of all the ink cartridges (as illustrated

The front panel warns you when a cartridge's ink level is low. When a cartridge is empty, the printer
stops printing and the front panel explains why:
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You are recommended to replace the empty cartridge with a new HP cartridge: see Remove an ink
cartridge and Insert an ink cartridge.
Although it is possible to use refilled or non-HP ink cartridges, either choice has several serious
disadvantages:
●

There is some risk of damaging the printer. In this case the printer warranty will not be valid for
any printer repairs that are related to the cartridge, nor for any problems due to ink
contamination.

●

You will invalidate the warranty of all printheads of the same color used in the printer
subsequently, unless and until the whole ink system (including ink tubes) is replaced.

●

Print quality may be impaired.

●

The printer will be unable to estimate the ink level in the cartridge, and will report it as empty.

If you decide to use refilled or non-HP ink cartridges, you will need to follow these instructions to
make the printer use a cartridge that it believes to be empty.
1.

Install the cartridge in the printer (see Insert an ink cartridge).

2.

The front panel will complain that the cartridge is empty, and the cartridge removal process will
start. Press the Cancel key to stop this automatic process.

3.

At the front panel, select the

4.

Highlight Replace ink cartridges, but do not select it.

5.

Press the Cancel key and the Up key at the same time, and hold them down for at least two
seconds.

6.

The front panel will display a series of warning messages. In response to each message, press
the Cancel key to cancel the process, or the Select key to confirm that you wish to continue.

icon.

When you have pressed Select in response to all warning messages, the front panel will give the
usual ink cartridge status display, but the refilled or non-HP cartridge will be shown as empty with a
warning sign.

Printheads
In order to increase printing speed, two printheads are connected to each ink cartridge, giving eight
printheads in total.

The printheads are extremely durable and do not need to be replaced every time an ink cartridge is
replaced. They will continue giving excellent results even if the ink cartridges are low in ink.
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Printheads
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To maintain optimum print quality, the printheads are automatically tested at regular intervals, and
automatically serviced if necessary. This takes a little time and will occasionally delay printing.
When a printhead eventually needs to be replaced, the front panel will tell you so.
CAUTION Whenever you buy a new printhead, you get a new printhead cleaner with it.
When you replace a printhead, always replace the printhead cleaner at the same time.
Leaving the old printhead cleaner in the printer will shorten the new printhead's life and
possibly damage the printer.

Printhead cleaners
Each printhead has its own printhead cleaner, so there are eight printhead cleaners in the printer.
Printhead cleaners are used to clean and maintain the printheads, to ensure the best possible print
quality, and to seal the printheads when they are not in use to prevent them from drying out.

CAUTION Whenever you buy a new printhead, you get a new printhead cleaner with it.
When you replace a printhead, always replace the printhead cleaner at the same time.
Leaving the old printhead cleaner in the printer will shorten the new printhead's life and
possibly damage the printer.
NOTE In some circumstances, the printer may ask you to replace a printhead cleaner even
though the corresponding printhead is not due for replacement. This is done in order to
maintain the printer's image quality and reliability.

Ink system tips
For best results, always follow these guidelines:
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●

Install the ink cartridges, printheads, and printhead cleaners before the install-by date, which is
printed on the packaging.

●

Install a new printhead cleaner every time you install a new printhead.

●

Follow the instructions on the front panel during installation.

●

Allow the printer and printhead cleaners to clean the printheads automatically.

●

Avoid unnecessary removal of the ink cartridges and printheads.

●

The ink cartridges should never be removed while the printer is printing. They should be
removed only when the printer is ready for you to replace them. The front panel will guide you
through the removal and installation procedures (or see Remove an ink cartridge and Insert an
ink cartridge).
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Supported paper types
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Using paper
Choosing the correct paper type for your needs is an essential step in ensuring good print quality.
For best printing results, use only recommended papers (see Supported paper types), whose
reliability and performance have been developed and thoroughly tested. All printing components
(printer, ink system, and paper) have been designed to work together to give trouble-free
performance and optimal print quality.
Here are some further tips about paper usage:
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●

Always keep unused rolls wrapped in the plastic wrap to prevent discoloration. Rewrap partially
used rolls if they are not being used.

●

Do not stack rolls.

●

Allow all paper types to adapt to room conditions out of the packaging for 24 hours before
printing.

●

Handle film and glossy paper by the edges or wear cotton gloves. Skin oils can be transferred to
the printing material, leaving fingerprint marks.

●

Keep the paper tightly wound on the roll throughout the loading and unloading procedures. If it
starts to unwind, it can become difficult to handle.

●

Whenever you load a roll or a sheet, the front panel prompts you to specify the paper type you
are loading. For good print quality, it is essential to specify this correctly. If paper is already
loaded, you can check the paper type at the front panel by highlighting the

or

icon.

●

The quality of some images may be reduced if you use a paper type that is unsuitable for your
image.

●

Make sure the appropriate print quality setting (Fast, Normal, or Best) is selected. You can set
the print quality from the driver, from the Embedded Web Server, or from the front panel. Driver
or Embedded Web Server settings override front panel settings. The combination of paper type
and print quality settings tells the printer how to place the ink on the paper—for example, the ink
density, halftoning method, and number of passes of the printheads. See Choose print quality
settings.

●

Although the ink systems supplied with this printer have good light-fastness, colors will
eventually fade or change if exposed to sunlight over a long period of time.

Supported paper types
The following tables list the HP paper types that are suitable for use with your printer, and show the
name that you should select in the front panel when loading each paper type. The “recommended”
paper types, listed first, have been thoroughly tested and are known to provide the best print quality
when used with your printer. The “other supported” paper types can be used with your printer but are
not guaranteed to provide the best print quality. For the part numbers, widths, and weights of these
papers, see Ordering paper.
NOTE This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/designjet/supplies/.
Table 27-1 Recommended paper types
Product name

Front panel name

HP Bright White Inkjet Bond Paper

Bright White
Max Speed Bright White
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Table 27-1 Recommended paper types (continued)
Front panel name

HP Matte Film

Matte Film

HP Clear Film

Clear Film

HP Natural Tracing Paper

Natural Tracing Paper

HP Translucent Bond

Translucent Bond

HP Vellum

Vellum

HP Coated Paper

Coated Paper

HP Heavyweight Coated Paper

Heavyweight Coated Paper

HP Heavyweight Coated Paper—long roll

Heavyweight Coated Paper

HP Productivity Photo Gloss

Productivity Photo Gloss

HP Productivity Photo Semi-Gloss

Productivity Photo Gloss

HP Photo Paper RC Matte

High-Gloss Photo Paper

HP Proofing Paper RC Satin

High-Gloss Photo Paper

HP Universal High-Gloss Photo Paper

High-Gloss Photo Paper

HP Universal Semi-Gloss Photo Paper

High-Gloss Photo Paper

HP Universal Instant-Dry Photo Gloss

Universal Instant-Dry Photo Gloss

HP Universal Instant-Dry Photo Semi-Gloss

Universal Instant-Dry Photo Gloss

HP Universal Inkjet Bond Paper

Bond Paper
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Product name

Max Speed Bond Paper

Table 27-2 Other supported paper types
Product name

Front panel name

HP Polyester Film Opaque White Glossy

High-Gloss Photo Paper

HP Universal Coated Paper

Bright White
Max Speed Bright White

ENWW

HP Universal Heavyweight Coated Paper

Heavyweight Coated Paper

HP Super Heavyweight Plus Matte Paper

Super Heavy Plus Matte

HP Banners with Tyvek [4000]

Super Heavy Coated Paper

HP Colorfast Adhesive Vinyl [4000]

High-Gloss Photo Paper

HP Backlit Film Reverse Print Matte

Matte Film

HP Studio Canvas [4000]

Canvas

HP Outdoor Billboard Paper Blue Back

[download]

HP Canvas Matte [4000]

Canvas

HP Outdoor Paper

[download]

HP Canvas Paper 140 gsm [4000]

Canvas

HP Canvas Paper 180 gsm [4000]

Canvas

HP Fine Art Paper Aquarella [4000]

Super Heavy Coated Paper

Supported paper types
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Table 27-2 Other supported paper types (continued)
Product name

Front panel name

HP Fine Art Paper Cream

[download]

HP Fine Art Paper Sahara

[download]

HP Indoor Paper Self-Adhesive

[download]

[4000] indicates paper types supported by the HP Designjet 4000 series but not by the HP Designjet 4500 series.
[download] indicates that you must download the appropriate media profile from the Web in order to use this paper type
(see Download media profiles).
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Drying time
With some printing materials and environmental conditions the ink needs some time to dry before the
printing material is unloaded. The following settings are available.
●

Optimal: the printer automatically determines the appropriate drying time, based on the printing
material you have selected and the current temperature and humidity. If any drying time is
required, a “drying time to go” countdown will be displayed on the front panel.

●

Extended: the default drying time is extended. This can be used if you find that the default
drying time is not enough to dry the ink sufficiently in your environment.

●

Reduced: the default drying time is reduced. This can be used if you are keen to get prints as
fast as possible, and you find that the reduced drying time causes no significant problem in your
environment.

●

None: no drying time is provided. This can be used, for example, if you are manually removing
the prints as fast as the printer is producing them.

To change the drying time, see Change the drying time.

Using paper with the stacker [4500]
NOTE This topic applies to the HP Designjet 4500 Printer series only.
The stacker can handle cut sheets of paper between 420 mm (16.5 in, A3 portrait) and 1189 mm
(46.8 in, A0 portrait) in length. Shorter prints will be enlarged to the minimum length with extra white
space; longer prints risk falling off the stacker.
Some printing materials are not compatible with the stacker, including:
●

Matte and clear film

●

Glossy paper (except instant-dry glossy paper, which may be used)

When printing in Fast mode on Translucent Bond, Vellum, or Natural Tracing Paper, there could be
some ink transfer marks in highly inked areas. Select Normal or Best mode to avoid this problem.
See Change the print quality.
NOTE You will have to remove the accumulated pile of cut sheets from the stacker every
now and then.
If you retrieve just one job from the stack, try to leave the stack in a tidy condition, otherwise
you may experience stacking problems and paper jams.
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28 Tell me about... (multiroll topics) [4500]

NOTE This chapter applies to the HP Designjet 4500 Printer series only.
The uses of a multiroll printer

●

How the printer allocates jobs to paper rolls

●

Roll switching policy

●

Unattended printing
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The uses of a multiroll printer
A multiroll printer can be useful in several different ways:
●

You can switch between different paper types quickly and without touching the printer.

●

You can switch between different paper widths quickly and without touching the printer. This
enables you to save paper by printing smaller images on narrower paper.

●

If you load two identical rolls into the printer, you can leave it printing unattended for a long time,
because it can switch from one roll to the other automatically when the first is exhausted. See
Unattended printing.

How the printer allocates jobs to paper rolls
When you submit a print job from the Embedded Web Server or the printer driver, you can specify
(using the Paper type or Type is option) that you want it to be printed on a particular paper type; you
can even specify (using the Paper source, Source is, or Paper Feed option) that you want it to be
printed on a particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also
look for a paper roll wide enough to print the image without clipping.
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●

If the job can be printed on either of the available rolls, the roll will be chosen according to the
roll switching policy. See Roll switching policy.

●

If the job can be printed on just one of the available rolls, it will be printed on that roll.

●

If the job cannot be printed on either of the available rolls, it will be held in the job queue with
the status “On hold for paper”, and not printed until you intervene. In this case, you can either
change rolls so that your requirements can be met, or you can tell the printer to go ahead and
print the job on whatever paper is available. See An “on hold for paper” message [4500].

The printer driver for Windows will tell you which paper types and widths are currently loaded in the
printer.
Here are some settings that might be used in typical situations:
●

●

With different paper types loaded:
●

Type is: select the paper type you require

●

Source is: Automatically select / Predetermined

●

Roll switching policy: doesn't matter

With different paper widths loaded:
●

Type is: Any

●

Source is: Automatically select / Predetermined

●

Roll switching policy: Minimize paper waste
Hint You can also save paper in some cases by rotating or nesting your images. See
Rotate an image and Nest jobs to save roll paper.

●
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With identical rolls loaded:
●

Type is: Any

●

Source is: Automatically select / Predetermined

●

Roll switching policy: Minimize roll changes
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Roll switching policy
If the printer has two rolls of paper and it receives a job that could be printed on either roll, it will
normally print on the currently loaded roll because there is no reason to change.
However, if the current roll is much wider than the job requires, to print on the current roll will mean
some waste of paper. If the other roll is narrower, but wide enough for the job, then paper can be
saved by printing the job on the other roll.
In these circumstances, the roll switching policy determines whether the printer changes to the
narrower roll or continues to print on the wider roll.
To set the roll switching policy at the printer's front panel, select the
options > Roll switching options. There are two options:

icon, then Paper handling

●

Minimize paper waste means that, in the above circumstances, the printer will change to the
narrower roll.

●

Minimize roll changes means that, in the above circumstances, the printer will continue to print
on the current roll.

Tell me about...
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Unattended printing
The HP Designjet 4500 Printer series, with multiple rolls and optional stacker, plus robust and
consistent image quality, is perfect for long unattended printing jobs.
Here are some recommendations to help you deal with a long queue of printing jobs.
●

If feasible, use brand-new long rolls of paper.

●

If you want to print on partly-used rolls, you can check the paper type and the remaining length
in the Embedded Web Server or in the front panel, to confirm that you have enough paper to
print all your jobs.
NOTE Information on the remaining length is available only if you told the printer the
length of the roll when you loaded it.

ENWW

●

Check that you have paper wide enough to print all of your jobs (any jobs that are too wide will
be put “on hold for paper”).

●

Check the ink levels remaining in your ink cartridges.

●

The standard bin is recommended only for less than 30 separate prints. The stacker can handle
up to 200 prints.

●

When you have submitted your print jobs, you can use the Embedded Web Server from a
remote location to monitor their status.

●

Drop detection should be set to Intensive.

●

Drying time should be set to Optimized.

●

We recommend the following settings, depending on the paper type and what kind of prints you
are making.

Roll switching policy
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Table 28-1 Recommended settings for unattended printing
Print type

Print mode

MaxDetail

Optimized for

Drying time

Paper types

Lines

Normal

Off

Lines

Optimized

Coated, Bond,
Heavyweight
Coated, Glossy

Lines and fills

Normal

On

Lines

Optimized

Coated, Bond,
Heavyweight
Coated, Glossy

Maps

Best

On

Images

Optimized

Coated,
Heavyweight
Coated, Glossy

Renderings,
photographs

Best

On

Images

Optimized

Coated,
Heavyweight
Coated, Glossy

Tell me about...
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Functional specifications

●

Physical specifications

●

Memory specifications

●

Power specifications

●

Ecological specifications

●

Environmental specifications

●

Acoustic specifications
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Functional specifications
Table 29-1 HP No. 90 ink supplies
Printheads

Yellow, magenta, black, and cyan (two of each)

Printhead cleaners

Yellow, magenta, black, and cyan (two of each)

Ink cartridges

Yellow, magenta, and cyan cartridges containing 225 or 400
cm³ of ink, and black cartridges containing 400 cm³ or 775
cm³ of ink

Table 29-2 Paper sizes
Minimum

Maximum

Width (Designjet 4000 series)

11 in (279 mm)

42 in (1.066 m)

Width (Designjet 4500 series)

16.5 in (420 mm)

42 in (1.066 m)

Length (Designjet 4000 series)

16.5 in (420 mm)

60 in (1.5 m) for sheet and 300 ft (90 m) for
roll

Length (Designjet 4500 series)

16.5 in (420 mm)

575 ft (175 m)

Table 29-3 Print resolution
Print
quality

Best

Max
detail

On

Optimized for lines and text

Optimized for images

Rendering
resolution (dpi)

Printing resolution (dpi)

Rendering
resolution (dpi)

Printing resolution (dpi)

1200×1200

2400×1200 (High-Gloss
Photo Paper, Canvas*)

1200×1200

2400×1200 (Productivity
Photo Gloss, High-Gloss
Photo Paper, Canvas*)

1200×1200 (other papers)

Tell me about... (printer
specifications topics)

1200×1200 (other papers)
Off

600×600

1200×1200 (High-Gloss
Photo Paper, Canvas*)

600×600

1200×600 (other papers)
Normal

On

600×600

1200×1200 (High-Gloss
Photo Paper, Canvas*)

1200×600 (other papers)
600×600

1200×600 (other paper
types)
Off

600×600

1200×1200 (High-Gloss
Photo Paper, Canvas*)

On

600×600

1200×1200 (High-Gloss
Photo Paper)
1200×600 (other paper
types)

1200×1200 (High-Gloss
Photo Paper, Canvas*)
1200×600 (other paper
types)

300×300

1200×600 (other paper
types)
Fast

1200×1200 (High-Gloss
Photo Paper, Canvas*)

1200×1200 (Productivity
Photo Gloss, High-Gloss
Photo Paper, Canvas*)
1200×600 (other paper
types)

600×600

1200×1200 (High-Gloss
Photo Paper)
600×600 (Max Speed,
Bright White, Bond Paper)
1200×600 (other paper
types)
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Table 29-3 Print resolution (continued)
Print
quality

Max
detail

Off

Optimized for lines and text

Optimized for images

Rendering
resolution (dpi)

Printing resolution (dpi)

Rendering
resolution (dpi)

Printing resolution (dpi)

300×300

1200×1200 (High-Gloss
Photo Paper)

300×300

1200×1200 (High-Gloss
Photo Paper)

600×600 (Max Speed)

600×600 (Max Speed,
Bright White, Bond Paper)

1200×600 (other paper
types)

1200×600 (other paper
types)

* Canvas is supported by the HP Designjet 4000 series only.

Table 29-4 Margins
Side margins

5 mm = 0.2 in (small, normal)
15 mm = 0.6 in (extended)

Top margin (leading edge)

5 mm = 0.2 in (small)
11.5 mm = 0.6 in (normal)
55 mm = 2.2 in (extended)

Bottom margin (trailing edge)

5 mm = 0.2 in (roll)
25 mm = 1 in (sheet, normal)*
55 mm = 2.2 in (sheet, extended)*

* Sheet paper is supported by the HP Designjet 4000 series only.

Table 29-5 Mechanical accuracy

Tell me about... (printer
specifications topics)

±0.1% of the specified vector length or ±0.1 mm (whichever greater) at 23°C (73°F), 50-60% relative humidity, on A0
printing material in Best or Normal mode with HP Matte Film.

Table 29-6 Graphic languages supported
HP Designjet 4000 and 4500 Printer series

HP-GL/2, RTL, TIFF, JPEG, CALS G4

HP Designjet 4000ps, 4500ps, and 4500mfp only

Adobe PostScript level 3, PDF 1.5

Physical specifications
Table 29-7 Printer physical specifications
Weight (including stand)

≈ 115 kg (Designjet 4000 series)
≈ 185 kg (Designjet 4500 series)

ENWW

Width

< 1930 mm

Depth

< 800 mm

Height

≈ 1350 mm

Physical specifications
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Table 29-8 Stacker physical specifications
Weight

53 kg

Width

1286 mm

Depth

1002–1569 mm

Height

1135 mm

Memory specifications
Table 29-9 Memory specifications
Memory (DRAM) supplied

256 MB

Memory (DRAM) maximum

512 MB

Hard disk

40 GB

Power specifications
Table 29-10 Printer power specifications
Source

100–240 V ac ±10%, autoranging

Frequency

50–60 Hz

Current

<6A

Consumption

< 1 kW

Table 29-11 Stacker power specifications

Tell me about... (printer
specifications topics)

Source

115 V ac ±10%

230 V ac ±10%

Frequency

60 Hz

50 Hz

Current

< 10 A

<6A

Consumption

< 1.1 kW

< 1.1 kW

Ecological specifications
For the up-to-date ecological specifications of your printer, please go to http://www.hp.com/ and
search for “ecological specifications”.

Environmental specifications
Table 29-12 Printer environmental specifications
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Relative humidity range for best print quality

20–80%, depending on paper type

Temperature range for best print quality

15 to 30°C (59 to 86°F), depending on paper type

Temperature range for printing

5 to 40°C (41 to 104°F)
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Table 29-12 Printer environmental specifications (continued)
Temperature range when not in operation

-20 to +55°C (-4 to +131°F)

Maximum altitude when printing

3000 m

Table 29-13 Stacker environmental specifications
Relative humidity range

20–80%

Temperature range for printing

5 to 40°C (41 to 104°F)

Temperature range when not in operation

-20 to +50°C (-4 to +122°F)

Acoustic specifications
Table 29-14 Printer acoustic specifications
Idle sound power

≤ 5.8 B (A)

Operating sound power

≤ 7.0 B (A)

Idle sound pressure

≤ 41 dB (A)

Operating sound pressure

≤ 53 dB (A)

Table 29-15 Stacker acoustic specifications
< 4.5 B (A)

Operating sound power

< 5.5 B (A)

Idle sound pressure

< 35 dB (A)

Operating sound pressure

< 57 dB (A)
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Ordering ink supplies

●

Ordering paper

●

Ordering accessories
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Ordering ink supplies
The following ink supplies can be ordered for your printer.
Table 30-1 Ink cartridges
Cartridge

Capacity (cm³)

Part number

HP 90 Cyan

225

C5060A

HP 90 Magenta

225

C5062A

HP 90 Yellow

225

C5064A

HP 90 Black

400

C5058A

HP 90 Cyan

400

C5061A

HP 90 Magenta

400

C5063A

HP 90 Yellow

400

C5065A

HP 90 Black

775

C5059A

HP 90 Cyan Multipack

400 × 3

C5083A

HP 90 Magenta Multipack

400 × 3

C5084A

HP 90 Yellow Multipack

400 × 3

C5085A

HP 90 Black Multipack

775 × 3

C5095A

Table 30-2 Printheads and printhead cleaners
Printhead & cleaner

Part number

HP 90 Black

C5054A

HP 90 Cyan

C5055A

HP 90 Magenta

C5056A

HP 90 Yellow

C5057A

Table 30-3 Printhead cleaners
Printhead cleaner

Part number

HP 90 Black

C5096A

Tell me about...
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Ordering paper
The following paper types are currently provided for use with your printer.
NOTE This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/designjet/supplies/.
Key to availability:

322

●

:A indicates papers available in Asia (excluding Japan)

●

:E indicates papers available in Europe, the Middle East, and Africa

Chapter 30
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●

:J indicates papers available in Japan

●

:L indicates papers available in Latin America

●

:N indicates papers available in North America

If the part number is not followed by a colon, the paper is available in all regions.
Table 30-4 Premium Technical
Name

g/m²

24 in wide

36 in wide

42 in wide

23.39 in
wide (A1)

33.11 in
wide (A0)

HP Bright White Inkjet Bond Paper

90

C1860A:LN

C1861A:LN

none

Q1445A:EJ

Q1444A:EJ

C6035A:AE

C6036A:AE

HP Bright White Inkjet Bond Paper (300
ft)

90

none

C6810A

none

none

none

HP Matte Film

160

51642A:AE
N

51642B

none

none

none

HP Clear Film

170

C3876A:AE
N

C3875A

none

none

none

HP Natural Tracing Paper

90

C3869A

C3868A

none

Q1439A:J

Q1438A:J

HP Translucent Bond

67

C3860A:AN

C3859A:AL
N

none

none

none

HP Polyester Film Opaque White Glossy

170

C7955A:EN

C7956A:EN

C7957A:EN

none

none

HP Vellum

75

C3862A:N

C3861A:LN

none

none

none

HP Coated Paper

96

C6019B

C6020B

C6567B

Q1442A:EJ

Q1441A:EJ

HP Coated Paper (300 ft)

96

none

C6980A

none

none

none

HP Heavyweight Coated Paper

131

C6029C:AE
N

C6030C

C6569C

none

none

HP Heavyweight Coated Paper (225 ft)

131

none

none

Q1956A:EN

none

none

Name

g/m²

24 in wide

36 in wide

42 in wide

HP Productivity Photo Gloss

244

none

Q1938A:AEN

Q1939A:AEN

HP Productivity Photo Semi-Gloss

244

none

Q1943A:AEN

Q1944A:AEN

HP Photo Paper RC Matte

200

none

C7946A:AEN

none

HP Proofing Paper RC Satin

200

none

C7952A:AEN

none

Table 30-6 Universal Line
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Name

g/m²

24 in wide

36 in wide

42 in wide

23.39 in
wide (A1)

33.11 in
wide (A0)

HP Universal High-Gloss Photo Paper

190

Q1426A:AE
N

Q1427A:AE
N

Q1428A:AE
N

none

none

HP Universal Semi-Gloss Photo Paper

190

Q1420A:AE
N

Q1421A:AE
N

Q1422A:AE
N

none

none

Ordering paper
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Table 30-5 Premium Photographic
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Table 30-6 Universal Line (continued)
Name

g/m²

24 in wide

36 in wide

42 in wide

23.39 in
wide (A1)

33.11 in
wide (A0)

HP Universal Instant-Dry Photo Gloss

190

Q6574A:AE
N

Q6575A:AE
N

Q6576A:AE
N

none

none

HP Universal Instant-Dry Photo SemiGloss

190

Q6579A:AE
N

Q6580A:AE
N

Q6581A:AE
N

none

none

HP Universal Inkjet Bond Paper

80

Q1396A:AE
N

Q1397A:AE
N

Q1398A:AE
N

Q8003A:J

none

HP Universal Inkjet Bond Paper (300 ft)

80

none

none

none

Q8004A:EJ

Q8005:EJ

HP Universal Inkjet Bond Paper (500 ft)

80

none

Q8002A:AE
N

none

none

none

95

Q1404A:AE
N

Q1405A:AE
N

Q1406A

none

none

Q1412A:AE
N

Q1413A

Q1414A:AE
N

none

none

(Designjet 4500 series only)
HP Universal Coated Paper

HP Universal Heavyweight Coated Paper 120

Table 30-7 Display Graphics
Name

g/m²

24 in wide

36 in wide

42 in wide

HP Super Heavyweight Plus Matte Paper

210

Q6626A

Q6627A

Q6628A

HP Banners with Tyvek

140

none

C6787A:AEN

none

328

none

C6775A

none

HP Backlit Film Reverse Print Matte

160

none

C7960A:AEN

none

HP Studio Canvas

368

none

C6771A

none

HP Outdoor Billboard Paper Blue Back

140

none

C7949A:EN

none

HP Outdoor Paper

145

none

C1730A:EN

none

HP Indoor Paper Self-Adhesive

170

none

C1733A:EN

none

Name

g/m²

24 in wide

36 in wide

42 in wide

HP Canvas Matte

340

C7966A:AEN

C7967A:AEN

C7968A:AEN

140

none

Q1718A:EN

none

180

none

Q1724A:AEN

none

240

none

Q1703A

none

(Designjet 4000 series only)
HP Colorfast Adhesive Vinyl
(Designjet 4000 series only)

(Designjet 4000 series only)

Table 30-8 Graphics Arts/Indoor/Fine Art
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(Designjet 4000 series only)
HP Canvas Paper 140 gsm
(Designjet 4000 series only)
HP Canvas Paper 180 gsm
(Designjet 4000 series only)
HP Fine Art Paper Aquarella
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Table 30-8 Graphics Arts/Indoor/Fine Art (continued)
Name

g/m²

24 in wide

36 in wide

42 in wide

HP Fine Art Paper Cream

140

none

Q1709A

none

HP Fine Art Paper Sahara

140

none

Q1715A:EN

none

(Designjet 4000 series only)

Ordering accessories
The following accessories can be ordered for your printer.
NOTE Accessories for the 4000 series are also suitable for the 4500 series, except for the
HP Designjet 4000 Roll Feed Spindle.
Product number

HP Jetdirect 40d Gigabit Print Server for the HP Designjet 4000 Printer series (provides the
highest capacity network connection to your printer)

Q5679A

HP Designjet 4000 Printer series High Speed USB 2.0 Card (provides a high speed direct
connection to your printer)

Q5680A

HP Jetdirect 620n Fast Ethernet print server

J7934A

HP Designjet 4000 Printer series 256 MB Memory Upgrade (to increase the memory capacity
of your printer to work with complex files)

Q5673A

HP Designjet 4000 Roll Feed Spindle 42” (spare spindles ease the process of switching
between different types of roll paper)

Q5675A

HP Designjet 4500 – 42 inch Roll Feed Spindle (spare spindles ease the process of switching
between different types of roll paper)

Q5676A

HP Designjet 4500 Stacker

Q5677A

HP Designjet 4500 Scanner

Q1277A

Tell me about...
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HP Designjet Online
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Other sources of information
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HP Instant Support
HP Instant Support is HP's suite of troubleshooting tools that collect diagnostic information from your
printer and match it with intelligent solutions from HP's knowledge bases, allowing you to resolve
problems as quickly as possible.
You can start an HP Instant Support session by clicking on the link provided by your printer's
Embedded Web Server. See Access the Embedded Web Server.
To be able to use HP Instant Support:
●

You must have a TCP/IP connection to your printer, because HP Instant Support is accessible
only through the Embedded Web Server.

●

You must have access to the World Wide Web, because HP Instant Support is a Web–based
service.

HP Instant Support is currently available in English, Korean, Simplified Chinese, and Traditional
Chinese.

HP Customer Care
As your strategic support partner, we make it our business to help keep your business running
smoothly. HP Customer Care offers award-winning support to ensure you get the most from your HP
Designjet.
HP Customer Care provides comprehensive, proven support expertise and leverages new
technologies to give customers unique end-to-end support. Services include setup and installation,
troubleshooting tools, warranty upgrades, repair and exchange services, phone and Web support,
software updates, and self-maintenance services. To find out more about HP Customer Care, please
visit us at:
http://www.hp.com/go/designjet/
or call the phone number in the Customer Service Guide provided with your printer.
What to do before you call:
●

Review the “The problem is” troubleshooting suggestions in this guide.

●

Review the relevant driver documentation supplied with this printer (for users sending PostScript
files or those using Microsoft Windows).

●

If you have installed third-party software drivers and RIPs, refer to their documentation.

●

If the problem appears to be related to your software application, first contact your software
vendor.

●

If you still have difficulty, refer to the HP Support Services booklet provided with your printer.
This document contains a comprehensive list of various support services available to help solve
printer problems.

●

If you call one of the Hewlett-Packard offices, please have the following information available to
help us answer your questions more quickly:
●
●
●
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The printer you are using (the product number and the serial number, found on the label at
the back of the printer)
The printer's Service ID: select the

icon, and then View printer information

If there is an error code on the front panel, note it down; see “Status codes and error
messages”

Tell me about... (getting help topics)
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The computer you are using

●

Any special equipment or software you are using (for example, spoolers, networks, switchboxes, modems, or special software drivers)

●

The cable you are using (by part number) and where you purchased it

●

The type of interface used on your printer (FireWire, USB, or network)

●

The software name and version you are currently using

●

If the problem is a system error it will have a error number; record the error number and
have it ready

●

If possible, print out the following reports; you may be asked to fax them to the support
center helping you: Configuration, Usage Report, and “all pages above” from Service
Information (see The printer's internal prints)

HP Designjet Online
Enjoy a world of dedicated services and resources to ensure you always get the best performance
from your HP Designjet products and solutions.
Register at HP Designjet Online, your large-format printing community at http://www.hp.com/go/
designjet/ for unrestricted access to:
●

Downloads — the latest printer firmware, drivers, software, media profiles, etc.

●

Technical support — online troubleshooting, customer care contacts, and more

●

Forums for direct contact with the experts, both HP and your colleagues

●

Warranty tracking online, for your peace of mind

●

Technical documentation and training videos

●

Latest product information — printers, supplies, accessories, software, etc.

●

Supplies Center for all you need to know about ink and paper

By customizing your registration for the products you have purchased and your type of business, and
by setting your communication preferences: you decide the information you need.
Register at HP Designjet Online for the best performance.
HP Designjet Online is available in English, German, French, Italian, Spanish, Portuguese,
Japanese, Korean, Simplified Chinese, and Traditional Chinese.

Other sources of information
More information is available from the following sources:

ENWW

●

The Embedded Web Server provides information about your printer status, technical support,
online documentation, etc.—see Tell me about... (Embedded Web Server topics).

●

The Printer assembly document that came with your printer

HP Designjet Online
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●

Worldwide Limited Warranty—HP Designjet 4000/4500 Printer series and 4500mfp

●

Hewlett-Packard Software License Agreement

●

Open source acknowledgments

●

Regulatory notices

●

DECLARATION OF CONFORMITY

Legal information
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Worldwide Limited Warranty—HP Designjet 4000/4500
Printer series and 4500mfp

Legal information

HP product

Limited Warranty Period

Printer

1 year (from the date of purchase by the customer)

Software

90 days (from the date of purchase by the customer)

Printhead

Until the “end of warranty” date printed on the product is
reached, or 1000 cm³ of HP ink have been cycled through
the printhead, whichever occurs first

Ink cartridge

Until the genuine HP ink is depleted as indicated by the
printer, or the “end of warranty” date printed on the product
is reached, whichever occurs first

A. Extent of HP Limited Warranty
1.

This Hewlett-Packard (HP) Limited Warranty gives you, the end-customer, express limited
warranty rights from HP, the manufacturer. In addition, you may also have other legal rights
under the applicable local law or special written agreement with HP.

2.

HP warrants to you that the HP products specified above will be free from defects in materials
and workmanship during the Limited Warranty Period specified above. The Limited Warranty
Period starts on the date of purchase. Your dated sales or delivery receipt, showing the date of
purchase of the product, is your proof of purchase date. You may be required to provide proof of
purchase as a condition of receiving warranty service. You are entitled to warranty service
according to the terms and conditions of this document if a repair or replacement of your HP
Products is required within the Limited Warranty Period.

3.

For software products, HP’s Limited Warranty applies only to a failure to execute programming
instructions. HP does not warrant that the operation of any product will be uninterrupted or error
free.

4.

HP’s Limited Warranty covers only those defects that arise as a result of normal use of the HP
products, and does not apply to any:
a.

Improper or inadequate maintenance or modification;

b.

Software, interfacing, media, parts, or supplies not provided or supported by HP; or

c.

Operation outside the product’s specifications.

Routine printer maintenance operations in the HP Designjet 4000/4500 Printer series and
4500mfp, such as cleaning and preventive maintenance services (including parts contained in
any preventive maintenance kit and HP service engineer visits), are not covered by HP’s
Limited Warranty, but in some countries may be covered under a separate support contract.
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5.

YOU SHOULD MAKE PERIODIC BACKUP COPIES OF THE DATA STORED ON THE
PRINTER'S HARD DISK OR OTHER STORAGE DEVICES AS A PRECAUTION AGAINST
POSSIBLE FAILURES, ALTERATION, OR LOSS OF THE DATA. BEFORE RETURNING ANY
UNIT FOR SERVICE, BE SURE TO BACK UP DATA AND REMOVE ANY CONFIDENTIAL,
PROPRIETARY, OR PERSONAL INFORMATION. HP IS NOT RESPONSIBLE FOR DAMAGE
TO OR LOSS OF ANY FILES, STORED BY YOU ON THE PRINTER'S HARD DISK OR
OTHER STORAGE DEVICES. HP IS NOT RESPONSIBLE FOR THE RECOVERY OF LOST
FILES OR DATA.

6.

For HP printer products, the use of a refilled or non-original HP consumable product (ink,
printhead or ink cartridge) does not affect either HP’s Limited Warranty to you or any HP
support contract with you. However, if printer failure or damage is attributable to the use of a
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non-HP or refilled ink cartridge, HP will charge its standard time and materials charges to
service the printer for the particular failure or damage.
Your exclusive remedies for defective HP products are the following:
a.

During the Limited Warranty Period, HP will replace any defective HP software, media, or
consumable product which is covered by this Limited Warranty, and deliver another
product to you to replace the defective one.

b.

During the Limited Warranty Period, HP, at its sole discretion, shall either repair on site or
replace any defective hardware product or component part. If HP elects to replace any
component part, HP will provide to you (i) a replacement part, in return of the defective
one, and (ii) remote part installation assistance, if needed.

c.

In the unlikely event that HP is unable to repair or replace, as applicable, a defective
product which is covered by this Limited Warranty, HP shall, within a reasonable time after
being notified of the defect, refund the purchase price for the product.

8.

HP shall have no obligation to replace or refund until you return the defective media,
consumable, hardware product or component part to HP. All components, parts, consumables,
media or hardware products removed under this Limited Warranty become the property of HP.
Notwithstanding the above mentioned, HP may waive the requirement for you to return the
defective part.

9.

Unless otherwise stated, and to the extent permitted by local law, HP products may be
manufactured using new materials or new and used materials equivalent to new in performance
and reliability. HP may repair or replace products (i) with equivalent products to the products
being repaired or replaced but which may have been subject to prior use; or (ii) with an
equivalent product to an original product that has been discontinued.

10. THIS LIMITED WARRANTY IS APPLICABLE IN ALL COUNTRIES AND MAY BE ENFORCED
IN ANY COUNTRY WHERE HP OR ITS AUTHORIZED SERVICE PROVIDERS OFFER
WARRANTY SERVICE AND HP HAS MARKETED THIS PRODUCT, SUBJECT TO THE
TERMS AND CONDITIONS SET FORTH IN THIS LIMITED WARRANTY. HOWEVER,
WARRANTY SERVICE AVAILABILITY AND RESPONSE TIME MAY VARY FROM COUNTRY
TO COUNTRY. HP WILL NOT ALTER FORM, FIT, OR FUNCTION OF THE PRODUCT TO
MAKE IT OPERATE IN A COUNTRY FOR WHICH IT WAS NEVER INTENDED TO FUNCTION
FOR LEGAL OR REGULATORY REASONS.
11. Contracts for additional services may be available for any authorized HP service facility where
the listed HP product is distributed by HP or an authorized importer.
12. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT AS EXPRESSLY SET FORTH IN
THIS LIMITED WARRANTY NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKE ANY
OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED,
WITH RESPECT TO THE HP PRODUCTS, AND SPECIFICALLY DISCLAIM THE IMPLIED
WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND
FITNESS FOR A PARTICULAR PURPOSE.

B. Limitations of liability
TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY
SET FORTH IN THIS LIMITED WARRANTY, IN NO EVENT SHALL HP OR ITS THIRD PARTY
SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES (INCLUDING ANY LOSS OF PROFITS OR SAVINGS), WHETHER
BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.
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C. Local law

Legal information

1.

This Limited Warranty gives you specific legal rights. You may also have other rights which vary
from state to state in the United States, from province to province in Canada, and from country
to country elsewhere in the world. You are advised to consult applicable state, province, or
national laws for full determination of your rights.

2.

To the extent that this Warranty Statement is inconsistent with local law, this Warranty
Statement shall be deemed modified to be consistent with such local law. THE WARRANTY
TERMS CONTAINED IN THIS LIMITED WARRANTY, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT, OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO
YOU.

Revision: September 20th, 2005
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Hewlett-Packard Software License Agreement
ATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP SOFTWARE LICENSE TERMS
SET FORTH BELOW. USING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE
LICENSE TERMS. IF YOU DO NOT ACCEPT THESE LICENSE TERMS, YOU MUST RETURN
THE SOFTWARE FOR A FULL REFUND. IF THE SOFTWARE IS SUPPLIED WITH ANOTHER
PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT FOR A FULL REFUND.

The following terms govern your use of the software integrated into your HP Designjet 4000/4500
Printer series and 4500mfp, unless you have a separate agreement with HP.
Definitions. HP Designjet 4000/4500 Printer series and 4500mfp software includes HP software
product (“the Software”) and Open Source Software components.
“Open Source Software” means various open source software components including, but not limited
to, Apache, Tomcat, MySQL, and omniORB, licensed under terms of applicable open source license
agreements included in the materials relating to such software (please see “Open Source Software”
section below).
License Grant. HP grants you a license to Use one copy of the Software pre-installed in the HP
Designjet 4000/4500 Printer series and 4500mfp. "Use" means storing, loading, executing or
displaying the Software. You may not modify the Software or disable any licensing or control features
of the Software.
Ownership. The Software is owned and copyrighted by HP or its third party suppliers. Your license
confers no title to, or ownership in, the Software and is not a sale of any rights in the Software. HP's
third party suppliers may protect their rights in the event of any violation of these License Terms.
Copies and Adaptations. You may only make copies or adaptations of the Software for archival
purposes or when copying or adaptation is an essential step in the authorized Use of the Software.
You must reproduce all copyright notices in the original Software on all copies or adaptations. You
may not copy the Software onto any public network.
No Disassembly or Decryption. You may not disassemble or decompile the Software unless HP's
prior written consent is obtained. In some jurisdictions, HP's consent may not be required for limited
disassembly or decompilation. Upon request, you will provide HP with reasonably detailed
information regarding any disassembly or decompilation. You may not decrypt the Software unless
decryption is a necessary part of the operation of the Software.
Transfer. Your license will automatically terminate upon any transfer of the Software. Upon transfer,
you must deliver the Software, including any copies and related documentation, to the transferee.
The transferee must accept these License Terms as a condition to the transfer.
Termination. HP may terminate your license upon notice for failure to comply with any of these
License Terms. Upon termination, you must immediately destroy the Software, together with all
copies, adaptations and merged portions in any form or, if the Software is supplied integrated into the
HP Designjet 4000/4500 Printer series or 4500mfp, stop using the HP Designjet 4000/4500 Printer
series or 4500mfp.
Export Requirements. You may not export or re-export the Software or any copy or adaptation in
violation of any applicable laws or regulations.
U.S. Government Restricted Rights. The Software and any accompanying documentation have
been developed entirely at private expense. They are delivered and licensed as "commercial
computer software" as defined in DFARS 252.227-7013 (Oct 1988), DFARS 252.211-7015 (May
1991) or DFARS 252.227-7014 (Jun 1995), as a "commercial item" as defined in FAR 2.101(a), or as
"Restricted computer software" as defined in FAR 52.227-19 (Jun 1987) (or any equivalent agency
regulation or contract clause), whichever is applicable. You have only those rights provided for such
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Software and any accompanying documentation by the applicable FAR or DFARS clause or the HP
standard software agreement for the product involved.
Open Source Software. The Open Source Software is composed of individual software
components, each of which has its own copyright and its own applicable license conditions. You
must review the licenses within the individual packages to understand your rights under them. The
licenses can be found in the folder called licenses on the Drivers and Documentation CD that came
with your printer. Copyrights to the Open Source Software are held by the copyright holders.

Open source acknowledgments
Legal information
336

●

This product includes software developed by the Apache Software Foundation
(http://www.apache.org/).

●

The source code, object code, and documentation in the com.oreilly.servlet package is licensed
by Hunter Digital Ventures, LLC.
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Regulatory notices
You can obtain current Material Safety Data Sheets for the ink systems used in the printer by mailing
a request to this address: Hewlett-Packard Customer Information Center, 19310 Pruneridge Avenue,
Dept. MSDS, Cupertino, CA 95014, U.S.A.
There is also a Web page: http://www.hp.com/hpinfo/community/environment/productinfo/
psis_inkjet.htm

Regulatory Model Number

RMN

Product family

BCLAA-0401

HP Designjet 4000 Printer series

Legal information

For regulatory identification purposes, your product is assigned a Regulatory Model Number (RMN).
The Designjet 4000 and 4500 Printer series comprise various products. The Regulatory Model
Number for your product is as follows:

HP Designjet 4500 Printer series
HP Designjet 4500 mfp series
BCLAA-0503

HP Designjet 4500 Scanner series

BCLAA-0504

HP Designjet 4500 Stacker series

The Regulatory Model Number (RMN) should not be confused with the marketing name (HP
Designjet 4000/4500 Printer series, HP Designjet 4500 Scanner, or HP Designjet 4500 Stacker) or
product number.

ELECTROMAGNETIC COMPATIBILITY (EMC)
WARNING! This is a class A product. In a domestic environment this product may cause
radio interference, in which case the user may be required to take adequate measures.

FCC statements (U.S.A.)
The U.S. Federal Communications Commission (in 47 cfr15.105) has specified that the following
notices be brought to the attention of users of this product.

Shielded cables
Use of shielded data cables is required to comply with the Class A limits of Part 15 of the FCC Rules.
CAUTION Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this
equipment not expressly approved by the Hewlett-Packard Company may cause harmful
interference and void the FCC authorization to operate this equipment.
This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference, in which case users will be required to correct the
interference at their own expense.
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Normes de sécurité (Canada)
Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites
applicables aux appareils numériques de Classe A prescrites dans le réglement sur le brouillage
radioélectrique édicté par le Ministére des Communications du Canada.

DOC statement (Canada)
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

Legal information

Korean EMI statement

VCCI Class A (Japan)

Safety power cord warning

Taiwanese EMI statement
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Sound
Geräuschemission (Germany) LpA < 70 dB, am Arbeitsplatz, im Normalbetrieb, nach DIN45635 T. 19.
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Chinese EMI statement

DECLARATION OF CONFORMITY
according to ISO/IEC Guide 22 and EN 45014
Supplier’s name:

Hewlett-Packard Company

Supplier’s address:

Avenida Graells, 501
08174 Sant Cugat del Vallès
Barcelona, Spain

Legal information

declares that the product
Regulatory Model Number (3):

BCLAA-0401, BCLAA-0503, BCLAA-0504

Product family:

HP Designjet 4000 Printer series, HP Designjet 4500 Printer series, HP
Designjet 4500 Scanner series, HP Designjet 4500 Stacker series

Product options:

All

conforms to the following product specifications
Safety:

IEC 60950-1:2001 / EN 60950–1:2001

EMC:

CISPR 22:1993+A1:95+A2:96 / EN 55022:1994+A1:95+A2:97 Class A (1)
EN 55024:1998+A1:2001+A2:2003
EN 61000-3-2:2000
EN 61000-3-3:1995+A1:2001
FCC Title 47 CFR, Part 15 Class A (2)

Additional information
The product herewith complies with the requirements of the Low-Voltage Directive 73/23/EEC and
the EMC Directive 89/336/EEC, and carries the CE marking accordingly.
1.

The product was tested in a typical configuration with HP Personal Computer systems and
peripherals.

2.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

3.

340

●

This device may not cause harmful interference.

●

This device must accept any interference received, including interference that may cause
undesired operation.

The product is assigned a Regulatory Model Number which stays with the regulatory aspect of
the design. The Regulatory Model Number is the main product identifier in the regulatory
documentation and test reports; this number should not be confused with the marketing name
or the product numbers.

Chapter 32

Legal information

ENWW

Hardware Quality Manager
Sant Cugat del Vallès (Barcelona)
July 28th, 2005

Local contacts for regulatory topics only
European contact: Hewlett-Packard GmbH, HQ-TRE, Herrenberger Strasse 140, 71034 Böblingen,
Germany.
United States contact: Hewlett-Packard Company, Corporate Product Regulations Manager, 3000
Hanover Street, Palo Alto, CA 94304, USA.
Australian contact: Hewlett-Packard Australia Ltd, Product Regulations Manager, 31–41 Joseph
Street, Blackburn, Victoria, 3130, Australia.
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Josep-Maria Pujol
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HP-GL/2 151

328

I
image diagnostics print 208
image problems
blank page 272
clipped image 272
distorted print 273
missing objects 274
overlapping images 273
partial print 272
PDF problems 274
pen settings ineffective 274
small image 273
unexpected mirror image 273
unexpected rotation 273
unintelligible print 273
Visio 2003 274
InDesign 163
ink cartridge
about 304
cannot insert 276
cannot remove 276
getting information 193
inserting 177
maintenance 204
non-HP 304
not accepted 276
ordering 322
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loading roll into printer [4500] 120
loading roll onto spindle [4000]
108
loading roll onto spindle [4500]
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maintenance 301
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media profiles
downloading 127
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N
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preventive maintenance 301
previewing copies [4500] 227
print job
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print quality
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printer driver
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Windows uninstall 92
printer software 8
printer's main components [4000]
3
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4
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about 305
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about 306
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inserting 190
ordering 322
removing 189
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288
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Q
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rear lights 300
recommended papers 308
refilling ink cartridges 304
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rendering intent 155
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restarting the printer 102
roll paper
loading into the printer [4000]
110
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120
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108
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[4500] 224
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loading 114
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small image 273
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software license 335
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[4000] 12
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margins 317
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memory 318
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physical 317
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squeaky rollers 292
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changing rolls 139
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cleaning the rollers 139
ink marks 264
installing 138
moving 140
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paper scrolls 280
storing 140
trailing edge curls 280
uninstalling 138
using paper 310
stacking problems in basket 257
stacking problems in bin 256
statistics
ink cartridge 193
printer usage 196
printhead 193
status 133
stepped lines 265
storing the printer 204
support services
HP Customer Care 328
HP Designjet Online 329
HP Instant Support 328
supported papers 308
switching the printer on/off 102
symbols on printer boxes [4000]
12
symbols on printer boxes [4500]
46

warranty note 193
warranty statement 332
Web access to printer 295

T
thin lines 261
TIFF 151
time to assemble the printer [4000]
12
time to assemble the printer [4500]
46
time, resetting 105
trimming the paper [4500] 125
U
unattended printing [4500] 313
unintelligible print 273
unloading a sheet [4000] 118
unloading roll from printer [4000]
113
unloading roll from printer [4500]
123
unpacking the printer [4000] 12
unpacking the printer [4500] 46
USB 2.0 accessory [4000]
installing 42
using this guide 2
V
Visio 2003, no output
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346

Index

ENWW

